Operating Instructions

Network Camera

Model No.  WV-S3531L
          WV-S3131L
          WV-S3511L
          WV-S3111L
          WV-S3532LM
          WV-S3512LM

The model number is abbreviated in some descriptions in this manual.
Preface

About the user manuals

There are 3 sets of operating instructions as follows.
- Operating Instructions (this document): Explains how to perform the settings and how to operate this camera.
- Important Information: Provides information about the cautions required for safely using and installing this camera.
- Installation Guide: Explains how to install and connect devices.

The screens used in these operating instructions show the case of WV-S3531L. Depending on the model used, the screens shown in the explanations may differ to the actual camera screens.

Note
- “Control No.:C****” used in this document should be used to search for information on the Panasonic support website and will guide you to the right information.

About notations

The following notations are used when describing the functions limited for specified models. The functions without the notations are supported by all models.
- \( \text{\textless S353x} \): The functions with this notation are available when using the model WV-S3531L and WV-S3532LM.
- \( \text{\textless S351x} \): The functions with this notation are available when using the model WV-S3511L and WV-S3512LM.
- \( \text{\textless S3131} \): The functions with this notation are available when using the model WV-S3131L.
- \( \text{\textless S3111} \): The functions with this notation are available when using the model WV-S3111L.

Abbreviations

The following abbreviations are used in these operating instructions.
- Microsoft Windows 10 is described as Windows 10.
- Microsoft Windows 8.1 is described as Windows 8.1.
- Microsoft Windows 7 is described as Windows 7.
- Internet Explorer 11 is described as Internet Explorer.
- microSDXC/microSDHC/microSD memory card is described as SD card or SD memory card.
- Universal Plug and Play is described as UPnP™ or UPnP.
For administrator registration

At the time of first access to the camera (or at the time of initialization), the registration screen will be displayed.

[User name (1 to 32 characters)]
Enter the user name of the administrator.

Available number of characters: 1 - 32 characters
Unavailable characters: 2-byte characters, and 1-byte symbols " & : ; \n
[Password (8 to 32 characters)]/[Retype password]
Enter the administrator password.

Available number of characters: 8 - 32 characters
Unavailable characters: 2-byte characters, and 1-byte symbols " &

Note
• Distinguish between upper- and lower cases.
• For the password, use three or more types of characters from upper- and lowercase alphabetic characters, numeric characters, and symbols.
• Set the password which does not include the user name.

IMPORTANT
• If you forgot or do not know the password or user name, the camera must be initialized. Because all settings other than preset position settings are deleted when the camera is initialized, make sure to keep the information secure from third parties. Refer to “Parts and functions” section in the Important Information in the supplied CD-ROM for more information about initializing the camera.
• It is recommended to change the password periodically.

The registration completion screen will be displayed after registering a user name and password of the administrator. After 10 seconds, the camera will be reconnected automatically. Please click “here” if it is not displayed automatically.
When the camera is reconnected to, an authentication window is displayed. Enter the registered user name and password to start operation.

**Registration of administrator is completed.**

After 10 seconds, the camera will be reconnected automatically. 
Please click here if it is not displayed automatically.

**Viewer software**

In order to display H.265 (or H.264) images, receive audio from the camera, and play images saved on the SD memory card, the “Network Camera View 4S” (ActiveX®) viewer software must be installed. This software can be installed directly from the camera or by selecting the [Install] button next to [Viewer Software] on the menu of the CD-ROM provided, and then following the on-screen instructions.

**IMPORTANT**

- The default setting of “Automatic installation” is “On”. Follow the instructions on page 228 when the message is displayed on the information bar of the browser.
- Depending on the software environment of your PC, it may take time for the message to be displayed on the information bar of the browser.
- If you display the “Live” page on a PC and click the [Viewer Software] button, the installation screen for ActiveX, which is required for viewing camera images, is displayed. Follow the on-screen instructions and install the software. When displayed JPEG images (still images), there is no need to install ActiveX.
- When the install wizard is displayed again even after completing the installation of the ActiveX, restart the PC.
• The viewer software used on each PC should be licensed individually. The number of installations of the viewer software from the camera can be checked on the [Upgrade] tab of the “Maintenance” page (→page 201). Refer to your dealer for the software licensing.
Table of Contents

1 Operations .................................................................................................................................9
  1.1 Monitor images on a PC ...........................................................................................................9
    1.1.1 Monitor images from a single camera ..................................................................................9
  1.2 Monitor images on a cellular phone/mobile terminal ..........................................................18
    1.2.1 Monitor images on a cellular phone .....................................................................................18
    1.2.2 Monitor images on a mobile terminal (including smartphones) ......................................19
  1.3 Record images on the SD memory card manually .................................................................22
  1.4 Action at an alarm occurrence ...............................................................................................23
    1.4.1 Alarm type .........................................................................................................................23
    1.4.2 Action at an alarm occurrence ............................................................................................23
  1.5 Transmit images onto an FTP server .....................................................................................25
    1.5.1 Transmit an alarm image at an alarm occurrence (Alarm image transmission) ..............25
    1.5.2 Transmit images at a designated interval or period (FTP periodic image transmission) ..........25
    1.5.3 Save images on the SD memory card when images fail to transmit using the FTP periodic image transmission function ...............................................................26
  1.6 Display the log list ..................................................................................................................27
  1.7 Playback of images on the SD memory card .........................................................................31
    1.7.1 Playback “JPEG(1)/JPEG(2)/JPEG(3)” images saved to the SD memory card ..................31
    1.7.2 Playback “Stream(1)/Stream(2)/Stream(3)/Stream(4)” images saved to the SD memory card ..........34

2 Settings .......................................................................................................................................37
  2.1 About the network security .....................................................................................................37
    2.1.1 Equipped security functions .................................................................................................37
  2.2 Display the setup menu from a PC ............................................................................................38
    2.2.1 How to display the setup menu .............................................................................................38
    2.2.2 How to operate the setup menu ............................................................................................39
    2.2.3 About the setup menu window ..............................................................................................40
  2.3 Use Easy Setup [Easy Setup] ..................................................................................................42
    2.3.1 Configure the Internet settings [Internet] .............................................................................42
    2.3.2 Configure an event action [Event action] .............................................................................43
      2.3.2.1 Configure the schedule/alarm (event function type setup menu) ....................................45
      2.3.2.2 Alarm: Configure the VMD and audio detection (alarm setup menu) ................................46
      2.3.2.3 Alarm: Configure the alarm function type (Alarm function type setup menu) ..............47
      2.3.2.4 Alarm: Configure the details for image transfer or recording conditions .........................48
      2.3.2.5 Alarm: configure the mail notifications and mail server .................................................50
      2.3.2.6 Schedule: Configure SD recording or FTP periodic image transmission (schedule function type setup menu) ...........................................................................52
      2.3.2.7 Schedule: Set SD memory recording (video recording setup menu) ................................52
      2.3.2.8 Schedule: Configure FTP periodic image transmission (FTP periodic image transmission setup menu) ..................................................................................54
  2.4 Configure the basic settings of the camera [Basic] ................................................................58
    2.4.1 Configure the basic settings [Basic] .......................................................................................58
    2.4.2 Configure the settings relating to the SD memory card [SD memory card] .......................65
    2.4.3 Configure the settings relating to alteration detection [Alteration detection] .....................73
    2.4.4 How to configure alteration detection settings ......................................................................75
      2.4.4.1 Generation of the CRT key (encryption key) ....................................................................76
      2.4.4.2 Generation of CSR (Certificate Signing Request) ...........................................................76
2.4.3 Installation of the certificate issued by CA ............................................................... 78
2.4.4 Configuration of alteration detection ...................................................................... 79
2.5.1 Configure the settings relating to the image capture mode [Image] ............................. 83
2.5.2 Configure the settings relating to JPEG images [Image] ............................................. 85
2.5.3 Configure the settings relating to Stream [Image] ...................................................... 87
2.5.4 Configure the settings relating to image adjust, extra zoom, privacy zone, VIQS, and lens distortion compensation [Image quality] ....................................................... 94
2.5.4.1 Configure the settings relating to image quality (“Image adjust” setup menu) ............ 95
2.5.4.2 Set mask areas .......................................................................................................... 104
2.5.4.3 Adjust the angular field of view with extra zoom ..................................................... 106
2.5.4.4 Configure the settings relating to the privacy zone (“Privacy zone” setup menu) ......... 108
2.5.4.5 Configure the VIQS setting ...................................................................................... 110
2.5.4.6 Configure the VIQS area ......................................................................................... 112
2.5.4.7 Configure the settings relating to lens distortion compensation ......................... 114
2.5.5 Configure the settings relating to audio [Audio] .......................................................... 115
2.5.6 Configure the settings relating to the user authentication [User auth.] ......................... 119
2.5.7 Configure the settings relating to the camera action on alarm occurrence [Alarm] ........ 120
2.5.8 Configure settings relating to image quality on alarm action .................................... 121
2.5.9 Configure settings relating to alarm E-mail notifications ........................................... 122
2.5.10 Configure settings relating to FTP transmissions of alarm images ............................. 123
2.5.11 Configure settings relating to recording to an SD memory card when an alarm occurs .............................................................. 124
2.5.12 Configure settings relating to Panasonic alarm protocol notification when an alarm occurs ........................................................................................................... 125
2.5.13 Configure settings relating to HTTP alarm notification when an alarm occurs ............ 126
2.5.14 Configure the VMD settings [VMD area] .................................................................... 126
2.5.15 Set the VMD areas [VMD area] .................................................................................. 128
2.5.16 Configure the settings relating to the audio detection [Audio detection] ....................... 130
2.5.17 Configuration of the settings relating to alarm notification [Notification] ................. 132
2.5.18 Configure the settings relating to Panasonic alarm protocol ....................................... 133
2.5.19 Configure the settings relating to HTTP alarm notification ......................................... 135
2.5.20 Configure the settings relating to the authentication [User mng.] ................................. 137
2.5.21 Configure the settings relating to the user authentication [User auth.] .......................... 137
2.5.22 Configure the settings relating to the host authentication [Host auth.] ......................... 140
2.5.23 Configure IEEE 802.1X [IEEE 802.1X] ...................................................................... 141
2.5.24 Configure the data encryption settings [Data encryption] .......................................... 145
2.5.25 Configure the HTTPS settings .................................................................................. 153
2.5.26 Configure the settings related to sending E-mails ...................................................... 153
2.5.27 Configure the settings related to FTP transmission ..................................................... 157
2.5.28 Configure the settings relating to the NTP server ..................................................... 161
2.5.29 Configure the UPnP settings ..................................................................................... 162
2.5.30 Configure the HTTPS settings ................................................................................. 164
2.5.31 Configure the settings relating to DDNS .................................................................... 165
2.5.32 Configure the settings relating to SNMP .................................................................... 167
2.5.33 Configure the QoS settings ....................................................................................... 168
1 Operations

1.1 Monitor images on a PC

The following are descriptions of how to monitor images from the camera on a PC.

1.1.1 Monitor images from a single camera

1. Start up the web browser.
2. Enter the IP address designated using the Panasonic “IP Setting Software” in the address box of the browser.
   - Example when entering an IPv4 address: http://URL registered using IPv4 address
     http://192.168.0.10/
   - Example when entering an IPv6 address: http://[URL registered using IPv6 address]
     http://[2001:db8::10]/

<Example of IPv4 access>

<Example of IPv6 access>

IMPORTANT

- When the HTTP port number is changed from “80”, enter “http://IP address of the camera + : (colon) + port number” in the address box of the browser. (Example: http://192.168.0.11:8080)
- When the PC is in a local network, configure the proxy server setting of the web browser (under [Internet Options...] under [Tools] of the menu bar) to bypass the proxy server for the local address.

Note

- Refer to page 181 and page 186 for further information about the case in which “HTTPS” is selected for “HTTPS” - “Connection” on the [Advanced] tab of the “Network” page (→page 148).
3. Press the [Enter] key on the keyboard.
   → The “Live” page will be displayed. Refer to page 11 for further information about the “Live” page.

When “On” is selected for “User auth.”, the authentication window will be displayed before displaying live images for the user name and password entries.

**IMPORTANT**

- It is recommended to change the password periodically.
- When displaying multiple H.265 (or H.264) images on a PC, images may not be displayed depending on the performance of the PC.

**Note**

- The maximum number of concurrent access user is 14 including users who is receiving H.265 (or H.264) images and users who are receiving JPEG images. Depending on the set values for “Bandwidth control(bit rate)” and “Max bit rate (per client)”, the maximum concurrent access number may be 14 or less users. When 14 users are concurrently accessing, the access limit message will be displayed for users who subsequently attempt to access. When “Multicast” is selected for “Transmission type” of “Stream”, only the first user who accessed to monitor H.265 (or H.264) images will be included in the maximum number. The second and subsequent users who are monitoring H.265 (or H.264) images will not be included in the maximum number.
- If you set the “Stream transmission” (→ page 87) to “On”, an H.265 (or H.264) image will be displayed based on the settings of the “Stream encoding format”. If you set the “Stream transmission” (→ page 87) to “Off”, a JPEG image will be displayed. A JPEG image can be displayed even if the “Stream transmission” is set to “On”, but in that case, the transmission interval of the JPEG image will be limited to maximum 5 fps.
- The refresh interval may become longer depending on a network environment, PC performance, photographic subject, access traffic, etc.

<table>
<thead>
<tr>
<th>Refresh interval of JPEG images</th>
<th>When “On” is selected for “Stream transmission”</th>
</tr>
</thead>
<tbody>
<tr>
<td>max. 5fps</td>
<td>max. 30fps</td>
</tr>
</tbody>
</table>
1.1.2 About the “Live” page

**Note**
- The buttons and setting items displayed on the “Live” page can be changed depending on the user rights of the accessing user. You can set the user right settings from “User auth.” under “User mng.”. (→ page 137)

**[select language] pull-down-menu**
The camera’s display language can be selected. The default language can be set in the [Menu language] in the [Basic] settings. (→ page 58)

**[Login] button**
This button is displayed when “User auth.” is “On” and a person other than the administrator logs in, or when “User auth.” is “Off” and “Guest User” is set to “Use”. (→ page 137)
Even in the above case, the [Login] button will not be displayed if “Host auth.” is set to “On”, and the camera browser is opened from a host with administrator rights.

If login fails, close all the browsers, open the “Live” page and login once again.

**[Setup] button**
Displays the setup menu.

**[Live view] pull-down menu**
You can select and switch to the image to be displayed in the main area from the following:
Stream(1)/Stream(2)/Stream(3)/Stream(4)/JPEG(1)/JPEG(2)/JPEG(3)/Multi-screen
The image in the main area is displayed based on the contents set in Stream(1) – (4) (→ page 87), JPEG(1) – (3) (→ page 85), or Multi-screen (→ page 117).
Also the first stream displayed when you accessed the camera can be set from “Initial display stream” of the [Image] tab. For “Multi-screen”, you can set the “Initial display” in the [Multi-screen] tab.
1 Operations

**Note**
- When the image capture size is larger than “1280x960” or “1280x720”, the image may become smaller than the actual size depending on the window size of the web browser.

**Stream information display**
Displays the setup for stream encoding format, image capture size, bit rate, and frame rate for the live view of a stream.

**Note**
- Displays the values set in the stream. The actual bit rate and frame rate vary depending on the network environment and the used PC.

**[Refresh interval] pull-down menu**
This pull-down menu will be displayed only when a JPEG image is displayed. Use it to select the display method of the JPEG image.
- **MJPEG**: Uses viewer software to display JPEG images successively as MJPEG (Motion JPEG). Not available if the viewer software is not installed.
- **Refresh interval**: 1s/3s/5s/10s/30s/60s: Refreshes JPEG format (still images) images at the specified interval.

**Note**
- Depending on the network environment or the PC used, JPEG format (still images) images may not be refreshed at the specified interval.
- The [Refresh interval] pull-down on the “Live” page is not displayed for JPEG images with data encryption set to “On”.

**[Zoom] buttons**
Images will be zoomed in on with the electronic zoom by the viewer software “Network Camera View 4S”.
- **[x1] button**: The images in the main area will be displayed at x1.
- **[x2] button**: The images in the main area will be displayed at x2.
- **[x4] button**: The images in the main area will be displayed at x4.

**[Brightness] buttons**
The brightness is adjustable from 0 to 255. Click the button to make the image brighter, or click the button to make the image darker. If you click the [Normal] button, the display will be reset to default.

**[Rec. on SD] button**
The [Rec. on SD] button will be displayed only when “Manual” is selected for “Save trigger” on the [SD memory card] tab. (→page 70)
Click this button to manually record images on the SD memory card. Refer to page 22 for descriptions of how to manually record images on the SD memory card.

**[Log/Play] button**
When the [Log/Play] button is clicked, the log list will be displayed and images saved on the SD memory card can be played.
Refer to page 27 for further information about the log list and for how to play images on the SD memory card.

**[Viewer software] button**
Starts installation of the viewer software for display. This button will not be available if the viewer software is already installed on the PC, or if the “Automatic installation” of the [Viewer software (nwcv4Ssetup.exe)] in the [Basic] tab is set to “Off”. (→page 63)

**Camera title**
The camera title entered for “Camera title” on the [Basic] tab will be displayed. (→page 59)

**Support button**
When this button is clicked, the support site below will be displayed in a newly opened window. This website contains technical information, FAQ, and other information.
Alarm occurrence indication button
When an alarm occurs, the display flashes. When this button is clicked, the button will disappear.

Note
- Since the blinking of the alarm occurrence indication button is not coupled to recording images to the SD memory card, forwarding E-mails, or other operations, check the settings of each operation separately.

Full screen button
Images will be displayed on a full screen. If the full screen button is clicked once when the image displayed in the main area is smaller than the main area, the image is displayed corresponding to its image capture size. If the full screen button is clicked once when images are displayed corresponding to their image capture sizes, images are displayed in full screen. To return to the “Live” page when displaying an image in full screen, press the [Esc] key.

Snap shot button
Click this button to take a picture (a still picture). The picture will be displayed on a newly opened window. When right-clicking on the displayed image, the pop-up menu will be displayed. It is possible to save the image on the PC by selecting “Save” from the displayed pop-up menu. When “Print” is selected, printer output is enabled.

Note
- If the viewer software is not installed, “Save” and “Print” will not be displayed in the pop-up menu.
- The following settings may be required.
  Open Internet Explorer, click [Tools] → [Internet Options] → [Security] → [Trusted Sites] → [Sites]. Register the camera address on [Website] of the displayed trusted windows. After registration, close the web browser, and then access the camera again.
- When it takes longer than the specified period to obtain the snap shot picture due to the network environment, the snap shot picture may not be displayed.
- If the image capture size specified for JPEG cannot be obtained, JPEG images are displayed with the image capture size that could be obtained. Therefore, when JPEG images obtained with snap shot are displayed on a PC, the displayed image size may differ from the captured sized.
- If the encryption setting for JPEG(1), JPEG(2), or JPEG(3) is “On”, the Snap shot button is not displayed.

Mic input button
Turns on/off the audio reception (hear audio from the camera on a PC). This button will be displayed only when “Mic input” is selected for “Audio transmission mode” on the setup menu. (→page 115)
When the audio reception is turned off, the button will turn into the button and audio from the camera will not be heard.
Audio volume can be adjusted (Low/ Middle/ High) by moving the volume cursor .

Note
- When “Audio volume control mode” is set to “Adjust Mic input” in the setup menu, the volume cursor is not displayed when using “Audio recording”.
- When the camera is restarted, the adjusted volume level (for the reception) will return to the level that had been set on the [Audio] tab on the setup menu. (→page 115)
- Actual volume level will change in three steps even though the volume cursor can be adjusted minutely.
- If multiple camera browsers are open at the same time on the same computer, audio cannot be heard from the camera browsers that were opened later. Please only access 1 camera at a time.

SD recording status indicator
The status of the SD recording can be checked with this indicator.
1 Operations

When the SD recording starts, the SD recording status indicator will light red. It will go off when the SD recording stops. This indicator will be displayed when “Manual” or “Schedule” is selected for “Save trigger” on the setup menu. (→page 65)

Main area
Images from the camera will be displayed in this area. The current time and date will be displayed according to the settings configured for “Time display format” and “Date/time display format”. (→page 58)
In addition, when being adjusted, the status of brightness (→page 61) will be displayed as well as the characters configured for “Camera title on screen” (→page 60). The number of lines for the display is 2. A zoom operation can be performed using the mouse wheel.
When clicking a desired point while displaying live images at x2 or x4 in the main area, the camera will move to locate the clicked point at the center of the main area.

Note

- When the camera is operated by a user with a low access level, images displayed on the screen may be changed temporarily. This does not affect operation of the camera.
- Depending on the PC in use, screen tearing* may occur when the shooting scene drastically changes due to the GDI restrictions of the OS.
  *A phenomenon in which portions of the screen are displayed out of alignment.

1 Only operable by users whose access level is “1. Administrator”.
2 Only operable by users whose access level is “1. Administrator” or “2. Camera control” when “On” is selected for “User auth.” (→page 137)
1.1.3 Monitor images from multiple cameras

Images from multiple cameras can be displayed on a multi-screen. Images from 4, 9, and up to 16 cameras can be displayed simultaneously. To display images on a multi-screen, it is necessary to register cameras in advance. 4 cameras can be registered as a group and up to 4 groups (16 cameras) can be registered. (→page 117)

**IMPORTANT**

- When video is displayed in 4 screens and 9 screens, the video and audio may cut out because the transmission volume of other cameras is large. In such cases, the setting of the registered cameras needs to be changed to reduce the transmission volume.
  
  Example of setup to reduce the transmission volume:
  - Set the video transmission format to “H.265” or “H.264”.
  - Set the “Transmission priority” (→page 89) of the stream to “Best effort”.
- To enable the audio for multi-screen, the audio must be enabled for the camera.
- When 16 screens are used for the display, only still images (JPEG) can be refreshed.

**Note**

- Multi-screen can be used to display JPEG images, and H.265 (or H.264) images. If other cameras support audio, audio is also output.
- Adjust the volume when multi-screen is displayed.
- For further information about “Network Camera Recorder with Viewer Software Lite”, which is suited to viewing images from several cameras, refer to our website (https://security.panasonic.com/support/info/ <Control No.: C0301>).
- When you have registered a camera with the authentication function enabled, enter the user name and password of the “Administrator” for the registered camera in the “Authentication dialog”. Refer to the Panasonic support website below for information about the terms and conditions for use of multi-screen.
  https://security.panasonic.com/support/info/ <Control No.: C0302>
1. From the “Live view” pull-down menu in the “Live” page, select “Multi-screen”.
   
   → Images from the registered cameras will be displayed on a selected multi-screen (screen can be split up to 16 areas). The following are instructions when displaying on a 4-split screen.

   “Live view” pull-down menu
   
   Select the image displayed in the main area.

   [Layout] pull-down menu
   
   Select from the pull-down menu to display images from cameras in multi-screens of 4 to 9 or even 16 screens.

   [Refresh interval] pull-down menu
   
   Select from the pull-down menu and switch between video (H.265/H.264/MJPEG) and still images (JPEG).

   For still images (JPEG), select the refresh interval (Refresh interval : 1s/Refresh interval : 3s/Refresh interval : 5s/Refresh interval : 10s/Refresh interval : 30s/Refresh interval : 60s) for camera images.

   When the 16 screen layout is used, Refresh interval : 1s cannot be selected.

   Note
   
   • When “On” is selected for Stream(1), “H.265” or “H.264” can be selected.
   • When “H.265” is selected, H.264 or MJPEG video may be displayed depending on the settings of the connected camera.
   • When “H.264” is selected, H.265 or MJPEG video may be displayed depending on the settings of the connected camera.

   [Image capture size] pull-down menu
   
   Select the image capture size from the pull-down menu to change it.

   When you select “4 Screens” in the [Layout] pull-down menu, the image capture size of the camera changes.
   
   • When the aspect ratio is 4:3:
     Switching between QVGA (default) and VGA
   • When the aspect ratio is 16:9:
     Switching between 320×180 (default) and 640×360
5 Full screen display
If you press the full screen button, the display of the camera image will be maximized. If you click the reset button in the full screen display, the display size will be reset to original size.

6 Camera title
If you click the camera title, live images from the corresponding camera will be displayed on the “Live” page of the newly opened window.

7 Camera control bar
Can be used to get snap shot of JPEG images or to adjust the PC mic input/output volume (mic input).

Note
- The frame rate may drop depending on the network environment and number of accessing users.
- If the image capture size specified for JPEG cannot be obtained, a JPEG image with an image capture size that could be obtained is displayed. Therefore, when JPEG images obtained with snap shot are displayed on a PC, the displayed image size may differ from the captured sized.
- When in full screen display, click&centering and zoom are not available.
- When a video (H.265/ H.264/ MJPEG) is selected from the “Refresh interval” pull-down menu, a different video from the setting may be displayed subject to the connected camera settings.
1.2 Monitor images on a cellular phone/mobile terminal

1.2.1 Monitor images on a cellular phone

It is possible to connect to the camera using a cellular phone via the Internet and monitor images (JPEG only) from the camera on the screen of the cellular phone. It is also possible to refresh images to display the latest image.

**IMPORTANT**

- When the authentication window is displayed, enter the user name and password. To enhance the security, it is recommended to change the password periodically. (→page 137)
- If the cellular phone in use is not compatible with UTF-8 encode, it is impossible to display the screen correctly.
- When “VGA”, “QVGA”, “640x360”, or “320x180” is not selected for either one of “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” of [JPEG] on the [Image] tab, images cannot be viewed from cellular phones.
- Audio is not supported for cellular phones.

**Note**

- It is necessary to configure the network settings of the cellular phone in advance to connect to the Internet and monitor images from the camera. (→page 148)
- When “Auto” is selected for “Menu language”, the screen is displayed in English. If you want the screen to be displayed in Japanese or Chinese, select “Japanese” or “Chinese” for “Menu language”. (→page 58)
- For further information about compatible devices, refer to our website (https://security.panasonic.com/support/info/ <Control No.: C0108>).

   → Images from the camera will be displayed.

![Image Control Panel](image.png)

1. Refresh control
   - Press the dial key “5” or the [Manual Refresh] button to refresh the camera images.
   - Press the [Auto Refresh] button to refresh the images from the camera in 5-second intervals.
When the dial key “5” or the [Manual Refresh] button is pressed again, the refresh mode of the camera will return to manual refresh.

**IMPORTANT**
- Transmission will be periodically performed when “Auto Refresh” is selected for the camera image. Confirm the contract plan of the cellular phone in use before using this function.
- Depending on the cellular phone in use, “Auto Refresh” may be unavailable.

 Resolution control
 Changes the image capture size by pressing the dial key “0”.
- Image in the aspect ratio of “4:3”: Changes the image capture size between 320x240 (default) and 640x480.
- Image in the aspect ratio of “16:9”: Changes the image capture size between 320x180 (default) and 640x360.

**Note**
- Some cellular phones cannot change the image capture size even when resolution is changed by resolution control.
- Depending on the image capture size selected for “JPEG(1)”, “JPEG(2)” or “JPEG(3)”, “Resolution” may not be able to be used.
- When the HTTP port number is changed from “80”, enter “http://IP address: (colon) + port number/mobile” in the address box of the browser. When using the DDNS function, access to “http://Host name registered in the DDNS server: (colon) + port number/mobile”.
- When “HTTPS” is selected for “HTTPS” - “Connection” on the [Advanced] tab of the “Network” page, enter as follows.
  “https://IP address: (colon) + port number/mobile” or “https://Host name registered in the DDNS server: (colon) + port number/mobile”
- When the authentication window is displayed, enter the user name of an administrator or user and password. Depending on the cellular phone in use, password entry may be required each time the screen is switched.
- Depending on the cellular phone in use, larger size images may not be displayed. In this case, selecting a setting close to the lowest quality setting for “Image quality setting” of “JPEG” (→page 85) may sometimes solve this problem.
- Depending on the cellular phone in use or its contract plan, it may be impossible to access.
- The operations menu displayed on the mobile telephone screen may not be displayed depending on the user rights and access level of the accessing user. To display the operations menu, it is necessary to set the user rights and access level (“User auth.” in “User mng.”). (→page 137)

*1 IP address is the global WAN IP address of the router that can be accessed via the Internet.

### 1.2.2 Monitor images on a mobile terminal (including smartphones)

It is possible to connect to the camera using a mobile terminal via the Internet and monitor images (MJPEG or JPEG) from the camera on the screen of the mobile terminal. It is also possible to refresh images to display the latest image.

The compatible mobile terminals are shown as follows. (As of October, 2018)
- iPad, iPhone (iOS 4.2.1 or later)
- Android™ mobile terminals

When an Android terminal is used, an MJPEG format image is displayed by the Firefox® browser, and a JPEG format image is displayed by the standard browser.
1 Operations

For further information about compatible devices, refer to our website (https://security.panasonic.com/support/info/<Control No.: C0108>)

**IMPORTANT**
- When the authentication window is displayed, enter the user name and password. To enhance the security, it is recommended to change the password periodically. (→page 137)

**Note**
- It is necessary to configure the network settings of the mobile terminal in advance to connect to the Internet and monitor images from the camera. (→page 148)

1. Access to “http://IP address/cam”\(^1\) or “http://Host name registered in the DDNS server/cam”\(^2\) using a mobile terminal.
   → Images from the camera will be displayed.

---

**Live images area**
Displays images from the camera.

**Operation buttons area**
Buttons to operate functions are displayed.

**Note**
- The operations button displayed on the mobile terminal screen may not be available depending on the user rights and access level of the accessing user. To display the operations button, it is necessary to set the user rights and access level (“User auth.” in “User mng.”). (→page 137)
2. Click the button of the function that you want to operate.

Resolution control

The resolution can be changed by selecting a resolution setting from the buttons. Images are displayed in the image capture size selected in “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” of [JPEG] on the [Image] tab.

Note

• You can change the image size displayed on the mobile terminal by accessing the following addresses.
  – Large display: http://IP address/cam/dl
  – Medium display: http://IP address/cam/dm
  – Small display: http://IP address/cam/ds
• When the resolution is changed by the resolution control, the displayed resolution changes but the image size remains the same.
• When the HTTP port number is changed from “80”, enter “http://IP address: (colon) + port number/cam”*1 in the address box of the browser. When using the DDNS function, access to “http://Host name registered in the DDNS server: (colon) + port number/cam”*2.
• When “HTTPS” is selected for “HTTPS” - “Connection” on the [Advanced] tab of the “Network” page, enter as follows.
  “https://IP address: (colon) + port number/cam” or “https://Host name registered in the DDNS server: (colon) + port number/cam”
• When the authentication window is displayed, enter the user name of an administrator or user and password. Depending on the mobile terminal in use, password entry may be required each time the screen is switched.
• It is impossible to receive audio using a mobile terminal.
• Depending on the mobile terminal in use, larger size images may not be displayed. In this case, selecting a setting close to the lowest quality setting for “Image quality setting” of “JPEG” (→page 85) may sometimes solve this problem.
• Depending on the mobile terminal in use or its contract plan, it may be impossible to access.

*1 IP address is the global WAN IP address of the router that can be accessed via the Internet. However, when accessing the same LAN as the camera with a wireless compatible mobile terminal, the IP address is the local IP address.
*2 Only when accessing the camera via the Internet.
1.3 Record images on the SD memory card manually

Images displayed on the “Live” page can be recorded on the SD memory card manually. This button is operable only when “Manual” is selected for “Save trigger” on the [SD memory card] tab on the “Basic” page of the setup menu. (→page 70)

It is possible to select “JPEG(1)”, “JPEG(2)”, “JPEG(3)”, “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” on “Recording format” of the setup menu. (→page 69) When “JPEG(1)”, “JPEG(2)”, or “JPEG(3) is selected for “Recording format”, still image data are recorded. When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected, video data are recorded.

Images recorded on the SD memory card can be copied onto the PC. (→page 80)

1. Display the “Live” page. (→page 9)

2. Click the [Rec. on SD] button.
   → The SD recording window will open.

3. Click the [Start] button to start recording images on the SD memory card. The SD recording status indicator will light red (→page 11) while images are being recorded on the SD memory card.
   The image saving interval can be configured on the [SD memory card] tab of the “Basic” page. (→page 65)

4. Click the [Stop] button to stop saving images on the SD memory card.
   → The SD recording status indicator will turn off.

5. Click the [Close] button to close the window.

Note
- Image data saved on Drive B can be obtained by executing “Access img.” on the [SD memory card] tab and logging in from the user authentication window (→page 80).
- The destination to save image data is a fixed directory on Drive B (→page 230).
- When the [Start] button is clicked immediately after the [Stop] button is clicked, saving of images may not start. In this case, click the [Start] button again.
1.4 Action at an alarm occurrence

The alarm action (camera action at an alarm occurrence) will be performed when the following alarms occur.

1.4.1 Alarm type

- **VMD alarm**: When motion is detected in the set VMD area, the alarm action will be performed. "VMD stands for “Video Motion Detection”.
- **Audio detection alarm**: When the configured audio detection level is exceeded, the alarm action will be performed.
- **Command alarm**: When a Panasonic alarm protocol is received from the connected device via a network, the alarm action will be performed.

1.4.2 Action at an alarm occurrence

**Display the alarm occurrence indication button on the “Live” page**

The alarm occurrence indication button will be displayed on the “Live” page at an alarm occurrence. (→ page 11)

**IMPORTANT**

- When “Polling(30s)” is selected for “Status update mode” (→ page 58), the Alarm occurrence indication button will be refreshed in 30-second intervals. For this reason, it may take a maximum of 30 seconds until the alarm occurrence indication button is displayed on the “Live” page at an alarm occurrence.

**Save images on the SD memory card**

When an alarm occurs, images (JPEG/H.265/H.264) will be saved on the SD memory card. The settings to save images on the SD memory card can be configured on the [SD memory card] tab (→ page 65) of the “Basic” page and the [Alarm] tab of the “Alarm” page. (→ page 120)

**Transmit an image onto a server automatically**

An alarm image can be transmitted at an alarm occurrence to the server designated in advance. The settings required to transmit an alarm image to a server can be configured in the “Alarm image” section on the [Alarm] tab of the “Alarm” page (→ page 120) and the [Advanced] tab of the “Network” page (→ page 157).

**Notify of alarm occurrences by E-mail**

Alarm E-mail (alarm occurrence notification) can be sent at an alarm occurrence to the E-mail addresses registered in advance. Up to 4 addresses can be registered as recipients of the alarm E-mail. An alarm image (still picture) can be sent with the alarm E-mail as an attached file. The settings for alarm E-mail can be configured in the “Alarm E-mail notification” section on the [Alarm] tab of the “Alarm” page (→ page 120) and the [Advanced] tab of the “Network” page (→ page 153).
Notify of alarm occurrences to the designated addresses (Panasonic alarm protocol notification)

This function is available only when a Panasonic device, such as the network disk recorder, is connected to the system. When “On” is selected for “Panasonic alarm protocol”, the connected Panasonic device will be notified that the camera is in the alarm state. The settings for Panasonic alarm protocol can be configured in the “Panasonic alarm protocol notification” section of the [Notification] tab of the “Alarm” page. (→page 133)

Notify of alarm occurrences to the designated HTTP server (HTTP alarm notification)

Alarm occurrence notifications can be sent at an alarm occurrence to the HTTP servers registered in advance. Up to 5 HTTP servers can be registered as recipients of alarm notifications. The URL sent to HTTP servers with alarm notifications can be specified. The settings for HTTP alarm notification can be configured on the [Notification] tab of the “Alarm” page. (→page 135)
1.5 Transmit images onto an FTP server

Images can be transmitted to an FTP server. By configuring the following settings, transmission of images captured at an alarm occurrence or captured at a designated interval to an FTP server will become available.

**IMPORTANT**

- When using this function, set the user name and the password to access the FTP server to restrict users who can log into the FTP server.

1.5.1 Transmit an alarm image at an alarm occurrence (Alarm image transmission)

An alarm image can be transmitted at an alarm occurrence to the FTP server. To transmit alarm images to an FTP server, it is necessary to configure the settings in advance.

FTP server settings and settings relating to alarm image transmission can be configured in the “FTP” section of the [Advanced] tab of the “Network” page. (→page 157) Settings can also be configured from the “Alarm image FTP transmission” settings of “Camera action on alarm” on the [Alarm] tab of the “Alarm” page. (→page 120)

**Note**

- Depending on the network traffic, the number of the transmitted images may not reach the set number of images to be transmitted.
- Alarm images failed to be transmitted to the FTP server at an alarm occurrence will not be saved on the SD memory card. However, images that fail to be transmitted with the FTP periodic image transmission will be saved.

When “On” is selected for both the alarm image transmission function and the FTP periodic image transmission function, the alarm image transmission function will be given priority over the FTP periodic image transmission function. Also, when “On” is selected for the “FTP transmission retry” FTP setting (→page 158), alarm images will be retransmitted if there is an FTP transmission failure. Therefore, if there is continuous retransmission due to network problems or other factors, periodic transmission will not be performed and images that fail to be transmitted with the FTP periodic image transmission will not be saved to an SD memory card.

1.5.2 Transmit images at a designated interval or period (FTP periodic image transmission)

Images can be transmitted at a designated interval or period. To transmit images at a designated interval or period, it is necessary to configure the settings in advance.

FTP server settings and settings relating to FTP periodic transmission image transmission can be configured in the “FTP” section of the [Advanced] tab of the “Network” page. (→page 157)

When using FTP periodic image transmission, it is necessary to configure the schedule settings of FTP periodic image transmission on the [Schedule] tab of the “Schedule” page.

Configure the schedule settings of the FTP periodic image transmission on the “Schedule” page. (→page 196)

**Note**

- Depending on the line speed or the traffic, images may not be transmitted at the designated interval.
- When “On” is selected for both the alarm image transmission function and the FTP periodic image transmission function, the alarm image transmission function will be given priority over the FTP periodic image transmission function.
image transmission function. Therefore, images may not be transmitted at the interval designated on the “FTP periodic image transmission” setting.

1.5.3 Save images on the SD memory card when images fail to transmit using the FTP periodic image transmission function

Images that have failed to transmit using the FTP periodic image transmission can be saved automatically on the SD memory card. It is possible to select a trigger to save images on the SD memory card on the [SD memory card] tab of the “Basic” page. (→page 65)

To use the SD memory backup function featured in Panasonic network disk recorder, select “Off” for “FTP periodic image transmission” (→page 159) and “FTP periodic image transmission error” for “Save trigger” of “Recording stream 1” (→page 70).

Note
• When “On” is selected for both the alarm image transmission function and the FTP periodic image transmission function, the alarm image transmission function will be given priority over the FTP periodic image transmission function. Also, when “On” is selected for the “FTP transmission retry” FTP setting (→page 157), alarm images will be retransmitted if there is an FTP transmission failure. Therefore, if there is continuous retransmission due to network problems or other factors, periodic transmission will not be performed and images that fail to be transmitted with the FTP periodic image transmission will not be saved to an SD memory card.

IMPORTANT
• We make no guarantee for any damages of files on the SD memory card incurred by malfunction or error occurrence in files saved in the SD memory card regardless of what the cause may be.
1.6 Display the log list

The history of various logs will be displayed in list form.

- **Alarm log**: Logs of the alarm occurrences such as time and date of the alarm occurrences, the image recording period and the alarm type will be displayed.
- **Manual/Schedule log**: Logs filed when images have been recorded manually or during the period of the schedule, and the image recording period will be displayed.
- **FTP trans. error log**: Logs filed when the FTP periodic image transmission function has failed will be displayed.

1. Display the “Live” page.
2. Click the [Log/Play] button.
   → The log list will be displayed in a newly opened window (log list window).

---

**IMPORTANT**

- Only a single user can operate the log list window. Other users cannot access the log list window.

1. **Time**
   Displays the time period of the data recorded on the SD memory card.

2. **Event**
   Select a log type to display on the log list.
   - **All**: All logs will be displayed.
   - **Select**: Only the logs of the selected log type will be displayed.
     - **Alarm log**: The log when an alarm is detected will be displayed.
     - **Manual/Schedule log**: Manual and Schedule logs will be displayed.
     - **FTP trans. error log**: Logs filed when the FTP periodic image transmission function has failed will be displayed.
   - **Default**: All

**Note**

- When “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” is selected for “Recording stream 1”, the FTP trans. error log will be displayed.
3 Recording time
Configure the time period of logs displayed on the log list.
- **From:** Configure the starting period of logs displayed on the log list.
  - **First recording:** Displays from the first log recorded on the SD memory card.
  - **Today:** Displays the logs recorded today.
  - **Yesterday:** Displays the logs recorded from yesterday to the present day.
  - **Last 7 days:** Displays the logs recorded from 6 days ago to the present day.
  - **Last 30 days:** Displays the logs recorded from 29 days ago to the present day.
  - **Date/time:** Displays the logs recorded from the entered date and time on “Date/time” box.
- **To:** Configure the ending period of logs displayed on the log list when “First recording” or “Date/time” is selected for “From”.
  - **Last recording:** Displays until the last log recorded on the SD memory card.
  - **Date/time:** Displays the logs recorded until the entered date and time on “Date/time” box.

4 [Search] button
Searches for logs according to the conditions specified in “Event” and “Recording time”. The search result will be displayed on the log list.

5 Log list
Displays the log search results.
You can play back recorded data by clicking on the time or duration of the recorded data displayed under [Time & date] and [Duration].
- **(Top) button:** Click this button to display the log listed at the top.
- **(Prev. page) button:** Click this button to display the previous page of the log list.
- **(Next page) button:** Click this button to display the next page of the log list.
- **(Last) button:** Click this button to display the log listed at the bottom.
- **[Time & date]:** Time and date when each log has been recorded will be displayed.

**Note**
- When “Off” is selected for “Time display format”, the alarm occurrence times are displayed in 24 hour time format.
- The recording timing of logs is as follows.
  - **Alarm log:** Alarm occurrence time and date will be filed as a log.
  - **Manual/Schedule log:** Time and date when recording of images onto the SD memory card started manually or during the period of the schedule will be filed as a log. When images are recorded sequentially, if “JPEG” is selected for “Recording format”, logs will be filed on the hour every hour (12:00, 1:00, 2:00, etc.). If “Stream” is selected for “Recording format”, logs will be filed every hour from the time when recording starts.
  - **FTP trans. error log:** Logs will be filed every one hour.
- **[Duration]:** Displays the period of time that the data has been recorded on the SD memory card.

**Note**
- The difference between the recording end time and recording start time of the image is calculated by rounding off to the nearest tenth of a second. For this reason, when only 1 JPEG image is saved, 00:00:00 is displayed for the duration.
- **[Event]:** The event type will be displayed.
  - **MN/SC:** Log by “Manual/Schedule”
  - **VMD:** Alarm by VMD alarm
  - **AUD:** Alarm by audio detection alarm
  - **COM:** Alarm by command alarm
  - **FTP:** Logs saved from FTP periodic image transmission errors
1 Operations

- **[SD memory card]**: Available capacity and the original capacity of the SD memory card will be displayed.
- **(Delete) button**: Deletes log lists from all pages. When logs are searched for, only the searched logs are deleted. Images associated with deleted logs will also be deleted.

**IMPORTANT**
- If there are many recorded data files on the SD memory card, it may take time to delete all of them. (For example, when the total size is 1 GB, it may take about 1 hour to delete the files.) In this case, format the SD memory card. However, please note that formatting will delete all of the files on the SD memory card.
- In the process of the deletion, “Alarm” and “Manual/Schedule” cannot be operated.
- Do not turn off the power of the camera until the deletion is complete. When the power of the camera is turned off in the process of the deletion, some images may remain on the SD memory card. In this case, click the **(Delete) button** on the same log list window used to delete the logs.

- **(Download) button**: Click this button to download all logs of the selected log list onto the PC.

**Note**
- The following settings may be required.
  Open Internet Explorer, click [Tools] → [Internet Options] → [Security] → [Trusted Sites] → [Sites]. Register the camera address on [Website] of the displayed trusted windows.
  After registration, close the web browser, and then access the camera again.
- Up to 50,000 logs will be downloaded to the SD memory card. When more than 50,000 logs are filed, the older logs will be overwritten by the newer logs. In this case, the oldest log is the first to be overwritten.
  If there are many logs, it may take time to download the logs.

- **(Close) button**: Click this button to close the log list window.
1.7 Playback of images on the SD memory card

When clicking a time and date listed on the log list window, the “Live” page will turn to the “Playback” page. When images associated with the clicked time and date are on the SD memory card, the first image of them will be displayed.

The display format varies depending on the “Recording format” of the SD memory card.

**IMPORTANT**

- Refresh interval of images may become slow during playback or download.
- When many images are saved on the SD memory card, it may take time to display images on the “Playback” page.
- When the aspect ratio is “4:3”, images will be displayed in VGA size on the “Playback” page regardless of the image capture size of the images saved on the SD memory card. When the aspect ratio is “16:9”, images will be displayed in “640×360” on the “Playback” page regardless of the image capture size of the images saved on the SD memory card. Therefore, images may look coarse on the “Playback” page.
- When playing images by selecting an FTP error log on the log list, images may not be played in order of images recorded on the SD memory card if they have been recorded on the SD memory card with selected value for the “Transmission interval” setting of “FTP periodic image transmission” on the [Advanced] tab is “1min” or less.
- The playback refresh interval may become slower when recording data to the SD memory card.

1.7.1 Playback “JPEG(1)”/“JPEG(2)”/“JPEG(3)” images saved to the SD memory card

When clicking a time and date listed on the log list window, total number of images associated with the clicked time and date, and the number of the currently displayed image will be displayed.
1 Operations

Note
- Enter the desired number of image and press the [Enter] key on the keyboard. The image of the designated number will be displayed.

REW (REW) button
Each time the button is clicked, the playback speed will change.
When the button or the button is clicked during fast reverse playback, playback speed will return to the normal playback speed.

REV PLAY (REV PLAY) button
Images will be played in reverse sequential order.

PLAY (PLAY) button
When this button is clicked, images will be played in sequential order.

FF (FF) button
Each time the button is clicked, the playback speed will change.
When the button or the button is clicked during fast playback, playback speed will return to the normal playback speed.

TOP (TOP) button
The first image will be displayed.

PREV. IMAGE (PREV. IMAGE) button
The previous frame will be displayed and paused when this button is clicked during playback.
Each time this button is clicked during pausing, the frame previous to the currently displayed frame will be displayed.

Note
- When the mouse button is held down while the mouse pointer is on this button, the image number will be decreased.
  When the mouse button is released, the decreasing of the image number will stop and the image corresponding to the currently displayed number will be displayed.

PAUSE (PAUSE) button
Playback will be paused when this button is clicked during playback.
Playback will resume when this button is clicked during pausing.

STOP (STOP) button
Playback will stop and the “Playback” window will turn to the “Live” page.

NEXT IMAGE (NEXT IMAGE) button
The next frame will be displayed and paused when this button is clicked during playback.
Each time this button is clicked during pausing, the frame next to the currently displayed frame will be displayed.
1 Operations

**Note**
- When the mouse button is held down while the mouse pointer is on this button, the image number will be increased. When the mouse button is released, the increment of the image number will stop and the image number displayed at the moment when the mouse button is released will be displayed.

(LAST) button
The last image will be displayed.

(Start) button
The selected image will be downloaded onto the PC. Before downloading images, designate the destination directory in advance. (→page 82)
The following window will be displayed when the button is clicked. Select the image to be downloaded, and then click the [OK] button.

• **All:** All images saved at the selected time and date will be downloaded.
• **Current image:** Only the currently displayed image will be downloaded.
• **Download range:** Images in the specified range will be downloaded.

**Note**
- When the [Cancel] button is clicked in the process of the download, the download will be canceled. In this case, images already downloaded before clicking the [Cancel] button will be saved on the PC.

(Browse) button
When successfully logged in after the user authentication process, a folder on the SD memory card in which images are saved will be displayed. (→page 80)

**Note**
- FTP access to camera must be allowed.
  Select “Allow” for “FTP access to camera” on the [Network] tab.
- When accessing the camera from a PC, there is a possibility that authentication information (user names, passwords, etc.) will be leaked. When obtaining images from the SD memory card, we recommend selecting “Digest” for “Authentication” of “User auth.”, or encrypting access using the HTTPS function before downloading from the image playing screen of the SD memory card.
1.7.2 Playback “Stream(1)”/“Stream(2)”/“Stream(3)”/“Stream(4)” images saved to the SD memory card

**IMPORTANT**

- Depending on the network environment, download of video data may fail. If downloading failed while playing images, you may be able to download images after stopping the currently played images and starting the download again.
- Depending on the network environment and status of the camera, you may not be able to operate each operation on this screen consecutively.

![Slider bar](image)

① **Slider bar**

By operating the slider bar, you can select where to start playing images from. The slider bar can only be used before playing images, or when playing is paused or stopped.

② **(PAUSE) button**

Playback will be paused when this button is clicked during playback.

③ **(PLAY) button**

When this button is clicked, recorded data will be played.

**Note**

- If audio is recorded, it can be played back, but the image and audio will not be synchronized. Therefore, images and audio may not always match. When data is being recorded to the SD memory card, audio may sound as if it is cutting out and the audio quality may be reduced.
- When recorded audio is played back, the refresh interval of live images and playback may become slow.
- Recorded audio is not played back when “Off” is selected for “Audio transmission mode” on the [Audio] tab of the “Image/Audio” page.
(FF) button
Each time this button is clicked, the playback speed will change. When the (FF) button is clicked during fast playback, playback speed will return to the normal playback speed.

Note
• The maximum speed of the fast playback varies depending on the setting of “Bit rate” - “Stream recording” of the SD memory card.
• Recorded audio will not be played back during fast playback.

(5s backward) button
Each time this button is clicked, the recorded data goes back by 5 seconds and starts playing.

(5s forward) button
Each time this button is clicked, the recorded data goes forward by 5 seconds and starts playing.

(STOP) button
Playback will stop and the “Playback” window will turn to the “Live” page.

[Time & date]
Time and date when each log has been recorded will be displayed.

[Duration]
Displays the period of time that the data has been recorded on the SD memory card.

[Event]
The event type will be displayed.
• MN/SC: Log by “Manual/Schedule”
• VMD: Alarm by VMD alarm
• AUD: Alarm by audio detection alarm
• COM: Alarm by command alarm

(Start) button
The selected image will be downloaded onto the PC.
Before downloading images, designate the destination directory in advance. (→ page 82)
The message window will be displayed to ask if it is OK to start download when the (Start) button is clicked. Click the [OK] button.

Note
• The image playing screen cannot be operated while downloading. Perform operations after the downloading is completed.
• When the [Cancel] button is clicked in the process of the download, the download will be canceled. In this case, video data already downloaded before clicking the [Cancel] button will be saved on the PC.
• Video data are saved in the files of approx. 20 MB. When the file size of video data is more than 20 MB, two or more files will be downloaded.
• It is possible to play back H.264 video data saved on the PC using such applications as Windows Media® Player. However, we are not liable for performance relating to these applications.
• Depending on the status of the SD memory card or Windows Media Player, H.264 video data cannot be played back.
• For information on playing back H.265 video data, refer to the following Panasonic website below.
https://security.panasonic.com/support/info/ <Control No.: C0303>
2 Settings

2.1 About the network security

2.1.1 Equipped security functions

The following security functions are featured in this camera.

① Access restrictions by the host authentication and the user authentication
   It is possible to restrict users from accessing the camera by setting the host authentication and/or the user authentication to “On”. (→page 137, page 140)

② Access restrictions by changing the HTTP port
   It is possible to prevent illegal access such as port scanning, etc. by changing the HTTP port number. (→page 150)

③ Access encryption by the HTTPS function
   It is possible to enhance the network security by encrypting the access to cameras using the HTTPS function. (→page 170)

**IMPORTANT**

- Design and enhance security countermeasures to prevent leakage of information such as image data, authentication information (user name and password), alarm E-mail information, FTP server information, DDNS server information, etc. Perform the countermeasure such as access restriction (using the user authentication) or access encryption (using the HTTPS function).
- After the camera is accessed by the administrator, make sure to close the browser for added security.
- Change the administrator password periodically for added security.

**Note**

- When user authentication (authentication error) has failed to pass 8 times within 30 seconds using the same IP address (PC), access to the camera will be denied for a while.
2.2 Display the setup menu from a PC

The settings of the camera can be configured on the setup menu.

**IMPORTANT**
- The setup menu is only operable by users whose access level is “1. Administrator”. Refer to page 137 for how to configure the access level.

2.2.1 How to display the setup menu

1. Display the “Live” page. (→page 9)
2. Click the [Setup] button on the “Live” page.
   → The window with the user name and password entry fields will be displayed.

3. Click the [OK] button after entering the user name and the password.
   → The setup menu will be displayed. Refer to page 40 for further information about this menu.
2.2.2 How to operate the setup menu

1. Click the desired button in the frame on the left of the window to display the respective setup menu. When there are tabs at the top of the “Setup” page displayed in the frame on the right of the window, click the desired tab to display and configure the setting items relating to the name of the tab.
2. Complete each setting item displayed in the frame on the right of the window.
3. After completing each setting item, click the [Set] button to apply them.

**IMPORTANT**

- When there are two or more [Set], [Register], and [Execute] buttons on the page, click the respective button to the edited setting item.

<Example>

When completing the setting items in field ①, click the [Set] button ② below field ①. The edited settings in field ① will not be applied unless the [Set] button ② below field ① is clicked. In the same manner as above, click the [Set] button ④ below field ③ when completing the setting items in field ③.
2.2.3 About the setup menu window

1. [Setup] button
   Display the “Setup” page.

2. [Live] button
   Display the “Live” page.

3. [Easy Setup] button
   Displays the “Easy Setup” page. The “Easy Setup” page is used to set the connectivity to the Internet, as well as to set event actions such as alarm settings and camera action on alarm. (→page 42)

4. [Basic] button
   Displays the “Basic” page. The basic settings such as time and date and camera title, and the settings relating to the SD memory card can be configured on the “Basic” page. (→page 58)

5. [Image/Audio] button
   Displays the “Image/Audio” page. The settings relating to image quality, image capture size, etc. of JPEG/H.265/H.264 camera images can be configured on the “Image/Audio” page. (→page 83)

6. [Multi-screen] button
   Displays the “Multi-screen” page. The cameras from which images are to be displayed on a multi-screen can be registered on the “Multi-screen” page. (→page 117)

7. [Alarm] button
   Displays the “Alarm” page. The settings relating to alarm occurrences such as settings for the alarm action at an alarm occurrence, the alarm occurrence notification, and the VMD area settings can be configured on the “Alarm” page. (→page 119)

8. [User mng.] button
   Displays the “User mng.” page. The settings relating to the authentication such as users and PC restrictions for accessing the camera and the data encryption can be configured on the “User mng.” page. (→page 137)
[Network] button
Displays the “Network” page. The network settings and the settings relating to DDNS (Dynamic DNS), SNMP (Simple Network Management Protocol), FTP (File Transfer Protocol), the NTP server, and QoS can be configured on the “Network” page. (→page 148)

[Schedule] button
Displays the “Schedule” page. On the “Schedule” page, it is possible to designate time zones to allow to activate the VMD detection function. (→page 193)

[Maintenance] button
Displays the “Maintenance” page. System log check, firmware upgrade, status check and initialization of the setup menu can be carried out on the “Maintenance” page. (→page 200)

[Support] button
Displays the “Support” page. The “Support” page contains methods to display the Panasonic Support Website. (→page 208)

Camera title
The title of the camera whose settings are currently being configured will be displayed.

Setup page
Pages of each setup menu will be displayed. There are tabs for some setup menus. The bottom of the settings page has been omitted.
2.3 Use Easy Setup [Easy Setup]

The “Easy Setup” page uses simple operations to set the following:
– Make the camera image available on the Internet
– Set event actions such as recording of a schedule/alarm to the SD memory card

The “Easy Setup” page consists of the [Internet] tab and [Event action] tab.

2.3.1 Configure the Internet settings [Internet]

Click the [Internet] tab of the “Basic” page. (page 38, page 39)

The settings relating to UPnP (Auto port forwarding), DDNS (Viewnetcam.com), and network settings for the Internet can be configured on this page.

[UPnP (Auto port forwarding)]
Select “On” or “Off” to determine whether or not to use the port forwarding function of the router.

To use the auto port forwarding function, the router in use must support UPnP and the UPnP must be enabled.

• Default: Off

Note
• Due to auto port forwarding, the port number may sometimes be changed. When the number is changed, it is necessary to change the port numbers registered in the PC and recorders, etc.
• The UPnP function is available when the camera is connected to the IPv4 network. IPv6 is not supported.
• To check if auto port forwarding is properly configured, click the [Status] tab on the “Maintenance” page, and check that the “Enable” is displayed for “Status” of “UPnP”. (page 202)
  When “Enable” is not displayed, refer to “Cannot access the camera via the Internet.” in 3.3 Troubleshooting.
• When the “UPnP (Auto port forwarding)” setting is changed, the “Auto port forwarding” setting under “UPnP” on the [Advanced] tab of the “Network” page also changes to the same setting.

[Area]
Select the region where the camera is installed.

Global/Japan

Note
• If the camera is used in Japan, select “Japan”. If the camera is used outside of Japan, select “Global”. The “Viewnetcam.com” service that is displayed when “Global” is selected cannot be used in Japan.
[Service]
Select “Viewnetcam.com” or “Off” to determine whether or not to use “Viewnetcam.com”. After configuring “Viewnetcam.com”, click “Go to Viewnetcam.com Registration page” to display the registration window for “Viewnetcam.com” in a newly opened window. Follow the on-screen instructions to register with “Viewnetcam.com”. Refer to page 189 or the “Viewnetcam.com” website (http://www.viewnetcam.com/) for further information.
• Default: Off

[Recommended network setting for internet]
The recommended settings for connecting to the Internet are performed here. By clicking the [Set] button, a dialog displaying how the following settings will change is displayed. Click the [OK] button after checking the settings to change the settings to the displayed values.
– [Image] tab on the “Image/Audio” page
  [JPEG(1)]
  [Image capture size]: VGA/640x360
  [JPEG(2)]/[JPEG(3)]
  [Image capture size]: QVGA/320x180
  [Stream(1)]/[Stream(2)]/[Stream(3)]/[Stream(4)]
  [Internet mode (over HTTP)]: On
  [Transmission priority]: Best effort
  [Max bit rate (per client)]: 1024 kbps
  [Stream(1)]
  [Image capture size]: 1280x960/1280x720
  [Stream(2)]
  [Image capture size]: VGA/640x360
  [Stream(3)]/[Stream(4)]
  [Image capture size]: QVGA/320x180
– [Network] tab on the “Network” page
  [Common]
  [Max RTP packet size]: Limited(1280byte)
  [HTTP max segment size(MSS)]: Limited(1280byte)

2.3.2 Configure an event action [Event action]
Click the [Event action] tab in the “Easy Setup” page. (→page 38, page 39)
The current settings are displayed here.

![Current settings table]

You can set event actions for SD schedule recording/FTP periodic image transmission/alarm detection. Once the settings are completed in each setup menu, click the [Next] button to proceed. The setup flow is as follows.

**Note**
- If you click the [Next] button, the settings in the screen will be saved.
# Flow of event action setup

<table>
<thead>
<tr>
<th>Event function type:</th>
<th>Alarm (→page 43)</th>
<th>Schedule (→page 52)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>VMD</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SD memory recording: H.265/H.264 (→page 52)</td>
<td>FTP periodic image transmission (→page 54)</td>
</tr>
<tr>
<td>Event detailed setup:</td>
<td>Settings of image transfer conditions</td>
<td>Settings of recording conditions</td>
</tr>
<tr>
<td></td>
<td>Settings of recording conditions</td>
<td>Settings of image transfer method</td>
</tr>
<tr>
<td>FTP settings</td>
<td>E-mail settings</td>
<td>Schedule settings</td>
</tr>
<tr>
<td></td>
<td>Completed</td>
<td>Completed</td>
</tr>
</tbody>
</table>

## 2.3.2.1 Configure the schedule/alarm (event function type setup menu)

Here, select the function type of the event.

![Event Action Setup Menu](image-url)
[Trigger]
- **Alarm**: Select when setting the alarm detection settings.
- **Schedule**: Select during “SD memory recording” or “FTP periodic image transmission”.
- **Default**: Alarm

[SD memory card format]
To format the SD memory card, click the [Execute] button. Once you click the [Execute] button, the “Format” confirmation screen will be displayed. If you click the [OK] button, the formatting will start. Once the “Format” completion screen is displayed, press the button.

**IMPORTANT**
- All data saved on the SD memory card will be deleted when the SD memory card is formatted.
- Do not turn off the power of the camera during formatting.

[Next] button
If you select “Alarm”, and click the [Next] button, the alarm setup menu will be displayed. (*page 46) If you select “Schedule”, and click the [Next] button, the schedule function type setup menu will be displayed. (*page 52)

2.3.2.2 Alarm: Configure the VMD and audio detection (alarm setup menu)
The settings relating to actions when an alarm is detected can be configured in this section.

![Alarm setup menu](image)

**Alarm**

[VMD alarm]
- **On**: If the VMD area is not configured, the entire region is configured. To configure the VMD area, use the [VMD area] tab on the “Alarm” page. (*page 128) To set the period for when VMD will be used, set the schedule for VMD permission. (*page 193) If the period is not set, VMD will be continuously active.
- **Off**: Disables all VMD states.
- **Default**: Off

[Audio detection alarm]
- **On**: If audio detection is not configured, set audio detection to “On”. To set the sensitivity of audio detection, set using the [Audio detection] tab on the “Alarm” page. (*page 130) To set the period for when audio detection will be used, set the schedule for audio detection permission. (*page 193) If the period is not set, audio detection will be continuously active.
- **Off**: Disables audio detection.
2.3.2.3 Alarm: Configure the alarm function type (Alarm function type setup menu)

Select the alarm function type as “FTP Transfer” or “SD memory recording”.

**[Trigger]**
- **FTP Transfer**: When an alarm occurs, performs FTP transfer of the JPEG image.
- **SD memory recording**: When an alarm occurs, records the image to the SD memory card.

**Note**
- “FTP Transfer” for when an alarm occurs and “FTP periodic image transmission” can both be performed simultaneously.
- If both “FTP Transfer” for when an alarm occurs and “FTP periodic image transmission” are set, “FTP Transfer” will be given priority when an alarm occurs.

**[Recording format]**
When “SD memory recording” is selected for “Trigger”, “JPEG(1)”, “JPEG(2)”, “JPEG(3)”, “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” can be selected for the stream encoding format for the recorded image.

---

- **Default**: Off

**[Alarm deactivation time]**
Set the duration for which detection is not to be performed after an alarm has been detected. For example, by using this function you can prevent mail from being sent too often when the E-mail notifications are configured to be sent to cellular phones when an alarm is detected.

5 – 600 seconds
- **Default**: 5s

**Note**
- The duration of the alarm deactivation time can be specified for each type of alarm. For example, during the time when detections for VMD alarm are not made, detections for command alarms can be made.

**[Next] button**
If you click the [Next] button, the alarm function type setup menu will be displayed. (→ page 47)

**Note**
- If you click the [Next] button, the setting items in the screen are saved.

**[Back] button**
If you click the [Back] button, the event function type setup menu will be displayed. (→ page 45)
2.3.2.4 Alarm: Configure the details for image transfer or recording conditions

1. Set FTP transfer (FTP transfer setup menu)

FTP transfer when an alarm is detected is set in this section.

Refer to page 157 for information about how to set the above screen. For information about “Image compression rate upon alarm detection” and “Image quality upon alarm detection”, refer to “2.7.2.1 Configure settings relating to image quality on alarm action”.

[Next] button
If you click the [Next] button, the mail setup menu will be displayed. (→page 50)
Note
- If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the alarm function type setup menu will be displayed. (→page 47)

② Configure SD memory recording (JPEG) (JPEG recording setup menu)
The SD memory recording (JPEG) when an alarm is detected is configure in this section.

Refer to page 71 of 2.4.2 Configure the settings relating to the SD memory card [SD memory card] for information about how to set the above screen.

[Next] button
If you click the [Next] button, the mail setup menu will be displayed. (→page 50)

[Back] button
If you click the [Back] button, the alarm function type setup menu will be displayed. (→page 47)

③ Configure SD memory recording (H.265 or H.264) (video recording setup menu)
The SD memory recording (H.265 or H.264) when an alarm is detected is configured in this section.

[Audio recording]
Select On/Off to determine whether or not to record audio data.
- On: Saves audio data to videos (MP4 format).
- Off: Does not save audio data to videos (MP4 format).

[Frame rate]
Select a frame rate for the H.265 (or H.264) to be recorded.
Note
• Refer to [Frame rate*] in “2.3.2.8 Schedule: Configure FTP periodic image transmission (FTP periodic image transmission setup menu)” for information about available frame rates and the bit rates that are set according to the frame rate.

[Pre alarm (recording) duration]
Determine whether or not to perform the pre alarm recording. Set the duration to save image data on the SD memory card.
Off/ 1s/ 2s/ 3s/ 4s/ 5s/ 8s/ 10s/ 15s/ 20s/ 25s/ 30s/ 40s/ 50s/ 60s/ 90s/ 120s
• Default: Off

Note
• The values change depending on the bit rate and the image capture size of the recorded stream. As the selected bit rate increases, the available maximum value for the pre alarm duration decreases.

[Post alarm (recording) duration]
Set the duration to save image data on the SD memory card after an alarm occurrence.
10s/ 20s/ 30s/ 40s/ 50s/ 60s/ 120s/ 180s/ 240s/ 300s
• Default: 30s
* The actual recording time may sometimes be longer than the duration selected for this setting.

[Next] button
If you click the [Next] button, the mail setup menu will be displayed. (→page 50)

Note
• If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the alarm function type setup menu will be displayed. (→page 47)

2.3.2.5 Alarm: configure the mail notifications and mail server
The settings relating to e-mail can be configured in this section.
To configure e-mail related settings:

Refer to page 153 for information about how to configure the above screen.

**[Set] button**
If you click the [Set] button, setup will be completed.

**[Back] button**
If you click the [Back] button, either the FTP transfer setup menu (→page 48), the JPEG recording setup menu (→page 49), or the video recording setup menu (→page 49) will be displayed.
2.3.2.6 Schedule: Configure SD recording or FTP periodic image transmission (schedule function type setup menu)

Here, the schedule type is selected as “SD memory recording” or “FTP periodic image transmission”.

[Trigger]
- **SD memory recording**: Records the H.265 (or H.264) image in the SD memory card at the scheduled time.
- **FTP periodic image transmission**: Transmits the JPEG image to the FTP server at the scheduled time.

[Recording format]
When “SD memory recording” is selected for “Trigger”, “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)" can be selected for the recorded image.

[Next] button
If you select “SD memory recording” and click the [Next] button, the video recording setup menu will be displayed. (→page 52)
If you select “FTP periodic image transmission” and click the [Next] button, the FTP periodic image transmission setup menu will be displayed. (→page 54)

**Note**
- If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the event function type setup menu will be displayed. (→page 45)

**Note**
- “FTP periodic image transmission” and “FTP img. trans.” for when an alarm occurs can both be performed simultaneously.
- If you select “SD memory recording”, the “FTP periodic image transmission” setting will be canceled.

2.3.2.7 Schedule: Set SD memory recording (video recording setup menu)

Here, SD memory recording (H.265 or H.264) is configured according to the schedule.
[Audio recording]
Determine whether or not to perform audio recording.
- **On**: Saves audio data to videos (MP4 format).
- **Off**: Does not save audio data to videos (MP4 format).
- **Default**: Off

**IMPORTANT**
- When the [Overwrite] setting is changed from “Off” to “On”, if the remaining capacity of the SD memory card is low, old images may be deleted in order to prepare to save new images.

[Frame rate*]
Select a frame rate for the H.265 or H.264 to be recorded from the following.
1fps/ 3fps/ 5fps*/ 7.5fps*/ 10fps*/ 12fps*/ 15fps*/ 20fps*/ 30fps*
- **Default**: 30fps*

**Note**
- If you click the [Next] button, the “Transmission priority” will be set to “Frame rate”. (→page 89)

The bit rate is set as follows depending on the selected image capture size and frame rate.
Unit: kbps

<table>
<thead>
<tr>
<th>Image capture size</th>
<th>Frame rate (fps)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
</tr>
<tr>
<td>QVGA</td>
<td>128</td>
</tr>
<tr>
<td>400x300</td>
<td>128</td>
</tr>
<tr>
<td>VGA</td>
<td>256</td>
</tr>
<tr>
<td>800x600</td>
<td>384</td>
</tr>
<tr>
<td>1280x960</td>
<td>512</td>
</tr>
<tr>
<td>320x180</td>
<td>128</td>
</tr>
<tr>
<td>640x360</td>
<td>256</td>
</tr>
<tr>
<td>1280x720</td>
<td>384</td>
</tr>
<tr>
<td>1920x1080</td>
<td>768</td>
</tr>
<tr>
<td>2048x1536</td>
<td>1024</td>
</tr>
</tbody>
</table>

[Overwrite]
Determine whether or not to overwrite images when the remaining capacity of the SD memory card becomes insufficient.
- **On**: Overwrites when the remaining capacity of the SD memory card becomes insufficient. (The oldest image is the first to be overwritten.)
- **Off**: Stops saving images on the SD memory card when the SD memory card becomes full.
- **Default**: Off
IMPORTANT

• When the [Overwrite] setting is changed from “Off” to “On”, if the remaining capacity of the SD memory card is low, old images may be deleted in order to prepare to save new images.

[Next] button
If you click the [Next] button, the setup menu to set the schedule for recording into the SD memory card will be displayed. (→page 54)

[Back] button
If you click the [Back] button, the schedule function type setup menu will be displayed. (→page 52)

• To configure the schedule settings:

Refer to page 193 for information about how to set the above screen.

[Set] button
If you click the [Set] button, setup will be completed.

[Back] button
If you click the [Back] button, the (video recording setup menu will be displayed. (→page 52)

Note

• Video recording is not performed if “SD memory recording” is not selected in the “Schedule mode”.

2.3.2.8 Schedule: Configure FTP periodic image transmission (FTP periodic image transmission setup menu)

The FTP periodic image transmission is configured in this section.
To configure FTP periodic image transmission settings:

Refer to page 157 for information about how to configure the above screen.

[Next] button
If you click the [Next] button, the setup menu to set the FTP periodic image transmission schedule will be displayed. (→page 56)

Note
• If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the schedule function type setup menu will be displayed. (→page 52)
• To configure FTP periodic image transmission schedule settings:

Refer to page 193 for information about how to set the above screen.

**[Set] button**
If you click the [Set] button, setup will be completed.

**[Back] button**
If you click the [Back] button, the FTP periodic image transmission setup menu will be displayed. (→page 54)
Note
- FTP periodic image transmission will not be performed when “FTP periodic image transmission” is not selected in “Schedule mode.”
2.4 Configure the basic settings of the camera [Basic]

The basic settings such as camera title, time and date, SD memory card and the logs can be configured on the “Basic” page. The “Basic” page has the [Basic] tab, the [SD memory card] tab, and the [Log] tab.

2.4.1 Configure the basic settings [Basic]

Click the [Basic] tab on the “Basic” page. (→page 38, page 39)
The settings such as the camera title, time and date, etc. can be configured on this page.
**[Menu language]**
Select the language to initially display when the camera is accessed from the following.
Auto/English/Japanese/Italian/French/German/Spanish/Chinese/Russian/Portuguese

- **Auto:** The language used by the browser is automatically selected. If the language used by the browser is not supported by the camera, English is selected.
- **Default:** Auto

The language displayed on the "Live" page can also be changed. (→page 11)

**Note**
- When Japanese is selected, diagnostic e-mails and the screens in cellular phones are displayed in Japanese.
- When Chinese is selected, the screens in cellular phones are displayed in Chinese.
- When any other language is selected, diagnostic e-mails and the screens in cellular phones are displayed in English.

**[Camera title]**
Enter the title of the camera. Click the [Set] button after entering the title of the camera. The entered title will be displayed in the “Camera title” field.

- **Available number of characters:** 0 - 20 characters
- **Unavailable characters:** " &
- **Default:** The model No. is displayed.

**[Date/time]**
Enter the current time and date. When “12h” is selected for "Time display format", “AM” or “PM” can be selected.

- **Available range:** Jan/01/2013 00:00:00 - Dec/31/2035 23:59:59

**IMPORTANT**
- Use an NTP server when the more accurate time & date setting is required for the system operation. (→page 161)

**[Date/time display]**
Select On/Off to determine whether or not to display the date and time on an image. To hide the date and time, select “Off”.

- **Default:** On

**[Time display format]**
Select the time display format from “24h” and “12h”. Enter the current hour reflecting this setting when entering the current time and date for “Date/time”.

- **Default:** 24h

**[Date/time display format]**
Select a date/time display format. When “2018/04/01 13:10:00” is set for "Date/time" after selecting “24h” for "Time display format", time & date will be respectively displayed as follows.

- **DD/MM/YYYY:** 01/04/2018 13:10:00
- **MM/DD/YYYY:** 04/01/2018 13:10:00
- **DD/Mmm/YYYY:** 01/Apr/2018 13:10:00
- **YYYY/MM/DD:** 2018/04/01 13:10:00
- **Mmm/DD/YYYY:** Apr/01/2018 13:10:00
- **Default:** Mmm/DD/YYYY

**[Date/time position]**
Select the position to display the time and date in an image.

- **Upper left:** The information will be displayed at the upper left corner of the screen.
2 Settings

- **Lower left**: The information will be displayed at the lower left corner of the screen.
- **Upper center**: The information will be displayed at the upper center of the screen.
- **Lower center**: The information will be displayed at the lower center of the screen.
- **Upper right**: The information will be displayed at the upper right corner of the screen.
- **Lower right**: The information will be displayed at the lower right corner of the screen.
- **Default**: Upper left

**Note**
- Only upper left or lower left can be configured for the OSD display position when “90 °” or “270 °” is selected for “Image rotation”.

**[NTP]**
When “NTP >>” is clicked, the [Advanced] tab of the “Network” page will be displayed. (→page 161)

**[Time zone]**
Select a time zone corresponding to the location where the camera is in use.
- **Default**: (GMT +09:00) Osaka, Sapporo, Tokyo

**[Summer time (daylight saving)]**
Select “In”, “Out” or “Auto” to determine whether or not to apply daylight saving time. Configure this setting if the summer time (daylight saving time) is applied in the location where the camera is in use.
- **In**: Applies summer time. An asterisk (*) will be displayed on the left side of the displayed time and date.
- **Out**: Does not apply summer time.
- **Auto**: Applies summer time in accordance with the settings for “Start time & date” and “End time & date” (month, week, day of the week, time).
- **Default**: Out

**[Start time & date] [End time & date]**
When “Auto” is selected for “Summer time (daylight saving)”, select the time & date for the start time and the end time (month, week, day of the week, time).

**[Camera title on screen display]**
Select “On” or “Off” to determine whether or not to display the camera title on the screen. When “On” is selected, the character string entered for “Camera title on screen” will be displayed at the position selected for “Camera title position”.
- **Default**: Off

**[Camera title on screen]**
Enter a character string to be displayed on the image.
- **Available number of characters**: 0 - 20 characters
- **Available characters**: 0-9, A-Z, a-z and the following marks.
  ! * # $ % & ' ( ) * + , - . / : ; = ?
- **Default**: None (blank)

**[Camera title position]**
Select the position where the date, time, and character string will be displayed on the image.
- **Upper left**: The above information will be displayed at the upper left corner of the main area on the “Live” page.
- **Lower left**: The above information will be displayed at the lower left corner of the main area on the “Live” page.
- **Upper center**: The above information will be displayed at the upper center of the image.
- **Lower center**: The above information will be displayed at the lower center of the image.
• **Upper right**: The above information will be displayed at the upper right corner of the main area on the “Live” page.
• **Lower right**: The above information will be displayed at the lower right corner of the main area on the “Live” page.
• **Default**: Upper left

**Note**
- Only upper left or lower left can be configured for the OSD display position when “90 °” or “270 °” is selected for “Image rotation”.

[OSD] - [Character size]
Select the character size of the date and time as well as text displayed in the image.
- **100%**: Displays in the standard size.
- **150%**: Displays in 150% of the standard size.
- **200%**: Displays in 200% of the standard size.
- **Default**: 100%

**IMPORTANT**
- If the settings for [Date/time position] and [Camera title position] are different, the frame rate may be lower than the specified value.
- If the settings for [Date/time position] and [Camera title position] are different, characters may be displayed incorrectly or overlapped depending on the [Character size] setting and the number of characters used. After completing the settings, confirm the result on the “Live” page.
- If “150%” or “200%” is selected for [Character size], the frame rate may be lower than the specified value.
- Depending on the setting and the numbers of characters used for [Character size], and the setting and image capture size of images, characters displayed on the screen may be cut off. After completing the settings, confirm the result on the “Live” page.

[Brightness status display]
Select “On” or “Off” to determine whether or not to display the status of brightness on images displayed on the “Live” page when adjusting brightness.
- **Default**: On

[Image rotation]
Set whether or not to rotate the image (JPEG, H.265, or H.264).
- **0 °(Off)**: Does not rotate the image.
- **90 °**: Rotates the image by 90 degrees.
- **180 °(Upside-down)**: Turns the image upside down.
- **270 °**: Rotates the image by 270 degrees.
- **Default**: 0 °(Off)

**IMPORTANT**
- The position shifts if the image rotation setting is changed when the following area settings are configured. Therefore, configure the settings for each area after configuring the image rotation.
  - Privacy zone (→page 108)
  - VMD area (→page 126)
  - VIQS area (→page 110)
  - Mask area (→page 104)
- If “90 °” or “270 °” is selected for “Image rotation”, depending on the “Character size” setting and the number of characters used, characters displayed on the screen may be cut off.
When “90 °” or “270 °” is selected for “Image rotation”, the position selectable with “Date/time position” and “Camera title position” is limited to “Upper left” or “Lower left”.

**Note**
- When “3 mega pixel [4:3](30fps mode)” or “1.3 mega pixel [4:3](30fps mode)” is selected for “Image capture mode”, “90 °” and “270 °” are not available.
- When “90 °” or “270 °” is selected for “Image rotation”, “Mirror” will be fixed to “Off”.

**[Mirror]**
Select “On” or “Off” to determine whether or not to turn the image over horizontally.
- **Default:** Off

**Note**
- When “90 °” or “270 °” is selected for “Image rotation”, “Mirror” will be fixed to “Off”.

**[Indicator]**
Determine whether or not to use the following indicators. Select “On” to use the following indicators to check the operational status by lighting them.
- Link indicator (LINK)
- Access indicator (ACT)
- SD memory card error indicator (SD ERROR)
- **Default:** On

**Note**
- **Link indicator (LINK) (orange):** This indicator will light when communication with the connected device is available.
- **Access indicator (ACT) (green):** This indicator will blink when accessing a network.
- **SD memory card error indicator (SD ERROR) (red):** Lights when data cannot be saved to the SD memory card.

**[Status update mode]**
Select an interval of the camera status notification from the following.
When the status of the camera changes, the alarm occurrence indication button or the “SD recording status indicator” will be displayed in the “Live” page to notify of the camera status.
- Polling(30s): Updates the status each 30 seconds and provide notification of the camera status.
- **Default:** Real time

**Note**
- Depending on the network environment, notification may not be provided in real time.
- When multiple cameras are using the same “Status reception port”, even if “Real time” is selected for “Status update mode”, status notification is not provided in real time. In this case, change the “Status reception port” settings.

**[Status reception port]**
When selecting “Real time” for “Status update mode”, designate a port number to which the status change notification is to be sent.
- **Available port number:** 1 - 65535
- **Default:** 31004

The following port numbers are unavailable since they are already in use.
20, 21, 23, 25, 42, 53, 67, 68, 69, 80, 110, 123, 161, 162, 443, 995, 10669, 10670
[Viewer software (nwcv4Ssetup.exe)] - [Automatic installation]
Determine whether or not to install the viewer software from this camera.
• **On**: Installs the viewer software from the camera automatically.
• **Off**: The viewer software cannot be installed from the camera.
• **Default**: On

**IMPORTANT**
• For PCs that do not have the viewer software “Network Camera View 4S” installed, JPEG images are displayed. You cannot display images using H.265 (or H.264) or receive audio from the camera. In order to display H.265 (or H.264) images or receive audio from the camera, you must click “Viewer Software” on the “Live” page (→page 11) and then install the viewer software.
• The number of the viewer software installations can be checked on the [Upgrade] tab of the “Maintenance” page.

[Viewer software (nwcv4Ssetup.exe)] - [Drawing method]
Perform image display settings when displaying camera images with the viewer software.
• **GDI**: The drawing method generally used in Windows.
• **Direct2D**: Can reduce choppy drawing of images.
• **Default**: GDI

**IMPORTANT**
• Use “Direct2D” with a computer that has the latest graphic driver version installed to it.
• When using “Direct2D”, set “Smoother live video display on the browser (buffering)” to “On”. If “Off” is selected for “H.264 Smoother live video display on the browser (buffering)”, “Direct2D” may not be very effective.

**Note**
• If your computer’s operating system is Windows 7 and the Aero function is disabled, “Direct2D” may not be very effective.
• When “Direct2D” is selected for “Drawing method”, video may not be displayed or the displayed image may be seen as it is partially corrupted depending on the PC in use.
• Refer to the Panasonic support website for information of PCs for which “Direct2D” is selectable. Panasonic website (https://security.panasonic.com/support/info/ <Control No.: C0313>)

[Viewer software (nwcv4Ssetup.exe)] - [Decoding Options]
Select the decoding method for H.265/H.264 images on the “Live” page.
• **Software**: Decoding is performed by software.
• **Hardware**: Uses the Hardware Acceleration (QSV/DXVA) function that performs fast decoding.
• **Default**: Software

**IMPORTANT**
• “Hardware” may not be able to be used depending on the computer used.
  One of the following messages is displayed when the [Confirm] button is clicked.
  – The hardware decode is available for both H.265 and H.264 on your PC.
    → Depending on your PC environment, images may not be able to be outputted. In this case, select “Software” for “Decoding Options”.
  – The hardware decode is available for H.264 on your PC, but unavailable for H.265 on your PC.
    → Depending on your PC environment, images may not be able to be outputted. In this case, select “Software” for “Decoding Options”.
  – The hardware decode is not available on your PC.
    → Select “Software” for “Decoding Options”.
Note

- When “Hardware” is selected for “Decoding Options”, video may not be displayed or the displayed image may be seen as it is partially corrupted depending on the PC in use.
- Refer to the Panasonic support website below for information of PCs for which “Hardware” is selectable.
  Panasonic website (https://security.panasonic.com/support/info/ <Control No.: C0313>)

[Viewer software (nwcv4Ssetup.exe)] - [Smother live video display on the browser (buffering)]
Perform settings to display camera images on the viewer software.
- **On**: Images are temporarily stored on the computer and are displayed smoother.
- **Off**: Images are displayed in real-time and are not stored on the computer.
- **Default**: On

[Viewer software (nwcv4Ssetup.exe)] - [Frame Skip Options (When PC is Heavy Processing Load)]
Perform settings to display camera images on the viewer software.
- **Auto**: If there is a delay in displaying images from the camera, the delay can be resolved by automatically skipping frames.
- **Manual**: If there is a delay in displaying images from the camera, frames are not skipped automatically.
- **Default**: Auto

Note

- When “Manual” is selected, “Off”, “1 Frame Skip”, “2 Frames Skip”, “4 Frames Skip”, “6 Frames Skip”, or “8 Frames Skip” can be selected for frame skip by right-clicking on the “Live” page. The value selected here will revert to “Off” when the browser is closed.

[Viewer software (nwcv4Ssetup.exe)] - [Contrast enhancement(RGB:0 to 255)]
Select “On” or “Off” to determine whether or not to enhance the contrast of H.265 images or H.264 images on the “Live” page.
If “On” is selected, the range of RGB signal on display is extended from 16-235 to 0-255.
When there is a bright part in an image, the intensity may be overexposed. Select a setting suitable to your usage environment.
- **Default**: Off

Note

- This setting is only available when viewing images on the “Live” page with Internet Explorer.
- Even if this setting is changed, transmitted image data and data saved on the SD memory card are not changed.
2.4.2 Configure the settings relating to the SD memory card [SD memory card]

Click the [SD memory card] tab on the “Basic” page. (→page 38, page 39)
The settings relating to the SD memory card can be configured on this page.

Operating mode

[SD memory card]
Select “Use” or “Not use” to determine whether or not to use the SD memory card.

- Default: Use

Note
- When “2 mega pixel [16:9](60fps mode)” or “1.3 mega pixel [16:9](60fps mode)” is selected for “Image capture mode”, functions related to SD memory cards are not available. “Not use” will be selected for “SD memory card”.

[Audio recording]
Select whether or not to save audio data when saving video data in MP4 format.
**2 Settings**

- **Off:** Does not save audio data to videos (MP4 format).
- **On:** Saves audio data to videos (MP4 format).
- **Default:** Off

**Note**

- When “Audio recording” is used, a stream setting must be selected for “Recording stream 1”, and “Off” must be selected for “Recording stream 2”.

**[Remaining capacity notification]**

When the E-mail notification function or the Panasonic alarm protocol function is used to provide notification of the remaining capacity of the SD memory card, select a level to be notified at from the following.

- **50%/ 20%/ 10%/ 5%/ 2%**
- **Default:** 50%

**Note**

- Notification will be provided each time the remaining capacity goes below each of the specified values. For example, notification will be provided each time the remaining capacity reaches 50%, 20%, 10%, 5% and 2% when “50%” is selected. Notification may not always be made at the very moment when the remaining capacity of the SD memory card has reached each value.

**[Overwrite]**

Determine whether or not to overwrite when the remaining capacity of the SD memory card becomes insufficient.

- **On:** Overwrites when the remaining capacity of the SD memory card becomes insufficient. (The oldest image is the first to be overwritten.)
- **Off:** Stops saving images on the SD memory card when the SD memory card becomes full.
- **Default:** Off

**IMPORTANT**

- Select “Not use” when operating without an SD memory card.
- Before removing the SD memory card from the camera, it is necessary to select “Not use” first. The recorded data may be corrupted if the SD memory card is removed when “Use” is selected.
- When an SD memory card is inserted when “Use” is selected, data will be saved in accordance with the setting of “Save trigger”.
- After inserting the SD memory card, it is necessary to select “Use” to use the SD memory card.
- When the image refresh interval is short, notification/recording timing or interval may become incorrect. Notification/recording may also not be performed correctly as configured when multiple users are receiving images. In this case, set the refresh interval longer.
- There are limited times to overwrite on an SD memory card. When having a high frequency of overwriting, the lifetime of the SD memory card may become shorter.
- A lifetime of an SD memory card should be influenced by the number of the image files stored and log savings on the SD memory card. Selecting “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” for “Recording format” can reduce the number of files that can be stored on the SD memory card.
- If the data writing speed goes down after data is repeatedly written on an SD memory card, we recommend replacing the SD memory card.
- When the setting is changed from “Off” to “On”, if the remaining capacity of the SD memory card is low, old images may be deleted in order to prepare to save new images.

**SD memory card security**

**[Additional info for detecting alteration]**

Select whether or not to add information to enable detection when the data in the SD memory card is altered.
Altering detection supports video data (MP4 format) only and can be checked using exclusive software. For further information about exclusive software for alteration detection and how to use it, refer to our website below.
https://security.panasonic.com/support/info/ <Control No.: C0304>
Click the [Setup>>] button to display the setup menu that can configure the settings relating to additional info for detecting alteration. The setup menu will be displayed in a newly opened window. (→page 73)

[SD memory card password lock]
Configure a password for the SD memory card. When configuring a password, devices other than the camera will be unable to write to or read the SD memory card. If the SD memory card is stolen or lost, the risk of recorded data being leaked can be reduced.

[Set]
When an SD memory card with no configured password is inserted, a password can be configured using the [Set] button.

[Password]/[Retype password]
Enter the password.
Available number of characters: 4 - 16 characters
Unavailable characters: " &
Default: None (blank)

[Remove]
When an SD memory card with a configured password is inserted, the password can be removed using the [Remove] button.

[Password]
Enter the password.
Available number of characters: 4 - 16 characters
Unavailable characters: " &
[Change]
When an SD memory card with a configured password is inserted, the password can be changed using the [Change] button.

[Old password]/[New password]/[Retype new password]
Enter the password.
Available number of characters: 4 - 16 characters
Unavailable characters: " &

[Status]
Display the configuration status of the password lock.
• Lock: A password is configured on the SD memory card, and the lock function is enabled.
• Unlock: The lock function is disabled.
Also display the password configuration status of SD memory card respectively.
• Password is set.: The password is configured correctly.
• Error(Unsupported SD memory card): A card that does not support password lock is inserted. Check that an SDHC memory card or SDXC memory card is inserted.
• Error(Password mismatch): The SD memory card cannot be used because the password configured for the SD memory card and the password configured for the camera do not match. Check that the passwords are correct.
• Error(Undefined error): Displayed when the SD memory card is formatting or when an error occurs in the SD memory card. Check the SD memory card.

Note
• The password lock function supports only SDHC memory cards and SDXC memory cards.
• If you will use the SD memory card on a device other than the camera with password lock configured, remove the password using the password lock remove button before removing the SD memory card. The password cannot be removed on devices (such as PCs) other than the camera.
• When the “Status” of “SD memory card password lock” is “Lock”, if an SD memory card with no configured password is inserted, the password is automatically configured to the SD memory card.

IMPORTANT
• If you forget the configured password, the password cannot be removed. The SD memory card with the configured password will become unusable, so manage passwords with great care.
• If you forget the configured password and you want to replace the SD memory card with a new one, perform one of the following step to set the “Status” of “SD memory card password lock” to “Unlock” before replacing the SD memory card.
  – Use the password lock remove button to enter a password and then press the [Set] button. In this case, even if you enter an incorrect password, the “Status” will change to “Unlock”.
  – Initialize settings from the “Maintenance” page.
Recording stream 1/Recording stream 2

[Recording format]
Select the type of image data to be recorded on the SD memory card. “Off” can only be selected for the "Recording format" of "Recording stream 2". "JPEG(1)", "JPEG(2)", and "JPEG(3)" can only be selected for the "Recording format" of "Recording stream 1".

- Off: Does not record data.
- JPEG(1): Records still image data (JPEG(1)). The data is recorded in accordance with the settings of “JPEG(1)” on the [Image] tab of the “Image/Audio” page.
- JPEG(2): Records still image data (JPEG(2)). The data is recorded in accordance with the settings of “JPEG(2)” on the [Image] tab of the “Image/Audio” page.
- JPEG(3): Records still image data (JPEG(3)). The data is recorded in accordance with the settings of “JPEG(3)” on the [Image] tab of the “Image/Audio” page.
- Stream(1): Records video data (Stream(1)) in the MP4 video encoding format. The data is recorded in accordance with the settings of “Stream(1)” on the [Image] tab of the “Image/Audio” page.
- Stream(2): Records video data (Stream(2)) in the MP4 video encoding format. The data is recorded in accordance with the settings of “Stream(2)” on the [Image] tab of the “Image/Audio” page.
- Stream(3): Records video data (Stream(3)) in the MP4 video encoding format. The data is recorded in accordance with the settings of “Stream(3)” on the [Image] tab of the “Image/Audio” page.
- Stream(4): Records video data (Stream(4)) in the MP4 video encoding format. The data is recorded in accordance with the settings of “Stream(4)” on the [Image] tab of the “Image/Audio” page.

- Default:
  - Recording stream 1: JPEG(2)
  - Recording stream 2: Off

IMPORTANT
- If an SD memory card with an SD Speed Class other than 10 is used, set the bit rate of a stream selected in "Recording format" to 6 Mbps.
- If an SD memory card with an SD Speed Class 10 is used, set the bit rate of a stream selected in "Recording format" to 12 Mbps.
- When recording streams, the available range of bit rates differs depending on the image capture mode of the stream. Check “Max bit rate (per client)” on the [Image] tab. (→ page 87)
- For SD memory cards with an SD Speed Class 10, use a card that supports UHS-I.
- Recording stream 2 is not available when a JPEG setting is selected for Recording stream 1.

Note
- When “Stream(1)” is selected, the settings for “Stream(1)” on the [Image] tab of the “Image/Audio” page will be changed to the settings for “Stream(1) & recording”.
- When “Stream(2)” is selected, the settings for “Stream(2)” on the [Image] tab of the “Image/Audio” page will be changed to the settings for “Stream(2) & recording”.
- When “Stream(3)” is selected, the settings for “Stream(3)” on the [Image] tab of the “Image/Audio” page will be changed to the settings for “Stream(3) & recording”.
- When “Stream(4)” is selected, the settings for “Stream(4)” on the [Image] tab of the “Image/Audio” page will be changed to the settings for “Stream(4) & recording”.
- When using the SD memory recording function of a Panasonic network disk recorder, select “JPEG(1)” for “Recording format” of “Recording stream 1”.
- When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, the settings of the following functions may be corrected.
  - When “VBR” is selected for “Transmission priority”, “Frame rate” is set.
  - When “2s”, “3s”, “4s”, or “5s” is selected for “Refresh interval”, “1s” is set.
- When “On” is selected for “Additional info for detecting alteration”, “Recording format” cannot be changed to “JPEG(1)”, “JPEG(2)”, or “JPEG(3)”. 
When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, the name of the saved file will be given automatically.

When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, the number of users that can access the camera may be reduced.

When “On” is selected for “Audio recording”, the maximum value of the available bit rate for “Stream” will be limited.

When “On” is selected for “Additional info for detecting alteration”, the maximum value of the available bit rate for “Stream” will be limited.

**[Save trigger]**
Select a trigger to save images on the SD memory card from the following.

- **FTP periodic image transmission error**: Saves images when images have failed to transmit to the FTP server by the FTP periodic image transmission function. Available only for the “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” images.
- **Alarm input**: Saves images at an alarm occurrence.
- **Manual**: Saves images manually.
- **Schedule**: Saves images in accordance with the settings for “Schedule” (→page 193). Available only for the “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” images.
- **Default**:
  - **Recording stream 1**: FTP periodic image transmission error
  - **Recording stream 2**: Alarm input

If you have selected “Alarm input” in the [Save trigger], you can select the alarm type from the following:

- **VMD**: Save the image when motion detection occurs.
- **Audio detection**: Save the image when audio detection occurs.
- **Command alarm**: Save the image when a command alarm is entered.

**Note**

- When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, “FTP periodic image transmission error” is unavailable.
- To enable alarms to occur, alarm settings must be configured in advance on the [Alarm] tab.
- When “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” is selected for “Recording format”, “Schedule” is unavailable.

**JPEG recording (Manual)**

This setting is only available when “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” is selected for “Recording format”, and “Manual” is selected for “Save trigger”.

**[File name]**
Enter the file name used for the image to be saved on the SD memory card. The file name will be as follows.

- **File name**: [“Entered file name” + “Time and date (year/month/day/hour/minute/second)“] + “Serial number”
- **Available number of characters**: 1 - 8 characters
- **Unavailable characters**: “ ” & * / ; ; < > ? \ |
[Image saving interval]
When "Manual" is selected for "Save trigger", select an interval (frame rate) of saving images on the SD memory card from the following.
0.1fps/0.2fps/0.33fps/0.5fps/1fps
• Default: 1fps

JPEG recording (Alarm)

This setting is only available when "JPEG(1)", "JPEG(2)", or "JPEG(3)" is selected for "Recording format", and "Alarm input" is selected for "Save trigger".

[File name]
Enter the file name used for the image to be saved on the SD memory card. The file name will be as follows.
• File name: ["Entered file name" + "Time and date (year/ month/ day/ hour/ minute/ second)"] + "Serial number"
• Available number of characters: 1 - 8 characters
• Unavailable characters: " / : ; < > ? \ |

[Image saving interval/Number of images to be saved(Pre alarm)] - [Image saving interval]
When "Alarm input" is selected for "Save trigger", select a pre alarm interval (frame rate) of saving images on the SD memory card from the following.
0.1fps/0.2fps/0.33fps/0.5fps/1fps
• Default: 1fps

[Image saving interval/Number of images to be saved(Pre alarm)] - [Number of images to be saved]
Select a number of pre alarm images to be saved on the SD memory card from the following.
Off/1pic/2pics/3pics/4pics/5pics
• Default: Off

[Image saving interval/Number of images to be saved(Post alarm)] - [Image saving interval]
When "Alarm input" is selected for "Save trigger", select an interval (frame rate) of saving images on the SD memory card from the following.
0.1fps/0.2fps/0.33fps/0.5fps/1fps
• Default: 1fps

[Image saving interval/Number of images to be saved(Post alarm)] - [Number of images to be saved]
Select a number of alarm images to be saved on the SD memory card from the following.
10pics/ 20pics/ 30pics/ 50pics/ 100pics/ 200pics/ 300pics/ 500pics/ 1000pics/ 2000pics/ 3000pics
• Default: 100pics
Stream recording (Alarm)

This setting is only available when “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format” of the SD memory card, and “Alarm input” is selected for “Save trigger”.

[Pre alarm (recording) duration]
Determine whether or not to perform the pre alarm recording. Set the duration to save image data on the SD memory card.
Off/ 1s/ 2s/ 3s/ 4s/ 5s/ 8s/ 10s/ 15s/ 20s/ 25s/ 30s/ 40s/ 50s/ 60s/ 90s/ 120s
- Default: Off

Note
- The available values change depending on the bit rate and image capture size for “Stream” selected for recording. As the selected bit rate increases, the available maximum value for the pre alarm duration decreases.

[Post alarm (recording) duration]
Set the duration to save image data on the SD memory card after an alarm occurrence.
10s/ 20s/ 30s/ 40s/ 50s/ 60s/ 120s/ 180s/ 240s/ 300s
- Default: 30s
  * The actual recording time may sometimes be longer than the duration selected for this setting.

SD memory card information

[Remaining capacity]
Total capacity and remaining capacity of the SD memory card will be displayed. Depending on the status of the SD memory card, the size indications will differ as follows.

<table>
<thead>
<tr>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*******MB/*******MB</td>
<td>The SD memory card is unformatted.</td>
</tr>
<tr>
<td>*******MB/Million MB</td>
<td>The SD memory card password lock cannot be unlocked.</td>
</tr>
<tr>
<td>Million MB/Million MB</td>
<td>No SD memory card is inserted. Failed to obtain available capacity due to error, etc.</td>
</tr>
</tbody>
</table>

Note
- When “Off” is selected for “Overwrite” and the available size of the SD memory card is “0 MB”, images will not be saved on the SD memory card. When the notification function is on, a notification will be sent to the registered addresses and destinations of the Panasonic alarm protocol when the SD memory card becomes full. (page 122, page 132)

[Format]
To format the SD memory card, click the [Execute] button.
IMPORTANT

- Before formatting the SD memory card, it is necessary to select “Use” for “SD memory card” on the [SD memory card] tab of the “Basic” page (→page 65) and “Off” for “FTP periodic image transmission” on the [Advanced] tab of the “Network” page (→page 159).

- Use the SD memory card after formatting it using the [SD memory card] tab. If using the SD memory card that has not been formatted on the [SD memory card] tab, the following functions may not work correctly.
  - Save/obtain images that failed to transmit to the FTP server using the FTP periodic image transmission function
  - Save/obtain alarm images
  - Save/obtain images saved manually
  - Save/obtain images in accordance with the schedule settings
  - Save/obtain the alarm logs, the manual/schedule logs, the FTP error logs and the system logs
  - Save/obtain images recorded using the SD memory recording function of Panasonic network disk recorder
  - Play/download images on the SD memory card

- When an SD memory card is formatted while another user is in operation, the operation will be canceled.

- It is impossible to access the SD memory card during the process of formatting.

- All data saved on the SD memory card will be deleted when the SD memory card is formatted.

- Do not turn off the power of the camera during the process of formatting.

- After formatting the SD memory card, available size may be smaller than the total size since the default directory is automatically created in the SD memory card.

- Refer to our website (https://security.panasonic.com/support/info/ <Control No.:C0107>) for latest information about the compatible SD memory cards.

- When repeatedly recording images on an SD memory card using the auto overwrite function, make sure to use an SD memory card with high reliability and durability.

- Use the SD memory card that complies with UHS-1(Ultra High Speed-1) in the case of SD Speed Class10.

SD memory card images

[Access img.]

Images on the SD memory card can be obtained. Click the [Execute] button. Refer to page 80 for how to access images.

2.4.3 Configure the settings relating to alteration detection

[Alteration detection]

Selecting “Alteration detection” enables detection using exclusive software when the data on the SD memory card is altered.

Alteration detection supports video files (MP4 format) only.

Refer to page 75 for information on how to configure “Alteration detection”.

For further information about exclusive software for alteration detection and how to use it, refer to our website below.

https://security.panasonic.com/support/info/ <Control No.: C0304>

Note

- When “Alteration detection” is used, a stream must be selected for “Recording stream 1”, and “Off” must be selected for “Recording stream 2”.
[Select certificate]
Select the certificate to be used with alteration detection.

**Pre-installed**: Selects a pre-installed certificate.

**CA**: Selects a “CA Certificate”. Only displayed when the “CA Certificate” is installed.

**Default**: Pre-installed

[Additional info for detecting alteration]
Select whether or not to give information for alteration detection to video files (MP4 format) to be saved on the SD memory card.

**Note**
- When “JPEG(1)”, “JPEG(2)”, or JPEG(3) is selected for “Recording format” of “Recording stream 1”, “On” cannot be selected.

[Pre-installed certificate - Certificate download]
Click the [Execute] button and download the root certificate for the pre-installed certificate. When implementing alteration detection of video data (MP4 files) on the SD memory card using exclusive software, the downloaded certificate is used.

[CA Certificate - CRT key generate]
CRT key (encryption key) used for alteration detection is generated. To generate the CRT key, click the [Execute] button to display “CRT key generate” dialog box.

[CA Certificate - Generate Certificate Signing Request]
When using the CA certificate issued by CA as the CA certificate used for alteration detection, the CSR (Certificate Signing Request) will be generated.
To generate the CSR, click the [Execute] button to display the “CA Certificate - Generate Certificate Signing Request” dialog window.
[CA Certificate - CA Certificate install]
Installs the certificate (CA certificate) issued by CA and displays the information of the installed certificate (CA certificate).
To install the certificate (CA certificate), click the [Browse...] button to display the [Open] dialog box, and select the file of the certificate (CA certificate) issued by CA, and click the [Execute] button.
If the certificate (CA certificate) is already installed, the file name of the installed certificate will be displayed.

[CA Certificate - Information]
Displays the information of the certificate (CA certificate) issued by CA.
When the [Confirm] button is clicked, the registered information of the installed certificate (CA certificate) will be displayed in the “CA Certificate - Confirm” dialog box. If the certificate (CA certificate) is not installed, the content of the generated CSR file will be displayed.
When the [Delete] button is clicked, the installed certificate (CA certificate) will be deleted.

[CA Certificate - Certificate download]
Downloads the certificate (CA certificate) issued by CA from the camera.
When implementing alteration detection of video data (MP4 files) on the SD memory card using exclusive software, the downloaded certificate is used.

**IMPORTANT**
- Before deleting the valid certificate (CA certificate), confirm that there is a backup file of the certificate (CA certificate) on the PC or another media. The backup file will be required when installing the certificate (CA certificate) again.

2.4.4 How to configure alteration detection settings
The settings relating to alteration detection that detects when data in the SD memory card is altered or edited can be configured on this page.

The alteration detection settings will be configured in the following procedure.
2.4.4.1 Generation of the CRT key (encryption key)

**IMPORTANT**
- When the certificate (CA certificate) issued by CA is valid, it is impossible to generate the CRT key.
- When the certificate (CA certificate) issued by CA is used, the available key size varies depending on the CA. Check the available key size in advance.
- To generate the CRT key, it may take about 2 minutes. Do not operate the web browser until the generation of CRT key is complete. While the CRT key is being generated, the refresh interval and line speed may be lower.

1. Click the [Execute] button of “CRT key generate”.
   → The “CRT key generate” dialog box will be displayed.

2. Click the [Execute] button.
   → The generation of CRT key will be started. When the generation is finished, the key size and generation time & date of the generated key will be displayed on “Current CRT key”.

**Note**
- To change (or update) the generated CRT key, perform step 1 to 2. The CRT key and certificate issued by CA are valid in a set. When the CRT key is changed, it is necessary to re-apply for the certificate issued by CA.
- When the CRT key is updated, the log of the previous CRT key is saved. When the [History] button of “Current CRT key” on the “CRT key generate” dialog box is clicked, the “Previous CRT key” dialog box will be displayed, and it is possible to check the key size and generation time & date of the previous key. When the [Apply] button is clicked on the “Previous CRT key” dialog box, it is possible to replace the current CRT key with the previous one.

2.4.4.2 Generation of CSR (Certificate Signing Request)

**IMPORTANT**
- If the CRT key is not generated, it is impossible to generate the CSR.
• Before generating the CSR file, configure the following settings on [Internet Options] of the web browser in advance. Click [Internet Options...] under [Tools] of the menu bar of Internet Explorer, and then click the [Security] tab.
  – Register the camera for [Trusted Sites].
  – Click the [Custom level...] button to open the [Security Settings] window, and check the [Enable] radio button of [File Download] under [Downloads].
  – Click the [Custom level...] button to open the [Security Settings] window, and check the [Enable] radio button of [Automatic prompting for file downloads] under [Downloads].

1. Click the [Execute] button of “CA Certificate - Generate Certificate Signing Request”.
   → The “CA Certificate - Generate Certificate Signing Request” dialog box will be displayed.

2. Enter the information of the certificate to be generated.

```
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Available number of characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Common Name]</td>
<td>Enter the camera address or host name.</td>
<td>64 characters</td>
</tr>
<tr>
<td>[Country]</td>
<td>Enter the country name.</td>
<td>2 characters (Country code)</td>
</tr>
<tr>
<td>[State]</td>
<td>Enter the state name.</td>
<td>128 characters</td>
</tr>
<tr>
<td>[Locality]</td>
<td>Enter the locality name.</td>
<td>128 characters</td>
</tr>
<tr>
<td>[Organization]</td>
<td>Enter the organization name.</td>
<td>64 characters</td>
</tr>
<tr>
<td>[Organizational Unit]</td>
<td>Enter the unit name of the organization.</td>
<td>64 characters</td>
</tr>
<tr>
<td>[CRT key]</td>
<td>Displays the key size and generation time &amp; date</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>of the current key.</td>
<td></td>
</tr>
</tbody>
</table>
```

3. Click the [OK] button after entering the items.
   → The [Save As] dialog box will be displayed.

4. Enter a file name for the CSR in the [Save As] dialog box to save on the PC.
   → The saved CSR file will be applied to the CA.

**IMPORTANT**

• The certificate will be issued for the set of the generated CSR and CRT key. If the CRT key is re-generated or updated after applying to the CA, the issued certificate will be invalidated.
This camera generates the CSR file in the PEM format.

2.4.4.3 Installation of the certificate issued by CA

**IMPORTANT**
- If the CSR file is not generated, it is impossible to install the certificate (CA certificate) issued by CA.
- For the installation of the certificate issued by CA, the CA certificate issued by CA is required.

1. Click the [Browse...] button of “CA Certificate - Certificate install”.
   → The [Open] dialog box will be displayed.
2. Select the certification file and click the [Open] button. Then, click the [Execute] button.
   → The certification will be installed.

**Note**
- The host name registered in the installed certificate will be displayed on “CA Certificate - Information”. Depending on the status of the certificate, the following are displayed.

<table>
<thead>
<tr>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid</td>
<td>The CA certificate is not installed.</td>
</tr>
<tr>
<td>[Host name of the certificate]</td>
<td>The certificate has already been installed and validated.</td>
</tr>
<tr>
<td>Expired</td>
<td>The certification has already expired.</td>
</tr>
</tbody>
</table>

- When the [Confirm] button is clicked, the registered information of the installed certificate (CA certificate) will be displayed in the “CA Certificate - Confirm” dialog box. (Only “Organizational Unit” will be displayed with an asterisk (*).)

- When the [Delete] button is clicked, the installed certificate (CA certificate) will be deleted.
- When “On” is selected for “Additional info for detecting alteration”, it is impossible to delete the certificate (CA certificate) issued by CA.
- To change (or update) the certificate issued by CA, perform step 1 and 2.

**IMPORTANT**
- Before deleting the valid certificate (CA certificate), confirm that there is a backup file of the certificate (CA certificate) on the PC or another media. The backup file will be required when installing the certificate (CA certificate) again.
• The expiration date of the certificate issued by CA can be checked by double-clicking the server certification file issued by CA.

2.4.4.4 Configuration of alteration detection

1. Select “On” for “Additional info for detecting alteration”, and click the [Set] button.
2. Extensive information for alteration detection will be added to video files (MP4 format) recorded after changing the setting.

IMPORTANT
• When the “Additional info for detecting alteration” setting is changed, manual recording on the SD memory card will stop. Start manual saving again as necessary.

Note
• Alteration detection can be performed on video files (MP4 format) recorded when “On” is selected for “Additional info for detecting alteration” using exclusive software.
  For further information about exclusive software and how to use it, refer to our website below.
  https://security.panasonic.com/support/info/ <Control No.: C0304>
2.4.5 Access copy images saved on the SD memory card onto the PC [SD memory card images]

Click the [SD memory card] tab on the “Basic” page. (→page 38, page 39)
The following are descriptions of how to copy images saved on the SD memory card onto the PC. It is necessary in advance to select “Allow” for “FTP access to camera” on the [Network] tab of the “Network” page. (→page 148)

**IMPORTANT**

- It may sometimes be impossible to operate when another user is accessing images on the SD memory card. In this case, retry later.
- Depending on the settings of a proxy server or a firewall, images may not be obtained via a network. In this case, refer to the network administrator.

1. Click the [Execute] button of “SD memory card images”.
   → The user authentication window will be displayed.

2. Click the [OK] button after entering the user name and password of the camera administrator.
   → The folder in which images are to be saved will be displayed.

**Note**

- When the FTP server of the camera is logged to access images, the SD memory card is assigned to Drive B.
  Images are saved in different directories according to “Save trigger”.
  Move to the directory corresponding to the desired images and copy them.
  Refer to page 230 for further information about the directory structure.
Possible number of JPEG images that can be saved on the SD memory card (as indications)

For possible numbers of JPEG images that can be saved on the SD memory card, refer to our website below.
https://security.panasonic.com/support/info/ <Control No.: C0306>

Possible duration of stream images (H.265 or H.264) that can be saved on the SD memory card (as indications)

For possible duration of stream images (H.265 or H.264) that can be saved on the SD memory card, refer to our website below.
https://security.panasonic.com/support/info/ <Control No.: C0307>
2.4.6 Configure the directory of the PC that images will be downloaded to [Log]

Click the [Log] tab on the “Basic” page. (→page 38, page 39)
The directory of the PC that images recorded on the SD memory card will be downloaded to can be configured in this section.

<table>
<thead>
<tr>
<th>Recording stream 1</th>
<th>Name of the destination directory for downloaded images</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Default directory</td>
</tr>
<tr>
<td>Manual/Schedule</td>
<td>Default directory</td>
</tr>
<tr>
<td>FTP periodic image transmission error</td>
<td>Default directory</td>
</tr>
</tbody>
</table>

**Alarm**

The settings related to the directory of the PC that recorded images of when alarms occur will be downloaded to can be performed.

**[Recording stream 1] - [Name of the destination directory for downloaded images]**

Enter the name of the destination directory to which images recorded in the recording stream 1 are to be downloaded. For example, enter “C:\alarm” to designate the folder “alarm” under drive C.

- **Available number of characters:** 3 - 128 characters
- **Available characters:** Alphanumeric characters, the slash (/), the backslash (\), the colon (:), and the underscore (_).

**[Recording stream 2] - [Name of the destination directory for downloaded images]**

Enter the name of the destination directory to which images recorded in the recording stream 2 are to be downloaded. For example, enter “C:\alarm2” to designate the folder “alarm2” under drive C.

- **Available number of characters:** 3 - 128 characters
- **Available characters:** Alphanumeric characters, the slash (/), the backslash (\), the colon (:), and the underscore (_).

**Manual/Schedule**

The settings related to the directory name of the PC that images recorded by manual saving or schedule saving will be downloaded to can be performed.

Designate the destination folder in the same manner as for “Alarm”.

**Note**

- Schedule saving is available only when “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”.

<table>
<thead>
<tr>
<th>Recording stream 1</th>
<th>Name of the destination directory for downloaded images</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Default directory</td>
</tr>
<tr>
<td>Manual/Schedule</td>
<td>Default directory</td>
</tr>
<tr>
<td>FTP periodic image transmission error</td>
<td>Default directory</td>
</tr>
</tbody>
</table>
FTP periodic image transmission error

The settings related to the directory name of the PC that recorded images of when FTP errors occur will be downloaded to can be performed.
Designate the destination folder in the same manner as for “Alarm”.

**IMPORTANT**
- When “Name w/o time&date” is selected for “File name” of “FTP periodic image transmission” on the [Advanced] tab on the “Network” page, FTP error log and associated images will not be saved. To save them, select “Name w/time&date”. (→page 159)

**Note**
- When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, “FTP periodic image transmission error” is unavailable.

2.5 Configure the settings relating to images and audio [Image/Audio]

The settings relating to JPEG, H.265, and H.264 images such as the settings of image quality, audio, etc. can be configured on this page.
The “Image/Audio” page has the [Image] tab, the [Image quality] tab, and the [Audio] tab.

2.5.1 Configure the settings relating to the image capture mode [Image]

Click the [Image] tab on the “Image/Audio” page. (→page 38, page 39)

**[Image capture mode]**
Select an image to be displayed on the “Live” page.

- 2 mega pixel [16:9](30fps mode)/2 mega pixel [16:9](60fps mode)/3 mega pixel [4:3](30fps mode)
  - **Default**: 2 mega pixel [16:9](30fps mode)

- 1.3 mega pixel [16:9](30fps mode)/1.3 mega pixel [16:9](60fps mode)/1.3 mega pixel [4:3](30fps mode)
  - **Default**: 1.3 mega pixel [16:9](30fps mode)

**IMPORTANT**
- The positions of areas may move out of alignment when the “Image capture mode” setting is changed when the following area settings are configured. Therefore we recommend that you configure each area setting after configuring the “Image capture mode”.
  - mask area (→page 104)
  - privacy zone (→page 108)
  - VMD area (→page 126)
2 Settings

- VIQS area (→ page 110)
2.5.2 Configure the settings relating to JPEG images [Image]

Click the [Image] tab on the “Image/Audio” page. (→page 38, page 39)

"Live" page (Initial display)

Configure the settings relating to the initial images displayed on the “Live” page.

[Initial display stream]

Select the image to display on the “Live” page from the following.
JPEG(1)/JPEG(2)/JPEG(3)/Stream(1)/Stream(2)/Stream(3)/Stream(4)/Multi-screen

• Default: Stream(1)

Note

• When “JPEG(1)”, “JPEG(2)”, or “JPEG(3)" is selected, the refresh interval can be selected.
  MJPEG/Refresh interval: 1s/Refresh interval: 3s/Refresh interval: 5s/Refresh interval: 10s/Refresh interval: 30s/Refresh interval: 60s

[Refresh interval (JPEG)*]

Select an interval to refresh the displayed JPEG image from the following.
0.1fps/ 0.2fps/ 0.33fps/ 0.5fps/ 1fps/ 2fps/ 3fps/ 5fps/ 6fps*/ 10fps*/ 12fps*/ 15fps*/ 30fps*

• Default: 5fps

Note

• When “On" is selected for “Stream transmission", the refresh interval may be longer than the set value when any value with an asterisk (*) on the right is selected.
• Depending on factors such as the network environment, the resolution, the image quality, or the number of computers concurrently accessing the camera, the transmission interval may be longer than the set value.
• If images are not delivered in the specified transmission interval, you can make the images be delivered closer to the specified time by lowering the resolution or image quality.

JPEG

Configure the settings such as “Image capture size", “Image quality" of “JPEG(1)”, “JPEG(2)”, or “JPEG(3)" on this section. Refer to page 87 for further information about the settings relating to H.265 (or H.264) images.

[Image capture size]

Select the image capture size to display the JPEG image.
### Image capture mode

<table>
<thead>
<tr>
<th>Image capture mode</th>
<th>JPEG(1)</th>
<th>JPEG(2)</th>
<th>JPEG(3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 mega pixel [16:9]</td>
<td>1920×1080</td>
<td>1920×1080</td>
<td>640×360</td>
</tr>
<tr>
<td>(30fps mode)</td>
<td>1280×720</td>
<td>1280×720</td>
<td>320×180</td>
</tr>
<tr>
<td></td>
<td>640×360</td>
<td>640×360</td>
<td></td>
</tr>
<tr>
<td></td>
<td>320×180</td>
<td>320×180</td>
<td></td>
</tr>
<tr>
<td>2 mega pixel [16:9]</td>
<td>1920×1080</td>
<td>1920×1080</td>
<td>640×360</td>
</tr>
<tr>
<td>(60fps mode)</td>
<td>1280×720</td>
<td>1280×720</td>
<td>320×180</td>
</tr>
<tr>
<td></td>
<td>640×360</td>
<td>640×360</td>
<td></td>
</tr>
<tr>
<td></td>
<td>320×180</td>
<td>320×180</td>
<td></td>
</tr>
<tr>
<td>3 mega pixel [4:3]</td>
<td>2048×1536</td>
<td>1280×960</td>
<td>VGA</td>
</tr>
<tr>
<td>(30fps mode)</td>
<td>1280×960</td>
<td>800×600</td>
<td>400×300</td>
</tr>
<tr>
<td></td>
<td>800×600</td>
<td>VGA</td>
<td>QVGA</td>
</tr>
<tr>
<td></td>
<td>VGA</td>
<td>400×300</td>
<td>QVGA</td>
</tr>
<tr>
<td></td>
<td>400×300</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>320×180</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Default:**
  - JPEG(1): 1920×1080
  - JPEG(2): 640×360
  - JPEG(3): 320×180

### Image capture mode

<table>
<thead>
<tr>
<th>Image capture mode</th>
<th>JPEG(1)</th>
<th>JPEG(2)</th>
<th>JPEG(3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3 mega pixel [16:9]</td>
<td>1280×720</td>
<td>1280×720</td>
<td>640×360</td>
</tr>
<tr>
<td>(30fps mode)</td>
<td>640×360</td>
<td>640×360</td>
<td>320×180</td>
</tr>
<tr>
<td></td>
<td>320×180</td>
<td>320×180</td>
<td></td>
</tr>
<tr>
<td>1.3 mega pixel [16:9]</td>
<td>1280×720</td>
<td>1280×720</td>
<td>640×360</td>
</tr>
<tr>
<td>(60fps mode)</td>
<td>640×360</td>
<td>640×360</td>
<td>320×180</td>
</tr>
<tr>
<td></td>
<td>320×180</td>
<td>320×180</td>
<td></td>
</tr>
<tr>
<td>1.3 mega pixel [4:3]</td>
<td>1280×960</td>
<td>1280×960</td>
<td>VGA</td>
</tr>
<tr>
<td>(30fps mode)</td>
<td>800×600</td>
<td>800×600</td>
<td>400×300</td>
</tr>
<tr>
<td></td>
<td>VGA</td>
<td>VGA</td>
<td>QVGA</td>
</tr>
<tr>
<td></td>
<td>400×300</td>
<td>400×300</td>
<td>QVGA</td>
</tr>
<tr>
<td></td>
<td>320×180</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Default:**
  - JPEG(1): 1280×720
  - JPEG(2): 640×360
  - JPEG(3): 320×180

#### Image quality

Select the image quality of JPEG images for each image capture size.

0 Super fine/ 1 Fine/ 2/ 3/ 4/ 5 Normal/ 6/ 7/ 8/ 9 Low

- **Default:** 5 Normal
2.5.3 Configure the settings relating to Stream [Image]

Click the [Image] tab on the “Image/Audio” page. (→page 38, page 39)
Configure the settings relating to H.265 (or H.264) image such as “Max bit rate (per client)”, “Image capture size”, “Image quality”, etc. in this section. Refer to page 85 for the settings relating to JPEG images.

Stream(1)/ Stream(2)/ Stream(3)/ Stream(4)

[Stream transmission]
Select “On” or “Off” to determine whether or not to transmit H.265 (or H.264) images.
• On: Transmits H.265 (or H.264) images.
• Off: Does not transmit H.265 (or H.264) images.
• Default: On

Note
• When “On” is selected for “Stream transmission” in “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” displaying of H.265 (or H.264) images or JPEG images on the “Live” page will become available.
• When “On” is selected for “Stream transmission” for “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)”, the refresh interval of JPEG images is limited to a maximum of 5 fps.

[Stream encoding format]
Select the stream encoding format for transmission.
• H.265: Transmits H.265 images.
• H.264: Transmits H.264 images.
• Default: H.265

[Internet mode (over HTTP)]
Select “On” when transmitting H.265 (or H.264) images via the Internet. It is possible to transmit stream without changing the broadband router settings configured for JPEG image transmission.
• **On**: H.265 (or H.264) images and audio will be transmitted using the HTTP port. Refer to page 150 for further information about the HTTP port number settings.
• **Off**: H.265 (or H.264) images and audio will be transmitted using the UDP port.
• **Default**: Off

**Note**
- When “On” is selected, only “Unicast port (AUTO)” will be available for “Transmission type”.
- When “On” is selected, it may take time to start displaying stream images.
- When “On” is selected, stream images may not be displayed depending on the number of the concurrent access user and audio data availability, etc.
- When “On” is selected, only IPv4 access is available.

### [Image capture size]
Select the image capture size from the following. What can be selected may be limited depending on the image capture size already selected.

<table>
<thead>
<tr>
<th>Image capture mode</th>
<th>Stream(1)</th>
<th>Stream(2)</th>
<th>Stream(3)</th>
<th>Stream(4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 mega pixel [16:9](30fps mode)</td>
<td>1920×1080 1280×720 640×360 320×180</td>
<td>1920×1080 1280×720 640×360 320×180</td>
<td>1280×720 640×360 320×180</td>
<td>640×360 320×180</td>
</tr>
<tr>
<td>2 mega pixel [16:9](60fps mode)</td>
<td>1920×1080 1280×720</td>
<td>1920×1080 1280×720 640×360 320×180</td>
<td>1280×720 640×360 320×180</td>
<td>640×360 320×180</td>
</tr>
<tr>
<td>3 mega pixel [4:3](30fps mode)</td>
<td>2048×1536 1280×960 800×600 VGA 400×300 QVGA</td>
<td>1280×720 640×360 VGA 400×300 QVGA</td>
<td>VGA 400×300 QVGA</td>
<td>VGA 400×300 QVGA</td>
</tr>
<tr>
<td>1.3 mega pixel [16:9] (30fps mode)</td>
<td>1280×720 640×360 320×180</td>
<td>1280×720 640×360</td>
<td>1280×720 640×360</td>
<td>640×360 320×180</td>
</tr>
<tr>
<td>1.3 mega pixel [16:9] (60fps mode)</td>
<td>1280×720</td>
<td>1280×720 640×360 320×180</td>
<td>1280×720 640×360 320×180</td>
<td>640×360 320×180</td>
</tr>
</tbody>
</table>

• **Default**:
  - Stream(1): 1920×1080
  - Stream(2): 640×360
  - Stream(3): 320×180
  - Stream(4): 320×180
<table>
<thead>
<tr>
<th>Image capture mode</th>
<th>Stream(1)</th>
<th>Stream(2)</th>
<th>Stream(3)</th>
<th>Stream(4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3 mega pixel [4:3] (30fps mode)</td>
<td>1280×960 800×600 VGA 400×300 QVGA</td>
<td>1280×960 800×600 VGA 400×300 QVGA</td>
<td>VGA 400×300 QVGA</td>
<td>VGA 400×300 QVGA</td>
</tr>
</tbody>
</table>

- **Default:**
  - Stream(1): 1280×720
  - Stream(2): 640×360
  - Stream(3): 320×180
  - Stream(4): 320×180

**[Transmission priority]**
Select a transmission priority for “Stream” from the following.

- **Constant bit rate:** H.265 (or H.264) images will be transmitted with the bit rate selected for “Max bit rate (per client)”**.
- **VBR:** H.265 (or H.264) images will be transmitted with the frame rate selected for “Frame rate”** while maintaining the image quality level selected in “Image quality”. In this case, images will be transmitted with the bit rate kept within the maximum bit rate that is set for “Max bit rate (per client)”**. The image quality is fixed, and the recording capacity changes according to the “Image quality” setting and conditions of the subject.
- **Frame rate:** H.265 (or H.264) images will be transmitted with the frame rate selected for “Frame rate”**.
- **Best effort:** In accordance with the network bandwidth, H.265 (or H.264) images will be transmitted with the maximum bit rates that are set for “Max bit rate (per client)”**.
- **Default:** Frame rate

**Note**
- When “Frame rate” is set for “Transmission priority”, number of users who can access the camera may be limited.

**[Frame rate]**
Select a frame rate from the following.
1fps/ 3fps/ 5fps*/ 7.5fps*/ 10fps*/ 12fps*/ 15fps*/ 20fps*/ 30fps* / 60fps*
- **Default:** 30fps*

**Note**
- “Frame rate”** is restricted by “Max bit rate (per client)”**. For this reason, the frame rate may be lower than the specified value when any value marked with an asterisk (*) is selected. When “VBR” is selected for “Transmission priority”, depending on the settings of “Max bit rate (per client)”** and “Image quality”, transmission of images may periodically be paused. Check the transmission of images after changing settings.
- When the “Image capture mode” is set as “2 mega pixel [16:9](60fps mode)” or “1.3 mega pixel [16:9] (60fps mode)”, Stream(1) is fixed to 60fps. Also, Stream(2) to Stream(4) can select up to a maximum of 30fps.
- Depending on the number of users connecting at the same time or the combination of features used, the frame rate may be lower than the configured value. Check the transmission of images after changing settings.
[Max bit rate (per client)*]
Select an H.265 (or H.264) bit rate per a client from the following.
64kbps/ 128kbps*/ 256kbps*/ 384kbps*/ 512kbps*/ 768kbps*/ 1024kbps*/ 2048kbps*/ 3072kbps*/
4096kbps*/ 6144kbps*/ 8192kbps*/ 10240kbps*/ 12288kbps*/ 14336kbps*/ 16384kbps*/ 20480kbps*/
24576kbps*/ — FREE ENTRY—
When “— FREE ENTRY—” is selected, the bit rate can be freely entered.
• Default:
  - Stream(1): 3072kbps*   3333  S353X   S3131  /2048kbps*  3333  S351X   S3111
  - Stream(2): 1536kbps*
  - Stream(3): 1024kbps*
  - Stream(4): 1024kbps*
* The range of bit rates that can be configured for H.265 (or H.264) bit rates differs depending on the
  “Transmission priority” and “Image capture size”.

When “Constant bit rate”, “Frame rate”, or “Best effort” is selected for “Transmission priority”
• QVGA, 400x300, VGA, 320×180 and 640x360: 64kbps - 4096kbps*
• 800x600: 64kbps - 4096kbps*
• 1280×960 and 1280×720*: 128kbps* - 8192kbps*
• 1920×1080*: 256kbps* - 12288kbps*  3333  S355X   S3131
• 2048×1536: 512kbps* - 16384kbps*  3333  S355X   S3131

When “VBR” is selected for “Transmission priority”
• QVGA, 400x300, VGA, 320×180 and 640x360: 64kbps - 12288kbps*
• 800x600: 64kbps* - 12288kbps*
• 1280×960 and 1280×720: 128kbps* - 12288kbps*
• 1920×1080: 256kbps* - 24576kbps*  3333  S355X   S3131
• 2048×1536: 512kbps* - 24576kbps*  3333  S355X   S3131

Note
• The bit rate for “Stream” is restricted by “Bandwidth control(bit rate)” on the [Network] tab on the
  “Network” page (→page 148). When a value with “*” attached is set, images may not be streamed.
• When the refresh interval is short, the configured bit rate may be exceeded depending on the subject.
• Depending on the number of users connecting at the same time or the combination of features used,
  the bit rate may be lower than the configured value.
Check the transmission of images after changing settings.

[Image quality]
Select the image quality of H.265 (or H.264) images from the following.
• For “Constant bit rate”, “Frame rate”, and “Best effort”: Motion priority/Normal/Quality priority
• “VBR”: 0 Super fine/ 1 Fine/ 2/ 3/ 4/ 5 Normal/ 6/ 7/ 8/ 9 Low
• Default: Normal

[Smart Coding] - [GOP control]
By using “GOP control”, the transmission data volume can be reduced when there is little motion in the image.
• When “H.265” is selected as the “Stream encoding format”: Off/On(Low)/On(Mid)/On(Advanced)/
  On(Frame rate control)
• When “H.264” is selected as the “Stream encoding format”: Off/On(Low)/On(Mid)
• Default: Off
IMPORTANT

• When “On(Low)”, “On(Mid)”, “On(Advanced)”, or “On(Frame rate control)” is selected, recording to an SD memory card cannot be performed.

Note

• When using “GOP control”, the refresh interval is increased when streaming H.265 (or H.264) images. For this reason, do not use it when the network environment has frequent errors.
• “On(Low)”/“On(Mid)”/“On(Frame rate control)” can be selected only when “VBR” is selected for “Transmission priority”. “On(Advanced)” can be selected regardless of the “Transmission priority” setting.
• When “On(Frame rate control)” is selected, the frame rate ranges from 1fps to the value set in [Frame rate] depending on the size of image changes.
• When “On(Frame rate control)” is selected, the display may temporarily become slower or faster when changing frame rates.

[Smart Coding] - [Smart Facial Coding]
Maintains high image quality in the areas of the image containing people’s faces and moving objects, and reduces the transmission data volume in other areas of the image.
• Off: Does not use “AUTO VIQS” and “Smart Facial Coding”.
• On(AUTO VIQS): Maintains high image quality in the areas of the image containing moving objects, and reduces the transmission data volume in other areas of the image.
• On(Smart Facial Coding): Maintains high image quality in the areas of the image containing people’s faces and moving objects, and reduces the transmission data volume in other areas of the image.
• Default: Off

Note

• This feature can only be used for “Stream(1)”.
• When “2 mega pixel [16:9](60fps mode)” or “1.3 mega pixel [16:9](60fps mode)” is selected for “Image capture mode”, this function is not available.
• When the camera is used in environments of 40°C or higher, the effectiveness of the smart facial coding will be reduced.
• Depending on the object, a high image quality may be maintained even in areas that do not contain a person’s face.
• If “On(AUTO VIQS)” or “On(Smart Facial Coding)” is selected, the VIQS setting set from the [Image quality] tab is disabled.

[Refresh interval]
Select an interval (I-frame interval; 0.2 - 5 seconds) to refresh the displayed H.265 (or H.264) images from the following.
If using under a network environment with frequent error occurrences, shorten the refresh interval for H.265 (or H.264) to diminish image distortions. However, the image refresh speed may be lowered and the configured bit rate may be exceeded.
0.2s/ 0.25s/ 0.33s/ 0.5s/ 1s/ 2s/ 3s/ 4s/ 5s
• Default: 1s

Note

• When “On(Low)” is selected for “GOP control”, the refresh interval is set to Max. 8s.
• When “On(Mid)” is selected for “GOP control”, the refresh interval is set to Max. 16s.
• When “On(Advanced)” is selected for “GOP control”, the refresh interval is set to 60s.
• If “GOP control” is set to “On(Frame rate control)”, the frame rate ranges from 1fps to the value set in [Frame rate] depending on the size of image changes. The smaller the frame rate value, the longer the refresh interval. When the frame rate is the value set in [Frame rate], the refresh interval is at Max. 16s.
[Transmission type]
Select the transmission type of H.265 (or H.264) images from the following.

- **Unicast port (AUTO):** Up to 14 users can access a single camera concurrently. “Unicast port1(Image)” and “Unicast port2(Audio)” will automatically be selected when transmitting images and audio from the camera. When it is unnecessary to fix the port number for stream transmission such as when using in a particular LAN environment, it is recommended to select “Unicast port (AUTO)”.
- **Unicast port (MANUAL):** Up to 14 users can access a single camera concurrently. It is necessary to select “Unicast port1(Image)” and “Unicast port2(Audio)” manually to transmit images and audio from the camera. It is possible to fix the port number of the router used for stream transmission via the Internet by setting “Unicast port (MANUAL)” ([→] page 148). Refer to the operating instructions of the router in use.
- **Multicast:** Unlimited number of users can access a single camera concurrently. Complete the entry field of “Multicast address”, “Multicast port” and “Multicast TTL/HOPLimit” when transmitting stream with multicast. Refer to page 9 for further information about the maximum concurrent access number.

**Default:** Unicast port (AUTO)

[Unicast port1(Image)]
Enter the unicast port number (used to transmit images from the camera).

- **Available port number:** 1024 - 50000 (Only even numbers are available.)
- **Default:**
  - Stream(1): 32004
  - Stream(2): 32014
  - Stream(3): 32024
  - Stream(4): 32034

[Unicast port2(Audio)]
Enter the unicast port number (used to transmit audio from the camera).

- **Available port number:** 1024 - 50000 (Only even numbers are available.)
- **Default:**
  - Stream(1): 33004
  - Stream(2): 33014
  - Stream(3): 33024
  - Stream(4): 33034

[Multicast address]
Enter the multicast IP address. Images and audio will be transmitted to the designated IP address.

- **Available IPv4 address:** 224.0.0.0 - 239.255.255.255
- **Available IPv6 address:** Multicast address starting with "FF"
- **Default:**
  - Stream(1): 239.192.0.20
  - Stream(2): 239.192.0.21
  - Stream(3): 239.192.0.22
  - Stream(4): 239.192.0.23

**Note**
- Enter a multicast IP address after checking available multicast address.

[Multicast port]
Enter the multicast port number (used to transmit images from the camera).

- **Available port number:** 1024 - 50000 (Only even numbers are available.)
- **Default:** 37004
**Note**
- When audio is transmitted from the unit, the port number to be used will be the multicast port number plus “1000”.

[Multicast TTL/HOPLimit]^3
Enter a value for “Multicast TTL/HOPLimit”.
- **Available value:** 1-254
- **Default:** 16

**IMPORTANT**
- When transmitting stream images via the internet, the transmitted image sometimes may not be displayed depending on the settings of a proxy server or a firewall. In this case, refer to the network administrator.
- When two or more network interface cards are installed on the PC in use, the network interface card(s) not used for receiving images should be invalidated when displaying images using the multicast port.

---

^1 When 60 fps is used, settings up to 24576kbps are possible.
^2 It is necessary to designate the unicast port number when “Unicast port (MANUAL)” is selected for “Transmission type”.
^3 It is necessary to designate the multicast IP address when “Multicast” is selected for “Transmission type”.

---

*Operating Instructions* | 93
2.5.4 Configure the settings relating to image adjust, extra zoom, privacy zone, VIQS, and lens distortion compensation [Image quality]

Click the [Image quality] tab on the “Image/Audio” page. (→page 38, page 39)
When the [Setup>>] button of each setting item is clicked, the detailed settings menu will be displayed in a newly opened window. The detailed settings can be configured while monitoring images displayed on the [Image quality] tab.
The settings relating to the image adjust, extra zoom, privacy zone, VIQS, and lens distortion compensation can be configured on this page.

[Image adjust]
Click the [Setup>>] button to display the setup menu that can configure the settings relating to image quality. The setup menu will be displayed in a newly opened window. (→page 95)

[Extra zoom]
Click the [Setup>>] button to display the setup menu that can configure the settings relating to extra zoom. The setup menu will be displayed in a newly opened window. (→Page 106)

[Privacy zone]
Click the [Setup>>] button to display the setup menu that can configure the settings relating to the privacy zone. The setup menu will be displayed. (→page 108)

[VIQS]
Click the [Setup>>] button to display the setup menu that can configure the settings relating to VIQS. The setup menu will be displayed. (→page 112)

[Lens distortion compensation]
Click the [Setup>>] button to display the setup menu that can configure the settings relating to lens distortion compensation. The setup menu will be displayed in a newly opened window. (→Page 114)
2.5.4.1 Configure the settings relating to image quality ("Image adjust" setup menu)

Click the [Setup>>] button of "Image adjust" on the [Image quality] tab of the "Image/Audio" page. (→page 94)
The settings relating to image quality can be configured with the setup menu displayed in a newly displayed window. When the values are changed, the changed values will be applied to the currently displayed image on the [Image quality] tab.
Click the "+" mark on the left of each item in the setup menu to expand the respective item, and enable detailed settings.
Click the "-" mark on the left of an expanded item to return to the screen displayed before the item was expanded.

<Example: Super dynamic (SD)>

Super Dynamic(SD)

[Super Dynamic(SD)]
Select “On” or “Off” to determine whether or not to activate the super dynamic function. This function is not available when “2 mega pixel [16:9](60fps mode)” or “1.3 mega pixel [16:9](60fps mode)” is selected for “Image capture mode”.
Refer to the description “Super Dynamic function” (→page 96) about the super dynamic function.
2 Settings

- **On**: The super dynamic function will work.
- **Off**: The super dynamic function will not work.
- **Default**: On

**Note**
- When the following are observed depending on the light condition, select “Off” for “Super Dynamic(SD)”:
  - When flickering appears or the color changes on the screen
  - When noise appears in the brighter area on the screen
- When the camera is used in environments of 40°C or higher, the effectiveness of the super dynamic function will be reduced.

**[Level]**
Adjust the super dynamic (SD) level.
If you move the slider in the “+” direction, a subject with high contrast can be captured without over exposure or under exposure.
If you move the slider in the “-” direction, the parts with medium brightness can be captured with rich gradation.
Click the [Reset] button to reset to the default setting.
- **Default**: 28

**Note**
- When changing the level, the images may be distorted temporarily.

**Super Dynamic function**
When there is wide variation between the illumination of light and dark areas of the location being monitored, the camera adjusts the lens iris in accordance with the brighter areas. This causes loss of detail in darker areas. Conversely, adjusting the lens brightness for the darker areas causes the brighter areas to become washed out.
Super Dynamic digitally combines an image that is set up for a clear view of the brighter areas with an image that is set up for a clear view of the darker areas, creating a final image that preserves overall detail.
Subject in the dark area is hard to notice...

Subject in the bright area is washed out...

Creates a clearer image by digitally combining images

[BLC/ HLC]
Select from the following. When “On” is selected for “Super Dynamic(SD)” or when “On” is selected for “Intelligent Auto”, this setting is not available.

- **Back light compensation (BLC):** Activates the back light compensation (BLC) function.
- **High light compensation (HLC):** Activates the high light compensation (HLC) function. The high light compensation function limits the over exposure of subjects caused bright light (such as light from headlights of cars) at night.
- **Off:** Deactivates the back light compensation function and high light compensation function.
- **Default:** Off

[BLC level]
Adjust the BLC level.
If you move the slider in the “+” direction, the effect of back light compensation will increase.
If you move the slider in the “-” direction, the effect of back light compensation will decrease.
Click the [Reset] button to reset to the default setting.
- **Default:** 16

[HLC level]
Adjust the high light compensation level.
If you move the slider in the “+” direction, the effect of high light compensation (HLC) will increase.
If you move the slider in the “-” direction, the effect of high light compensation (HLC) will decrease.
Click the [Reset] button to reset to the default setting.
- **Default:** 16

[Mask area]
When mask area is set, the selected area is masked and you can adjust brightness. When “On” is selected for “Super Dynamic(SD)”, this setting is not available.
Refer to page 104 for information on how to set the mask area.
2 Settings

Light control mode

Select the light control mode from the following.

- **Indoor scene (50 Hz) / Indoor scene (60 Hz)**: The shutter speed will automatically be adjusted to prevent flicker caused by fluorescent light. Select 50 Hz or 60 Hz corresponding to the location where the camera is in use.
- **ELC**: Uses shutter speed adjustment to control light.
- **Default**: ELC

[Brightness]
Adjust the brightness.
If you move the slider in the “+” direction, the image will become brighter.
If you move the slider in the “-” direction, the image will become darker.
Click the [Reset] button to reset to the default brightness setting.

- **Default**: 64

[Maximum gain]
Adjusts the maximum gain. When the luminance of the subject becomes darker, gain will be automatically increased and screen will become brighter. If you increase the gain, the noise may also increase.
If you move the slider in the “+” direction, the maximum gain will increase.
If you move the slider in the “-” direction, the maximum gain will decrease.
Click the [Reset] button to reset to the default setting.

- **Default**: 11

[Maximum shutter]
The maximum shutter time adjusts the storage time of the sensor. The following are available for the recording duration.

- When “2 mega pixel [16:9](60fps mode)” or “1.3 mega pixel [16:9](60fps mode)” is selected for “Image capture mode”:
  Max.1/10000s, Max.1/4000s, Max.1/2000s, Max.1/1000s, Max.1/500s, Max.1/250s, Max.1/120s, Max.1/100s, Max.2/120s, Max.1/30s, Max.2/30s, Max.4/30s, Max.6/30s, Max.10/30s, Max.16/30s

- When “2 mega pixel [16:9](30fps mode)”, “1.3 mega pixel [16:9](30fps mode)”, “3 mega pixel [4:3](30fps mode)”, or “1.3 mega pixel [4:3](30fps mode)” is selected for “Image capture mode”:
  Max.1/10000s, Max.1/4000s, Max.1/2000s, Max.1/1000s, Max.1/500s, Max.1/250s, Max.1/120s, Max.1/100s, Max.2/120s, Max.2/100s, Max.3/120s, Max.1/30s, Max.2/30s, Max.4/30s, Max.6/30s, Max.10/30s, Max.16/30s

- **Default**: Max.1/30s

Note
- When “On” is selected for “Super Dynamic(SD)”, “Max.1/2000s”, “Max.1/4000s” and “Max.1/10000s” are not available.
• When "0" is selected for "Maximum gain", "Max.2/30s" or higher is not available in 30fps mode and "Max.1/30s" or higher is not available in 60fps mode.

[Light control speed]
Adjust the light control speed.
If you move the slider in the "+" direction, the light control speed will increase.
If you move the slider in the "-" direction, the light control speed will decrease.
Click the [Reset] button to reset to the default setting.
• Default: 31

Day & Night(IR)
Select switching between the color mode and the black & white mode from the following.
• Off: The color mode is selected.
• On(IR Light Off): Always captured as black & white images.
• On(IR Light On): Always captured as black & white images. Suitable when using near-infrared lighting at night.
• Auto1(IR Light Off): The camera automatically switches between the color mode and the black & white mode in accordance with the picture brightness (luminance).
• Auto2(IR Light On): The camera automatically switches between the color mode and the black & white mode in accordance with the picture brightness (luminance). Suitable when using near-infrared lighting at night.
• Auto3(SCC): Suitable to keep the color mode even under darker light condition. The Super Chroma Compensation (SCC) function retains the color mode even with dim lighting.
• Default: Auto2(IR Light On)

Super Chrome Compensation (SCC) function
This function achieves faithful color images using the proprietary color compensation technology that reproduce images even under low illumination where it is usually difficult to capture objects faithfully.

IMPORTANT
• If the focus cannot be automatically adjusted, refer to “2.5.4.3 Adjust the angular field of view with extra zoom”.

Note
• Since the color compensation technology is used for “Auto3(Super Chrome Compensation(SCC))”, some colors may look different from the actual objects depending on the light condition (such as when infrared lights are used).
• The operating sound might be heard when changing to black-and-white mode, however it does not indicate any malfunction.
• The color mode and the black white mode may not be switched automatically depending on the environment. In such a case, use the schedule function to switch the color and the black white mode. For how to set up, refer to the following Panasonic support website.
[Level]
Select the threshold illuminance level (brightness) to switch between the color mode and the black & white mode. The descriptions about the following threshold illuminance levels are given when “Off” is selected for “Super Dynamic(SD)”.

• **High**: Switches from the color mode to the black & white mode when the ambient brightness (illuminance) of the camera is approx. 2 lx or less.
• **Low**: Switches from the color mode to the black & white mode when the ambient brightness (illuminance) of the camera is approx. 1 lx or less.
• **Default**: High

**Note**
• When a low value is selected for “Maximum gain”, it may be difficult to switch modes depending on the environment.

[Dwell time]
Select a wait time for switching between the color mode and the black & white mode from the following.
2s/ 10s/ 30s/ 1min
• **Default**: 10s

[IR LED light intensity]
Select the IR LED light intensity from High/Middle/Low/Off.
• **Default**: High

**Note**
• “Off” is only available when “Black & white input” is selected for “Terminal 1” on the [Alarm] tab.

[Intensity control]
Select On/Off to determine whether or not to activate the IR Light over exposure suppression function.
• **Default**: On

**White balance**

[White balance]
Select a method of white balance adjustment from the following.
White color can be adjusted by “Red gain” and “Blue gain”.
• **ATW1**: Selects the automatic tracing white balance mode. The camera will constantly check the color temperature of the light source and adjust the white balance automatically. Operating color temperature range is approx. 2,700 K to 6,000 K.
• **ATW2:** Selects the automatic tracing white balance mode under a sodium lamp. The camera will adjust the white balance automatically under a sodium lamp. Operating color temperature range is approx. 2,000 K to 6,000 K.

• **AWC:** Selects the automatic white balance control mode. This adjustment is suitable for a location where a light source is stable. Operating color temperature range is approx. 2,000 K to 10,000 K.

• **Default:** ATW1

**Note**
- Under the following conditions, color may not be faithfully processed. In these cases, select “AWC”.
  - When shooting a subject whose major part is a thick color
  - When shooting blue sky or sun at sunset
  - When shooting a subject whose luminance is too low
- When “AWC” is selected, click the [Set] button.

**[Red gain]**
Adjust the red color of images.
When the slider is moved in the “+” direction, the red color will become thicker. When the slider is moved in the “-” direction, the red color will be thinner. Click the [Reset] button to reset the color to the default.
- **Default:** 128

**[Blue gain]**
Adjust the blue color of images.
When the slider is moved in the “+” direction, the blue color will become thicker. When the slider is moved in the “-” direction, the blue color will be thinner. Click the [Reset] button to reset the color to the default.
- **Default:** 128

**[Mask area]**
If you set the mask area, you can adjust the white balance after masking the set area.
Refer to page 104 for information about how to configure the mask area.

**[Adjustment speed]**
Adjust the white balance adjustment speed.
If you move the slider in the “+” direction, the white balance adjustment speed will increase. If you move the slider in the “-” direction, the white balance adjustment speed will decrease. If you click the [Reset] button, the slider position and white balance adjustment speed will be reset to default.
- **Default:** 31

**Intelligent Auto**

<table>
<thead>
<tr>
<th>Intelligent auto</th>
<th>On</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face priority level</td>
<td>128</td>
<td>Reset</td>
</tr>
<tr>
<td>Motion priority level</td>
<td>128</td>
<td>Reset</td>
</tr>
</tbody>
</table>

**[Intelligent Auto]**
Select On/Off to determine whether or not to activate the “Intelligent Auto” function.
“Intelligent Auto” can detect conditions (back lighting, outdoor, night time, etc.) or moving objects and then automatically adjust the camera’s aperture, gain, shutter speed, and contrast in order to display moving objects more clearly.
- **Default:** On
[Face priority level]
Adjusts the face priority level when “Intelligent Auto” is activated.
If you move the slider in the “+” direction, adjusts to improve the visibility of faces.
If you move the slider in the “-” direction, adjusts the entire image so that is well-balanced.
Click the [Reset] button to reset to the default setting.
• Default: 128

[Motion priority level]
Adjusts the motion priority level when “Intelligent Auto” is activated.
If you move the slider in the “+” direction, it becomes difficult for the moving subjects to blur, but the noise of dark subjects increases.
If you move the slider in the “-” direction, it becomes easier for the moving subjects to blur, but the noise of dark subjects decreases.
Click the [Reset] button to reset to the default setting.
• Default: 128

Detailed setting

[Auto contrast adjust]
Select On/Off(Manual) to determine whether or not to activate the auto contrast adjust function.
On: Activates the auto contrast adjust function.
Off: Stops the auto contrast adjust function.
• Default: On

Note
• When “On” is selected for “Intelligent Auto”, this setting is not available.

[Contrast level]
Adjust the contrast level.
If you move the slider in the “+” direction, the contrast of the image will increase.
If you move the slider in the “-” direction, the contrast of the image will decrease. Click the [Reset] button to reset to the default setting.

- Default: 128

**[Adaptive black stretch]**
Adjust the brightness of the dark parts of the image.
If you move the slider in the “+” direction, the dark parts of the image will become brighter.
If you move the slider in the “-” direction, the dark parts of the image will become darker.
Click the [Reset] button to reset to the default setting.

- Default: 128

**IMPORTANT**
- The “adaptive black stretch” settings may cause the noise in the darker parts to increase, and the parts around borders between the darker parts and the brighter parts may become darker/brighter than the other darker/brighter parts.

**[Adaptive highlight stretch]**
Adjust the brightness of the bright parts of the image.
If you move the slider in the “+” direction, the dark parts of the image will become brighter.
If you move the slider in the “-” direction, the bright parts of the image will become darker.
Click the [Reset] button to reset to the default setting.

- Default: 128

**[Fog compensation]**
Select “On” or “Off” to determine whether or not to activate the fog compensation function. When “On” is selected for “Auto contrast adjust”, or when “On” is selected for “Intelligent Auto”, this setting is not available. The fog compensation function can make dim images that have been affected by fog or other conditions clearer using digital image processing.

- On: Activates the fog compensation function.
- Off: Stops the fog compensation function.
- Default: Off

**[Level]**
Adjust the fog compensation level. The level of fog compensation will increase when the slider is moved in the “+” direction, and decrease when the slider is moved in the “-” direction. Click the [Reset] button to reset to the default setting.

- Default: 4

**[Chroma gain level]**
Adjusts the chroma level (color density).
If you move the slider in the “+” direction, the colors will become loud and vivid. If you move the slider in the “-” direction, the colors will become subdued. Click the [Reset] button to reset the color to the default.

- Default: 128

**[Hue level]**
Adjust the hue level of images.
If you move the slider in the “+” direction, the redness of skin color will increase, and the blueness of sky color will decrease.
If you move the slider in the “-” direction, the redness of skin color will decrease, and the blueness of sky color increase.
Click the [Reset] button to reset to the default setting.

- Default: 128
[Aperture level]
Adjust the aperture level (outline compensation).
If you move the slider in the “+” direction, the outline of the image will become sharper, and if you move it in the “-” direction, the outline of the image will become softer. Click the [Reset] button to reset the color to the default.
• Default: 16

[Pedestal level]
Adjust the black level of images by moving the slider.
When the slider is moved to the “+” direction, images will become brighter. When the slider is moved to the “-” direction, images will be darker. Click the [Reset] button to reset the color to the default.
• Default: 128

[DNR]
The digital noise reduction function reduces noise automatically under the condition of low illuminance.
If you move the slider in the “+” direction, the noise reduction effect is strengthened. There may be many afterimages.
If you move the slider in the “-” direction, the noise reduction effect is weakened. There are fewer afterimages.
Click the [Reset] button to reset to the default setting.
• Default: 128

Scene registration

[Scene file]
The combination of settings used to adjust image quality can be saved as a scene file. The scene file can be selected here.
Registered scene files can be configured in the “Schedule” page (→ page 193). If the timing of when images are viewed greatly affects the area where images are viewed, registering scene files to the schedule can let you match a combination of settings to different times of day in order to view images in the best conditions.

[Scene file title]
The scene file name (up to 10 characters) displayed in “Scene file” can be changed. Only file names displayed in “1:”, “2:”, “3:”, and “4:” can be changed.
• Unavailable characters: “ &

[Load] button
Loads the setting data selected in “Scene file” and changes the current image accordingly.

[Register] button
The combination of settings used to adjust image quality that are currently displayed can be registered to the scene file displayed in “Scene file”.

2.5.4.2 Set mask areas
This explains how to mask an area of the image and adjust brightness.
When setting the mask area, set “Super Dynamic(SD)” to “Off”.

1. Display the “Image adjust” setup menu. (→page 94)

2. Click “+” on the left of “Super Dynamic(SD)” to display the detailed SD menu.

3. Click the [Start] button of “Mask area”.
   → Borders will appear and the image displayed on the [Image quality] tab will be divided into 63 (9×7).
4. Click the divided areas to be masked.
   → The clicked areas will be masked and will become white. To cancel masking, click the area again.

5. Click the [End] button after completing masking areas.
   → The borders on the image displayed on the [Image quality] tab will disappear.

**IMPORTANT**

- The mask area may move out of alignment if the setting for "Image capture mode" of the [Image] tab, or "Image rotation" or "Mirror" of the [Basic] tab is changed after the mask area has been configured. Make sure to check the mask area after changing the settings.
- Configure mask area settings with a zoom ratio of x1.0 used for extra zoom. The mask area operates in the mask position of zoom ratio of x1.0 even after extra zoom settings.

**Note**

- When the [Reset] button is clicked, masking for all the masked areas will be canceled.

### 2.5.4.3 Adjust the angular field of view with extra zoom

Click the [Setup>>] button of "Extra zoom" on the [Image quality] tab of the "Image/Audio" page. (→Page 94)
It is possible to adjust the angular field of view using the extra zoom function.

Click this button to adjust the zoom ratio to the “Wide” side.
• Click this button to set the zoom ratio to x1.0.
• Click this button to adjust the zoom ratio to the “Tele” side.
• Click these buttons to adjust the horizontal/vertical position of the image after zooming.

**Note**
- The maximum zoom ratio for extra zoom varies depending on the model and the selected [Image capture mode].
- Refer to the Important Information for more information about the maximum zoom ratio.

**IMPORTANT**
- The extra zoom function may not be activated on the appropriate position if the setting for the function is performed after the settings for the VIQS area (page 112), privacy zone (page 108), or VMD area (page 128). Therefore, configure each area's settings after configuring the extra zoom settings.
- Configure mask area settings with a zoom ratio of x1.0. The mask area (page 104) operates in the mask position of zoom ratio of x1.0 even after extra zoom settings.
### 2.5.4.4 Configure the settings relating to the privacy zone (‘Privacy zone’ setup menu)

Click the [Setup>>] button of ‘Privacy zone’ on the [Image quality] tab of the ‘Image/Audio’ page. (→page 94)

When there is a zone that you do not want to display, set the zone as a privacy zone not to be displayed. Up to 8 privacy zones can be set.

#### [Area]

The privacy zone will be set when an area is designated by dragging the mouse. Each zone can be overlapped. The zones are numbered sequentially from area 1.

**Note**

- Set the privacy zone larger than the size of an object to be hidden.

#### [Status]

Select “On” or “Off” to determine whether or not to display the privacy zone.

- **On**: The privacy zone will be displayed.
- **Off**: The privacy zone will not be displayed.
- **Default**: Off

#### [Delete] button

Click the [Delete] button corresponding to the zone to be deleted.

#### [Display type]

- **Filling**: Displays in gray.
• **Mosaic**: Displays in mosaic.
• **Default**: Filling

**IMPORTANT**
- When “Mosaic” is selected for [Display type], image behind the set area can be seen through. Therefore, the object and person behind the area can be recognized to some extent. Always check the result image according to factors such as the setting conditions or the subject.

**[Close] button**
Click this button to close the “Privacy zone” setup menu.

**IMPORTANT**
- The privacy zone may move out of alignment if the settings for “Image capture mode” of the [Image] tab, or “Image rotation” or “Mirror” of the [Basic] tab are changed. Make sure to check the privacy zone setting after changing the settings.
2.5.4.5 Configure the VIQS setting

Click the [Setup>>] button of “VIQS” on the [Image quality] tab of the “Image/Audio” page. (→page 94) VIQS is an abbreviation of Variable Image Quality on Specified area and is a feature that enables you to change the images of a specified area.

It is possible to enhance the image quality of the specified range within a shooting area (image). It is also possible to moderate the image data size by lowering the image quality of other areas. The VIQS setting is available only for H.265 (or H.264) images.

Up to 8 VIQS areas can be set.
To check the image after configuring VIQS, when H.265 (or H.264) images are selected under “Stream”, you can check the image by pressing the [Confirm] button. You can also check by displaying an H.265 (or H.264) image on the “Live” page.

[Area]
When selecting a VIQS area in the screen, it will be numbered as area 1. (Subsequent areas will be numbered in the order of selection.)

[Status]
Select “On” or “Off” to determine whether or not to use the VIQS area.
• On: The VIQS area will be set.
• Off: Does not set the VIQS area.
[Delete] button
Deletes the VIQS area. Click the button to delete the VIQS area.

[Level]
Configure the difference level in the image quality between specified areas and non-specified areas. The greater the difference level, the more the image quality of the non-specified area is reduced. This makes it possible to moderate the image data size.
0 Min./ 1/ 2/ 3/ 4/ 5 Normal/ 6/ 7/ 8/ 9 Max.
• Default: 5 Normal

Stream

[Stream(1)]
Select “On” or “Off” to determine whether or not to activate the VIQS function for the transmitted (Stream(1)) images.
The VIQS (Stream(1)) images can be confirmed with the [Confirm] button.
• Default: Off

[Stream(2)]
Select “On” or “Off” to determine whether or not to activate the VIQS function for the transmitted (Stream(2)) images.
The VIQS (Stream(2)) images can be confirmed with the [Confirm] button.
• Default: Off

[Stream(3)]
Select “On” or “Off” to determine whether or not to activate the VIQS function for the transmitted (Stream(3)) images.
The VIQS (Stream(3)) images can be confirmed with the [Confirm] button.
• Default: Off

[Stream(4)]
Select “On” or “Off” to determine whether or not to activate the VIQS function for the transmitted (Stream(4)) images.
The VIQS (Stream(4)) images can be confirmed with the [Confirm] button.
• Default: Off

IMPORTANT
• After the VIQS setting is set to “On”, the VIQS area may move out of alignment when the “Image capture mode” setting on the [Image] tab of the “Image/Audio” page is changed. Make sure to check the VIQS setting after changing the “Image capture mode” setting.

Note
• Refer to page 112 for setting procedure of the VIQS area.
• When “Off” is selected for “Stream transmission” of the applicable stream, the stream selection cannot be changed.
2.5.4.6 Configure the VIQS area

The VIQS area is specified by following the steps below.

1. Drag the mouse on the screen to specify the area (up to 8 areas).
   → The specified area is set to area “1(White)”, and the outline is displayed.
   The areas are set in the area number order from number 1. The color next to the area number show
the color of the corresponding outline.

2. Configure the difference level in the image quality between specified areas and non-specified areas. The
   greater the difference level, the more the image quality of the non-specified area is reduced. This makes
   it possible to moderate the image data size.

3. Select On/Off to activate/deactivate a distributed image of “Stream(1)” – “Stream(4)”.

4. Click the [Set] button.
   → This unit is updated with the setting contents. Click the [Delete] button corresponding to the area to be
   deleted.

5. Click the [Confirm] button.
   → The image (“Stream(1)” – “Stream(4)”) that the [Confirm] button was pressed for is displayed. When a
   window is newly opened and about 3 seconds pass, the currently outputted bit rate can be confirmed
   with the configured VIQS.
**IMPORTANT**

- No setting contents are determined unless the [Set] button is clicked.
- To check the image after configuring VIQS, display an H.265 (or H.264) image on the “Live” page, or press the [Confirm] button under “Stream”.
- The outputted bit rate changes depending on the subject. Confirm the bit rates with actual subjects used when operating the camera.
- If the larger range is specified, the output bit rate increases. Check the current output bit rate to decide the area size.
2.5.4.7 Configure the settings relating to lens distortion compensation

Click the [Setup>>] button of “Lens distortion compensation” on the [Image quality] tab of the “Image/Audio” page. (→Page 94)
Distortion correction can be performed using lens distortion compensation. The amount of compensation performed can be adjusted.

- The degree of distortion compensation varies depending on the image capture mode. Configure the image capture mode before configuring the lens distortion compensation.
- The degree of distortion compensation varies depending on the zoom ratio. Adjust the angular field of view with the zoom setting before configuring the lens distortion compensation.
2.5.5 Configure the settings relating to audio [Audio]

Click the [Audio] tab on the “Image/Audio” page. (→page 38, page 39)
The settings relating to audio can be configured on this page.

Note

• Images and audio will not be synchronized. Therefore, images and audio may not always match.
• Audio may be interrupted depending on the network environment.

Mic input

[Mic input volume]
Set the audio volume for input into the camera. This setting is reflected in the volume when listening to audio on a PC (mic input to PC), and in the volume during “Audio recording”.
• **Mic High/Mic Middle/Mic Low**: Set the volume when audio is input to the camera using a microphone.
• **Default**: Mic Middle

[AGC (audio)]
Automatically adjusts the audio reception to a suitable volume. The degree to which the volume is adjusted can be selected from High/Middle/Low.
When “High” is selected, it is easier to hear quiet sounds, but sounds may be heard as noise. If you do not want to hear noise, select “Middle” or “Low”. These settings are linked with the volume settings of the “Audio recording”.
• **Default**: High

[Audio bit rate]
Set the audio compression bit rate.
[G.726(Live)]: 16kbps/32kbps
[G.711(Live)]: 64kbps (cannot be changed)
[AAC-LC(Live/Recording)]: 64kbps/96kbps/128kbps
• **Default**:
  – [G.726(Live)]: 32kbps
Audio transmission/reception

[Audio transmission mode]
Select the communication mode used for audio data reception between the camera and the PC from the following:
• Off: Does not receive audio between the camera and the PC.
• Mic Input (To PC): PC receives the audio data from the camera. On the PC, the image can be viewed together with the accompanying audio. The image and audio are not synchronized.
• Default: Off

[Mic input interval (Camera to PC)]
Select an interval for audio reception from the following. 20ms/40ms/80ms/160ms
• Default: 40ms

Note
• When a shorter interval is selected, the delay time will be shorter. When a longer interval is selected, audio interruption may be diminished even though the delay time will be longer. Select the interval according to the network environment.
• "Mic input interval (Camera to PC)" is unavailable when "AAC-LC" is selected for "Audio input encoding format".

Live page

[Audio input encoding format]
Select the audio input encoding format to be used in the "Live" page from G.726, G.711, or AAC-LC.
• Default: G.726

[Audio volume control mode]
Select the operation method using the volume cursor of the Mic input button on the “Live” page.
• Adjust PC speaker: Change the volume of the PC in which the “Live” page is opened.
• Adjust Mic input: Change the mic input volume of the camera.
• Default: Adjust Mic input
2.6 Configure the multi-screen settings

[Multi-screen]

The cameras from which images are to be displayed on a multi-screen can be registered on the “Multi-screen” page. (→page 38, page 39)

**[IP address]**

Enter the IP address or the host name of the camera to be used for the multi-screen. 4 cameras can be registered as a group and up to 4 groups (16 cameras) can be registered.

When the HTTP port number for the camera of which images are to be displayed had been changed, enter as follows:

- **Example of entry:**
  - Example when entering an IPv4 address: http://192.168.0.10:8080
  - Example when entering an IPv6 address: http://[2001:db8:0:0:0:0:0:1]:8080

To access the cameras using the HTTPS protocol, enter as follows:

- **Example of entry:** https://192.168.0.10/

**Available number of characters:** 1 - 128 characters

**Default:** (Cam. 1) selfcamera, (Cam. 2 - 16) not registered
2 Settings

IMPORTANT

- When accessing the camera using the HTTPS protocol, install the pre-installed certificate or the CA certificate of the camera to display images on the monitor. (→page 180)
- This camera is specified when “selfcamera” is displayed for the IP address or host name.

Note

- For further information about “Network Camera Recorder with Viewer Software Lite”, which is suited to viewing images from several cameras, refer to our website (https://security.panasonic.com/support/info/ <Control No.: C0301>).
- When using the host name, it is necessary to configure the DNS settings of the PC to be used for the multi-screen display. Refer to the network administrator for information on the DNS setting of PCs.

[Camera title]
Enter the title of the camera. The entered camera title will be displayed on a multi-screen.
- Available number of characters: 0 - 20 characters
- Unavailable characters: " &
- Default:
  - (Cam. 1) The model No. is displayed.
  - (Cam. 2 - 16) None (blank)

Note
- When selecting a 16 split-screen, some characters of the camera title to be displayed may not be displayed.

Initial display

[Layout]
Select the layout for the initial display from the following:
- 4 Screens(1-4)/ 4 Screens(5-8)/ 4 Screens(9-12)/ 4 Screens(13-16)/ 9 Screens(1-9)/ 9 Screens(10-16)/ 16 Screens
- Default: 4 Screens(1-4)

[Refresh interval]
Select the refresh interval during initial display.
- H.265(1): Displays the camera image in the H.265 format (video).
- H.264(1): Displays the camera image in the H.264 format (video).
- MJPEG: Displays the camera image in the motion JPEG format (video).
- Refresh interval: 1s/ Refresh interval: 3s/ Refresh interval: 5s/ Refresh interval: 10s/ Refresh interval: 30s/ Refresh interval: 60s: Displays the JPEG format (still image) camera image in the selected interval.
- Default: MJPEG

[Image capture size(4 Screens)]
Select the image capture size for 4 screens in initial display.
- Default: 320×180
2.7 Configure the alarm settings [Alarm]

The settings relating to alarm occurrences such as settings for the alarm action at an alarm occurrence or alarm images, the VMD area settings, and the alarm occurrence notification can be configured on this page. The “Alarm” page has the [Alarm] tab, the [VMD area] tab, and the [Notification] tab.

2.7.1 Configure the settings relating to the alarm action [Alarm]

Click the [Alarm] tab on the “Alarm” page. (→page 38, page 39)
The settings relating to the alarm can be configured in this section. Refer to page 120 for further information about the settings relating to the alarm images.

![Alarm settings table]

**Alarm**

[VMD alarm]
When clicking “VMD >>”, the [VMD area] tab of the “Alarm” page will be displayed. (→page 128)

[Audio detection alarm]
When clicking “Audio detection>>, the [Audio detection] tab will be displayed. (→page 132)

[Command alarm]
Select “On” or “Off” to determine whether or not to receive the command alarm.
The command alarm is the function that provides notification of a Panasonic protocol alarm from the other cameras. When “On” is selected, alarm actions will be performed between multiple cameras.
• Default: Off

[Reception port]
Select a port number to be used to receive the command alarm.
• Available range: 1-65535
• Default: 8181
The following port numbers are unavailable since they are already in use.
20, 21, 23, 25, 42, 53, 67, 68, 69, 80, 110, 123, 161, 162, 443, 554, 995, 10669, 10670, 59000-61000

[Alarm deactivation time]
Configure the duration that detections won’t be made after an alarm is detected. For example, by using this function you can prevent E-mail from being sent too often when E-mail notifications are configured to be sent to cellular phones when an alarm is detected.
5-600s
• Default: 5s
Note
• The duration that alarm detections are not made can be managed for each type of alarm. For example, during the time when detections for command alarms are not made, detections for VMD alarm can be made.

2.7.2 Configure the settings relating to the camera action on alarm occurrence [Alarm]
Click the [Alarm] tab on the "Alarm" page. (→page 38, page 39)
The settings related to the camera action on alarm can be configured in this section.

- [Image compression rate upon alarm detection]
  Click "Image compression rate upon alarm detection setup >>" to display the setup menu that can configure the settings relating to image quality when an alarm occurs. The setup menu will be displayed in a newly opened window. (→page 121)

- [Alarm E-mail notification]
  Click "E-mail server >>" to display the setup menu that can configure the settings relating to E-mail notification when an alarm occurs. The setup menu will be displayed in a newly opened window. (→page 122)

- [Alarm image FTP transmission]
  Click "FTP setup >>" to display the setup menu that can configure the settings relating to FTP transmission when an alarm occurs. The setup menu will be displayed in a newly opened window. (→page 123)

- [Alarm image recording(SD memory card)]
  Click "SD memory card setup >>" to display the setup menu that can configure the settings relating to recording images on an SD memory card when an alarm occurs. The setup menu will be displayed in a newly opened window. (→page 124)

- [Panasonic alarm protocol]
  Click "Panasonic alarm protocol notification >>" to display the setup menu that can configure the settings relating to transmitting Panasonic alarm protocol notifications when an alarm occurs. The setup menu will be displayed in a newly opened window. (→page 125)

- [HTTP alarm notification]
  Click "HTTP alarm notification setup >>" to display the setup menu that can configure the settings relating to transmitting HTTP alarm notifications when an alarm occurs. The setup menu will be displayed in a newly opened window. (→page 126)
2.7.2.1 Configure settings relating to image quality on alarm action

Click “Image compression rate upon alarm detection setup >>” of “Camera action on alarm” on the [Alarm] tab of the “Alarm” page. (→page 120)

[Image compression rate upon alarm detection]
Select “On” or “Off” to determine whether or not to change the image quality (→page 85) upon alarm detection.
- **On**: Images will be transmitted with the image quality selected for “Image quality upon alarm detection”.
- **Off**: Does not change the image quality upon alarm detection.
- **Default**: Off

[Image quality upon alarm detection]
Image quality can be changed upon an alarm occurrence. Select the image quality from the following.
0 Super fine/ 1 Fine/ 2/ 3/ 4/ 5 Normal/ 6/ 7/ 8/ 9 Low
- **Default**: 5 Normal
2.7.2.2 Configure settings relating to alarm E-mail notifications

Click “E-mail server >>” of “Camera action on alarm” on the [Alarm] tab of the “Alarm” page. (→page 120)

Refer to page 153 for information on configuration for these settings.
2.7.2.3 Configure settings relating to FTP transmissions of alarm images

Click “FTP setup >>” of “Camera action on alarm” on the [Alarm] tab of the “Alarm” page. (→page 120)

Refer to page 157 for information on configuration for these settings.
2.7.2.4 Configure settings relating to recording to an SD memory card when an alarm occurs

Click “SD memory card setup >>” of “Camera action on alarm” on the [Alarm] tab of the “Alarm” page. (→page 120)

Refer to page 65 for information on configuration for these settings.
2.7.2.5 Configure settings relating to Panasonic alarm protocol notification when an alarm occurs

Click “Panasonic alarm protocol notification >>” of “Camera action on alarm” on the [Alarm] tab of the “Alarm” page. (→page 120)

Refer to page 133 for information on configuration for these settings.
2.7.2.6 Configure settings relating to HTTP alarm notification when an
alarm occurs

Click “HTTP alarm notification setup >>” of “Camera action on alarm” on the [Alarm] tab of the “Alarm” page. (→page 120)

Refer to page 135 for information on configuration for these settings.

2.7.3 Configure the VMD settings [VMD area]

Click the [VMD area] tab on the “Alarm” page. (→page 38, page 39)
The video motion detection areas can be set on this page.
Up to 4 areas can be set. When motion is detected in the set area, it will be regarded as an alarm.

IMPORTANT

• The alarm occurrence indication button (→page 11) will be displayed when motion is detected by the
VMD function.
• The alarm occurrence indication button will be displayed when an alarm is detected with the audio
detection alarm, or when receiving a command alarm.
• Depending on the network environment, notification may be delayed even when “Real time” is selected
for “Status update mode” on the [Basic] tab of the “Basic” page (→page 58).
• After configuring the VMD area, the VMD area may move out of alignment when “Image capture
mode” of the [Image] tab is changed. Make sure to check the VMD area after changing the “Image
capture mode” setting.
• The motion detection function is not the dedicated function to prevent thefts, fires, etc. We are not responsible for any accidents or damages that may occur.

### Area
When selecting a VMD area in the screen, it will be numbered as area 1. (Subsequent areas will be numbered in the order of selection.)

### Status
Select “On” or “Off” to determine whether or not to perform video motion detection.
- **On**: Performs video motion detection.
- **Off**: Does not perform video motion detection.
- **Default**: Off

### Detection area
Adjust the size of the VMD area using the slider. The smaller the selected value is, the higher the sensitivity of VMD area becomes. The current value (1-10) will be displayed on the right of the slider.
- **Default**: 1

### Detection sensitivity
Adjust the sensitivity of motion detection in the VMD area using the slider. The settings can be configured for each area individually. The larger the value is set, the higher the sensitivity level becomes. The current value (1 (low) - 15 (high)) will be displayed below the slider.
- **Default**: 8
[Delete] button
Click the [Delete] button corresponding to the area to be deleted. The outline of the selected area will be deleted.

[Light detection control]
Select “On” or “Off” to determine whether or not to suspend video motion detection affected by brightness change such by a dimming level control.
• Default: Off

IMPORTANT
• “Light detection control” may not work when brightness change is too small.
• When “On” is selected for “Light detection control”, the video motion detection may not be performed even when detecting a subject moving over the whole screen.

[Area No. notification]
When “Panasonic alarm protocol notification >>” is clicked, the [Notification] tab of the “Alarm” page will be displayed. (→page 132)

VMD information addition
[Information addition]
Select “On” or “Off” to determine whether or not to add VMD information to superimposed image data. The VMD information can be searched by some of Panasonic network disk recorders. Refer to the operating instructions of the connected devices for further information about the functions and settings.
• Default: Off

2.7.4 Set the VMD areas [VMD area]
Set the areas to activate the VMD function.

IMPORTANT
• During change of setting in the setup menu, no alarm will be detected. After setup is complete, close the setup menu.
1. Set the video motion detection area by dragging the mouse on the screen.
   → The designated area will become the VMD area “1(White)” and the outline will be displayed. When 2 - 4 VMD areas are set, each area will be numbered in order. The areas will be identified by the respective outline colors. The “Status” of the outline to be set for the area will become “On”.

   Refer to page 126 for further information about the “Detection sensitivity” and “Detection area”. The currently displayed area and its detection sensitivity will be displayed in the “Detection area” section. Change areas and the settings of “Detection area” and “Detection sensitivity” as necessary.

3. Click the [Set] button after completing the settings.

   **IMPORTANT**
   - The setting will not be applied unless the [Set] button is clicked.

4. To invalidate the VMD area, click the [Set] button after selecting “Off” for “Status” of the VMD area to be invalidated.
   → The outline of the invalidated VMD area will turn to a dotted line. When the VMD area is invalidated, no alarm will occur even when a motion can be recognized in the area.

5. To delete the VMD area, click the [Delete] button corresponding to the area to be deleted.
   → The outline of the respective VMD area will disappear.

6. Click the [Set] button.
   → The edited settings will be applied.
2.7.5 Configure the settings relating to the audio detection [Audio detection]

Click the [Audio detection] tab on the “Alarm” page. (→page 38, page 39)

The settings relating to audio detection can be configured in this section. When the configured audio detection level is exceeded, the alarm action will be performed.

The audio detection level can be adjusted in 10 levels.

**IMPORTANT**

- The alarm occurrence indication button will be displayed when sound is detected by the audio detection function. (→page 11)
- The alarm occurrence indication button will also be displayed when receiving a VMD alarm detection or a command alarm.
- Notification may be delayed in some network environments even when “Real time” is selected for “Status update mode” on the [Basic] tab of the “Basic” page. (→page 58)
- The audio detection feature is not designed to be used in situations that require high reliability. We are not responsible for any accidents or damages that may occur.

[Audio detection]

Select “On” or “Off” to determine whether or not to perform audio detection.
- **On**: Performs audio detection.
- **Off**: Does not perform audio detection.
- **Default**: Off
Note
- The volume level for when audio detection is performed can be changed in “Mic input volume” on the [Audio] tab of the “Image/Audio” page. (→page 115)

[Audio detection level]
Select the level at which the camera determines that there is sound in the area around the camera when detecting sound.
If you only want to detect loud sounds, raise the audio detection level; if you also want to detect quiet sounds, lower the audio detection level.

Configure the audio detection level

1. Check the audio detection level and current volume level.
   → The volume level configured in “Mic input volume” on the [Audio] tab of the “Image/Audio” page is displayed in the preview.
2. Adjust the “Audio detection level” with the slider bar so that it is lower than the volume level that you want to detect.
3. Adjust the “Mic input volume” on the [Audio] tab of the “Image/Audio” page as necessary. (→page 115)
   → The settings and the actual audio detection status are displayed on the bottom of the screen. If the volume level goes above the audio detection level, a red bar, which indicates that sound has been detected, is displayed.
If further adjustments are required, repeat from step 2.

**Note**
- Noise or other unwanted sound from the surrounding area may be mistakenly detected.
- Only the volume of the sound determines whether sound is detected or not, the type of sound does not matter.

### 2.7.6 Configuration of the settings relating to alarm notification [Notification]

Click the [Notification] tab on the “Alarm” page. (→page 38, page 39)

The settings relating to Panasonic alarm protocol and HTTP alarm notification can be configured in this section.
2.7.6.1 Configure the settings relating to Panasonic alarm protocol

Panasonic alarm protocol notification

[Panasonic alarm protocol]
Select “On” or “Off” to determine whether or not to provide notification by Panasonic alarm protocol according to the settings for the “Alarm” and “Diag.” checkboxes of “Destination of notification” below.

– When an alarm is detected (“Alarm”)
– When a notification of the remaining capacity of the SD memory card has been provided (“Diag.”)
– When the SD memory card has become full (“Diag.”)
When the SD memory card cannot be recognized (“Diag.”)
  • Default: Off

**Note**
  • When “On” is selected, notification of the alarm occurrence will be provided to the registered destination server addresses in order (to IP address 1 first, to IP address 8 last).

**[Additional alarm data]**
Determine whether or not to send notifications for VMD alarm detection area numbers with the Panasonic alarm protocol by selecting On/Off.
  • Default: Off

**[Destination port]**
Select a destination port for the Panasonic alarm protocol from the following.
  • Available range: 1 - 65535
  • Default: 1818
The following port numbers are unavailable since they are already in use.
20, 21, 23, 25, 42, 53, 67, 68, 69, 80, 110, 123, 161, 162, 443, 995, 10669, 10670

**[Retry times]**
Select a retry time for the Panasonic alarm protocol.
  • Available range: 0-30
  • Default: 2

**Destination of notification**

**[Address 1] - [Address 8]**
Enter the destination IP address or host name of the Panasonic alarm protocol from the following. Up to 8 destination server addresses can be registered.
  • [Alarm] checkbox: When the checkbox is checked, the Panasonic alarm notification will be provided upon an alarm occurrence.
  • [Diag.] checkbox: When the checkbox is checked, notification using Panasonic alarm protocol will be provided in the following cases.
  - When notification of the remaining capacity of the SD memory card has been provided
  - When the SD memory card has become full
  - When the SD memory card cannot be recognized
  • [Destination server address]: Enter the destination server address or host name.
  - Available characters: Alphanumeric characters, the colon (:), the period (.), the underscore (_), and the hyphen (-).
To delete the registered destination server address, click the [Delete] button respective to the desired destination server address.

**[Notification per VMD area]**
Select “On” or “Off” to determine whether or not to set “Notification per VMD area”.
If “Notification per VMD area” is turned “On”, an alarm is notified only when “Alarm area No.” matches “Alarm area” configured by “VMD alarm”. Alarm notifications other than “VMD alarm” are not implemented. When using “Notification per VMD area”, select “On” for “Status” of the alarm area in VMD.
  • Default: Off

**[Alarm area No.]**
  • Available range: 1-4
  • Default: 1
IMPORTANT

• When entering the host name of the “Destination server address”, the DNS settings on the [Network] tab of the “Network” page must be configured. (→ page 148)
• Confirm that the destination IP addresses are registered correctly. When a registered destination does not exist, notification may be delayed.

2.7.6.2 Configure the settings relating to HTTP alarm notification

HTTP alarm notification

[Address 1] - [Address 5]
Enter the destination IP address or host name of the HTTP alarm notification. Up to 5 destination server addresses can be registered.
• Available characters: Alphanumeric characters, the colon (:), the period (.), the underscore (_), and the hyphen (–).
• Default: http://
Example of entry: “http://IP address of the HTTP server + : (colon) + port number” or “http://Host name: (colon) + port number”

[Alarm] checkbox
When the checkbox is checked, the HTTP alarm notification will be provided upon an alarm occurrence.

[Delete] button
When this button is clicked, all configured information, including the address, user name, password, and notification data, will be deleted.

[User name]
Enter the user name (login name) to access the HTTP server.
• **Available number of characters**: 0 - 63 characters
• **Unavailable characters**: " & : ; \ 

**[Password]**
Enter the password to access the HTTP server.
• **Available number of characters**: 0 - 63 characters
• **Unavailable characters**: " & 

**[Notification data]**
Enter the notification data to add after the destination HTTP server addresses set in [Address 1] - [Address 5].
• **Available characters**: Alphanumeric characters
• **Default**: /cgi-bin/comalarm.cgi?CMD=01

**Note**
- When the HTTP alarm function is enabled, leakage of the HTTP server authentication information (user name and password) may occur in the network at the time of HTTP alarm notification.
- For “Address 1” to “Address 5”, a total of 256 characters can be entered for the address (including “http://”) and “Notification data”.
- Make sure to enter a slash (/) as the first character for “Notification data”.
- If the HTTP alarm notification fails, information about the failure will be added to the system log.
- Even if the [Set] button is clicked after deleting the contents of “Notification data”, “/cgi-bin/comalarm.cgi?CMD=01” will be set.
- HTTPS cannot be used.

**<Example>**
When http://192.168.0.100 is set for the address and /cgi-bin/comalarm.cgi?CMD=01 is set for “Notification data”, an HTTP alarm notification such as http://192.168.0.100/cgi-bin/comalarm.cgi?CMD=01 will be executed.
2.8 Configure the settings relating to the authentication [User mng.]

The settings relating to the authentication such as users and PCs restrictions for accessing the camera with a PC or cellular phone/mobile terminal can be configured on the "User mng." page. The "User mng." page has 4 tabs; the [User auth.] tab, the [Host auth.] tab, [IEEE 802.1X] tab and [Data encryption] tab.

2.8.1 Configure the settings relating to the user authentication [User auth.]

Click the [User auth.] tab on the "User mng." page. (→page 38, page 39)
The settings relating to the authentication of users who can access this camera from the PC or a cellular phone/mobile terminal can be configured on this page. Up to 24 users can be registered.
Note

- When user authentication has failed to pass (authentication error) 8 times within 30 seconds using the same IP address (PC), access to the unit will be denied for a while.

[User auth.]
Select “On” or “Off” to determine whether or not to authenticate the users.
- Default: On

[Guest User]
Select whether or not to set Guest User. If you select “Use”, you can set which functions are available or unavailable for guest users for whom user authentication has not been performed.
- Default: Not use
[Authentication]
Set the user authentication method.
- Digest or Basic: Uses “Digest or Basic” authentication.
- Digest: Uses “Digest” authentication.
- Basic: Uses “Basic” authentication.
- Default: Digest

Note
- To enhance the security, it is recommended to select “Digest” for “Authentication method”. If “Digest or Basic” or “Basic” is selected, leakage of the user name and the password may occur.
- When the [Authentication] setting has been changed, close the web browser, and then access the camera again.
- About the system devices (Panasonic network disk recorder and others)
  For the model No. and the firmware version of applicable products, refer to the following Panasonic support web site.
  https://security.panasonic.com/support/info/ <Control No.: C0701>

[User name registration]
At the time of new registration, register a new user name in [User name]. Click [▼] in “User name registration” to view registered users. Registered users are displayed as "Registered user name [Access level]". (Example: admin [1])
If you click the [Change] button on the right, the selected user will be displayed in [User name], and you can change the password. By clicking the [Delete] button on the right, you can delete the selected user.

[User name (1 to 32 characters)]
Enter a user name.
- Available number of characters: 1 - 32 characters
- Unavailable characters: " & : ; \
- Default: None (blank)

Note
- When the user name already in use is entered and the [Set] button is clicked, the respective user information will be overwritten.

[Password (8 to 32 characters)] [Retype password]
Enter a password.
- Available number of characters: 8 - 32 characters
- Unavailable characters: " &
- Default: None (blank)

Note
- Distinguish between upper- and lower cases.
- For the password, use three or more types of characters from upper- and lowercase alphabetic characters, numeric characters, and symbols.
- Set the password which does not include the user name.

[Access Level]
Select the access level of the user from the following.
- 1. Administrator: Allowed all available operations of the camera.
- 2. Camera control: Allowed to control the camera. Functions selected for “Access level” can be operated.
- 3. Live only: Allowed to display live view. Functions selected for “Access level” can be operated.
- Default: 3. Live only
[Access level]
Select the available functions based on the user access level (camera control, live view, guest user).

- **Default:**
  - Camera control: All are checked
  - Live only: All are not checked
  - Guest User: All are not checked

**Note**
- **If you have set “User authentication” to “Off”, and “Guest User” to “Not use”:**
  The “Access Level” item cannot be set. And, while all the live operation buttons are displayed, the [Setup] buttons require authentication.
- **If you have set “User authentication” to “Off”, and “Guest User” to “Use”:**
  You can set the items for “Guest User”.
- **If you have set “User authentication” to “On”:**
  You cannot set the items for “Guest User”.

You can set the following functions.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live view selectable</td>
<td>Selecting an image displayed in the live view setting permissions</td>
</tr>
<tr>
<td>Listen</td>
<td>Mic Input (To PC) (when listening on a PC) setting permissions (→page 13)</td>
</tr>
<tr>
<td>Refresh Rate</td>
<td>JPEG format image refresh interval setting permissions (→page 12)</td>
</tr>
<tr>
<td>Snap shot</td>
<td>Snap shot operation permissions (→page 13)</td>
</tr>
<tr>
<td>Playback of recording (Log disp.)</td>
<td>Log operation permissions (→page 12)</td>
</tr>
<tr>
<td>Manual rec./Delete rec.</td>
<td>SD memory card save/delete permissions (→page 12)</td>
</tr>
<tr>
<td>Brightness</td>
<td>Brightness setting permissions (→page 12)</td>
</tr>
</tbody>
</table>

2.8.2 Configure the settings relating to the host authentication [Host auth.]

Click the [Host auth.] tab on the “User mng.” page. (→page 38, page 39)

The restriction settings of PCs (IP address) from accessing the camera can be configured on this page.
[Host auth.]
Select “On” or “Off” to determine whether or not to authenticate the host.
- **Default:** Off

**IMPORTANT**
- Set “Host auth.” to “On” after registering the IP address of the PC.
- If “On” is selected for “User auth.”, the user authentication is required regardless of the host authentication settings.

[IP address]
Enter the IP address of the PC to be allowed to access the camera. Host name cannot be entered for the IP address.

**Note**
- When “IP address/subnet mask” is entered, it is possible to restrict PCs in each subnet. For example, when “192.168.0.1/24” is entered and “2. Camera control” is selected for the access level, the PCs whose IP address is between “192.168.0.1” - “192.168.0.254” can access the camera with the access level “2. Camera control”.
- When the IP address already in use is entered and the [Set] button is clicked, the respective host information will be overwritten.
- A “Set address” error message is displayed if the IP address of the PC has not been set properly. Check the set IP address of the PC again.

[Access level]
Select the access level of the host from the following.
1. Administrator/ 2. Camera control/ 3. Live only
Refer to page 137 for further information about the access level.
- **Default:** 3. Live only

[Host check]
From the pull-down menu of “Host check”, the registered host can be selected and the selected host’s IP address can be checked.
The registered IP address will be displayed with the access level.
(Example: 192.168.0.21 [1])
To delete the registered host, click the [Delete] button after selecting the IP address to be deleted.

### 2.8.3 Configure IEEE 802.1X [IEEE 802.1X]
Click the [IEEE 802.1X] tab on the “User mng.” page. (➔For menu display and how to operate, refer to page 38, page 39)
The settings relating to IEEE 802.1X can be configured on this page.
This function can be used when making secure network environments using authentication LAN switches. For further information about authentication LAN switches, consult with your network administrator. Because the
procedure changes according to [EAP method], configure using the following procedure. If “On” is selected for [IEEE 802.1X], start configuring settings with “Off” selected for [IEEE 802.1X].

IEEE 802.1X
Select “On” or “Off” to determine whether or not to perform port authentication using IEEE 802.1X.
• Default: Off

User name
Enter the user name to access the authentication LAN switch.
• Available number of characters: 1 - 32 characters
• Unavailable characters: " & : ; \

Password
[Retype password]
Enter the password to access the authentication LAN switch.
• Available number of characters: 4 - 32 characters
• Unavailable characters: " &

CA Certificate - [Certificate install]
Install the root CA Certificate. Do not include the intermediate CA Certificate. Installation is possible only when “Off” is selected for “IEEE 802.1X”.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data format</td>
<td>Format: PEM or DER</td>
<td>Extension: pem or der</td>
</tr>
<tr>
<td>Item</td>
<td>Specifications</td>
<td>Remarks</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------</td>
<td>---------</td>
</tr>
<tr>
<td>Max. number of certificates included in the PEM format</td>
<td>1 pc.</td>
<td>—</td>
</tr>
<tr>
<td>Max. size of certificate</td>
<td>Approx. 10 Kbyte</td>
<td>—</td>
</tr>
</tbody>
</table>

**[CA Certificate] - [Information]**

*not installed*: indicates that the certificate is not installed.

*CA certificate host name*: indicates that the certificate is installed.

*Expired*: indicates that the certificate is expired.

The details of CA Certificate can be checked with the [Confirm] button.

**Note**

- Check that the CA certificate has not expired. If you use a certificate that have expired, you may not be able to connect to authentication LAN switches.

**[Private key or Client Certificate including private key] - [Installation]**

Install the private key or Client Certificate that includes private key.

Installation is possible only when “Off” is selected for “IEEE 802.1X”.

### Specification of private key and Client Certificate including private key

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data format</td>
<td>Format: PEM or PFX</td>
<td>Extension: pem or pfx</td>
</tr>
<tr>
<td>Key size [bit]</td>
<td>1024 /1536 /2048 /3072 /4096</td>
<td>—</td>
</tr>
<tr>
<td>Max. number of certificates included in the PEM format</td>
<td>6 pc.</td>
<td>—</td>
</tr>
<tr>
<td>Max. size of certificate (including intermediate CA Certificate)</td>
<td>Approx. 10 Kbyte</td>
<td>—</td>
</tr>
</tbody>
</table>

**[Private key or Client Certificate including private key] - [Password]**

Enter the password if the private key is encrypted or the password is set for Client Certificate for the PFX method. Leave password blank when not encrypted.

*Available number of characters*: 0 - 30 characters

**[Private key or Client Certificate including private key] - [Install status of private key]**

*not installed*: Private key is not installed.

*installed*: Private key is installed.

**[Client Certificate] - [Installation]**

Install the Client Certificate.

If signed by the intermediate CA Certificate, install the Client Certificate including the intermediate CA Certificate.

Installation is possible only when “Off” is selected for “IEEE 802.1X”.

### Specification of Client Certificate

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data format</td>
<td>Format: PEM</td>
<td>Extension: pem</td>
</tr>
<tr>
<td>Max. number of certificates included in the PEM format</td>
<td>6 pc.</td>
<td>—</td>
</tr>
<tr>
<td>Item</td>
<td>Specifications</td>
<td>Remarks</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td>Max. size of certificate (including intermediate CA Certificate)</td>
<td>Approx. 10 Kbyte</td>
<td>—</td>
</tr>
</tbody>
</table>

[Client Certificate] - [Information]

- **not installed**: indicates that the certificate is not installed.
- **Certificate host name**: indicates that the certificate is installed.
- **Expired**: indicates that the certificate is expired.

The details of Client Certificate can be checked with the [Confirm] button.

**Note**
- Check that the client certificate has not expired. If you use a certificate that has expired, you may not be able to connect to authentication LAN switches.

[EAP method]
Select the authentication method from EAP-MD5, EAP-PEAP or EAP-TLS.

**EAP-MD5/EAP-PEAP**
1. Select “On” for “IEEE 802.1X”.
2. Select “EAP-MD5” or “EAP-PEAP” for “EAP method”.
3. Click the [Set] button after entering the user name, the password, and confirming the password.

**EAP-TLS**
1. Click the [Browse] button of “CA Certificate” - “Certificate install”. Then, select a CA Certificate and click the [Execute] button. The host name (CommonName) specified when creating certificates will be displayed for “Information”.
2. Click the [Browse] button of “Private key or Client Certificate including private key”, and select a private key or Client Certificate that includes Private key.
3. Enter the password if the private key is encrypted or the password is set for Client Certificate for the PFX method. Leave password blank when not encrypted.
4. Click the [Execute] button to start installation.
   “installed” will be displayed for “Install status of private key”.
   In the case of selecting Client Certificate including the private key, “installed” will be displayed for “Client Certificate” - “Information” as well.
5. When the private key is installed in step 2, select a Client Certificate after clicking the [Browse] button of “Client Certificate”, and then click the [Execute] button. The host name (CommonName) specified when creating certificates will be displayed for “Information”.
6. Select “On” for “IEEE 802.1X”. Then, select “EAP-TLS” for “EAP method”.
7. Enter the user name registered to the server in “User name”. Then, click the [Set] button.
   If no user name is registered to the server, enter an arbitrary user name.
   “Password” and “Retype password” can be left blank.

**Note**
- To delete each certificate, set [IEEE 802.1X] to “Off”.
- Check that the CA certificate and client certificate have not expired. If you use certificates that have expired, you may not be able to use the port notification feature.
Example of CA Certificate check screen

Example of Client Certificate check screen

IMPORTANT

- After selecting “On” for “IEEE 802.1X”, if access to the camera fails for some reason, connect to a switch or port without authentication. It disables IEEE 802.1X, and enables access to the camera.
- If the Client Certificate includes intermediate CA Certificate, the Client Certificate needs to come first, then the intermediate CA Certificate.
- When a certificate over 10 Kbyte is installed, no error will be displayed during installation. However, an error may occur at the time of connection.

2.8.4 Configure the data encryption settings [Data encryption]

Click [Data encryption] on the “User mng.” page. (→For menu display and how to operate, refer to page 38, page 39)

The settings relating to the data encryption can be configured in this section.

Click the “+” mark on the left of the setup menu to expand the respective item, and enable detailed settings.

Click the “−” mark on the left of an expanded item to return to the screen displayed before the item was expanded.
[Data encryption (Batch change)]
Select “On” or “Off” to determine whether or not to activate data encryption.
- **On:** Activates data encryption. Encrypts Stream(1), Stream(2), JPEG(1), JPEG(2), JPEG(3), and “AAC-LC” audio.
- **Off:** Deactivates data encryption.
- **Default:** Off

[Stream(1)], [Stream(2)], [JPEG(1)], [JPEG(2)], [JPEG(3)]
Select “On” or “Off” independently for Stream(1), Stream(2), JPEG(1), JPEG(2), and JPEG(3) to determine whether or not to activate data encryption.
- **Default:** Off

[Encryption password], [Retype encryption password]
Set the password for data encryption.
- **Available number of characters:** 4 - 16 characters
- **Unavailable characters:** " &

**IMPORTANT**
- The initial password is displayed in “MAC address” on the [Upgrade] screen of the [Maintenance] tab. When using data encryption, make sure to change the password.
- When “On” is selected for data encryption, it is recommended to set the total bit rate of the stream becomes 16 Mbps or less.
- When “On” is selected for JPEG data encryption, the snap shot button on the “Live” page will be hidden.
- When “On” is selected for JPEG data encryption, images cannot be monitored using a cellular phone/mobile terminal. Additionally, the [Refresh interval] pull-down on the “Live” page is not displayed for JPEG with data encryption set to “On”.
- The encrypted MP4 files and JPEG images cannot be viewed on the image playing screen in the browser. Download it to a PC and use the decryption tool to confirm it. For information about the decryption tool, refer to the “readme.txt” file in the supplied CD-ROM or our website (https://security.panasonic.com/support/info/ <Control No.: C0310>).
- When “On” is selected for JPEG data encryption, “Refresh interval: 1s” to “Refresh interval: 60s” in the [Refresh interval] pull-down menu on the multi-screen become unselectable.
- When “On” is selected for data encryption, “16 Screens” in the “Layout” pull-down menu on the multi-screen becomes unselectable.
- If you set data encryption to “On”, “Stream(3)” and “Stream(4)” become “Off”.
- When the image capture mode is “3 mega pixel [4:3](30fps mode)” and data encryption is “On”, “2048x1536”, “JPEG” or stream cannot be selected.

**Note**
- In order to view streams with data encryption set to “On”, you must install the viewer software.
- If you confirm streams with data encryption set to “On” on the “Live” page, password entry for decryption is displayed. If you correctly enter the “Encryption password” that was set, you will be able to view images. When “Mic input” is selected for [Audio transmission mode], only audio may be played until the password is entered.

- Streams that have data encryption enabled for them are wrapped in < > in the [Live view] pull-down menu. Additionally, streams that have data encryption enabled for them are enclosed within <Encrypted> in the setup menu pull-down menu.
Example: When Stream 1 and JPEG(3) are data encrypted

- [Live view] pull-down menu on the “Live” page

- Pull-down menu in the setup menu

- When [Data encryption (Batch change)] is “On”, “AAC-LC” audio is data encrypted (“G.726” and “G.711” are not data encrypted). To encrypt both the image and audio, set [Data encryption (Batch change)] to “On” and set [Audio input encoding format] to “AAC-LC”.
- For encrypted MP4 files and JPEG images, you can use the decryption tool to confirm the images.
2.9 Configuring the network settings [Network]

The network settings can be configured on the “Network” page. The “Network” page has the [Network] tab and the [Advanced] tab.

2.9.1 Configure the network settings [Network]

Click the [Network] tab on the “Network” page. (→page 38, page 39)
The following information is required to configure the network settings. Contact the network administrator or your Internet service provider.
- IP address
- Subnet mask
- Default gateway (when using the gateway server/router)
- HTTP port
- Primary DNS address, Secondary DNS address (when using DNS)
IPv4 network

[Network Settings]
Select the method of how to configure the IP address from the following.

- **Static:** The IP address is configured by entering manually on “IP address(IPv4)”.
- **DHCP:** The IP address is configured using the DHCP function.
- **Auto(AutoIP):** The IP address is configured using the DHCP function. When the DHCP server is not found, the IP address is automatically configured.
- **Auto(Advanced):** Using the DHCP function, network address information is referred to, and an unused IP address is configured to the camera as a static IP address. The configured IP address is automatically determined within the subnet mask range by the camera. When the DHCP server is not found, the IP address is set to 192.168.0.10.
- **Default:** Auto(Advanced)

**Note**
- When “Auto(AutoIP)” is selected and the IP address cannot be obtained from the DHCP server, an IP address not used in the same network will be searched within 169.254.1.0 - 169.254.254.255.

[IP address(IPv4)]
When not using the DHCP function, enter the IP address of the camera. Do not enter an IP address already in use (for the PCs and the other network cameras).
- **Default:** 192.168.0.10

**Note**
- Multiple IP addresses are unavailable even when using the DHCP function. Refer to the network administrator for further information about the settings of the DHCP server.

[Subnet mask]
When not using the DHCP function, enter the subnet mask of the camera.
- **Default:** 255.255.255.0

[Default gateway]
When not using the DHCP function, enter the default gateway of the camera.
- **Default:** 192.168.0.1

**Note**
- Multiple IP addresses for the default gateway are unavailable even when using the DHCP function. Refer to the network administrator for further information about the settings of the DHCP server.

[DNS]
Determine how to set the address of the DNS server by selecting “Auto” (obtain the address automatically) or “Manual” (enter the address of the DNS server). When “Manual” is selected, it is necessary to configure the settings for the DNS.
When using the DHCP function, it is possible to obtain the DNS address automatically by selecting “Auto”. Refer to the network administrator for further information about the settings.
- **Default:** Auto

[Primary server address], [Secondary server address]
When “Manual” is selected for “DNS”, enter the IP address of the DNS server. Refer to the network administrator about the IP address of the DNS server.
IPv6 network

[Manual]
Select “On” or “Off” to determine whether or not to manually configure the IP address for IPv6 network (IPv6 address).
- **On:** Enter an IPv6 address manually.
- **Off:** Manual entry of an IPv6 address will become unavailable.
- **Default:** Off

[IP address(IPv6)]
When “On” is selected for “Manual”, manual entry of the IPv6 address is required. Do not enter an address already in use.

**Note**
- When connecting to the manually configured IPv6 address beyond the router, use an IPv6 compatible router and turn on the automatic IPv6 address assignment function. In this case, it is necessary to configure IPv6 address including prefix information provided from the IPv6 compatible router. Refer to the manuals provided with the router for further information.

[Default gateway]
When “On” is selected for “Manual” of IPv6 network, enter the default gateway of IPv6 network of the camera.
- **Default:** None (blank)

[DHCPv6]
Select “On” or “Off” to determine whether or not to use the IPv6 DHCP function.
Configure the DHCP server not to assign the same IP addresses used for the other network cameras and PCs whose IP address is unique. Refer to the network administrator for further information about the settings of the server.
- **Default:** Off

[Primary DNS server address], [Secondary DNS server address]
Enter the IPv6 address of the DNS server. Refer to the network administrator about the IPv6 address of the DNS server.

Common

[HTTP port]
Assign the port numbers independently.
- **Available port number:** 1 - 65535
- **Default:** 80
The following port numbers are unavailable since they are already in use.
20, 21, 23, 25, 42, 53, 67, 68, 69, 110, 123, 161, 162, 443, 554, 995, 10669, 10670, 59000 - 61000

[Line speed]
Select the line speed for data transmission from the following. It is recommended to use with the default “Auto”.
- **Auto:** Line speed will be applied automatically.
- **100M-Full:** 100 Mbps full-duplex
- **100M-Half:** 100 Mbps half-duplex
- **10M-Full:** 10 Mbps full-duplex
- **10M-Half:** 10 Mbps half-duplex
- **Default:** Auto
[Max RTP packet size]
Select “Unlimited(1500byte)” or “Limited(1280byte)” to determine whether or not to restrict the RTP packet size when viewing images from the camera using the RTP protocol. It is recommended to use with the default “Unlimited(1500byte)”. When the RTP packet size is restricted in the network line in use, select “Limited(1280byte)”. Refer to the network administrator for further information about the maximum packet size in the network line.
- Default: Unlimited(1500byte)

[HTTP max segment size(MSS)]
Select “Unlimited(1460byte)”, “Limited(1280byte)”, or “Limited(1024byte)” to determine whether or not to restrict the maximum segment size (MSS) when viewing images from the camera using the HTTP protocol. We recommended that you use this feature with the default setting. When the MSS is restricted in the network line in use, select “Limited(1024byte)” or “Limited(1280byte)”. Refer to the network administrator for further information about the MSS in the network line.
- Default: Unlimited(1460byte)

[Bandwidth control(bit rate)]
Select the total bit rate for data transmission from the following.
Unlimited/ 64kbps/ 128kbps/ 256kbps/ 384kbps/ 512kbps/ 768kbps/ 1024kbps/ 2048kbps/ 4096kbps/ 6144kbps/ 8192kbps/ 10240 kbps/ 15360 kbps/ 20480 kbps/ 25600 kbps/ 30720kbps/ 35840kbps/ 40960 kbps/ 51200kbps
- Default: 51200kbps

Note
- When selecting “64kbps”, select “Off” for “Audio transmission mode” on the [Audio] tab. (→page 115)
- Select “128kbps” or a faster rate to carry out the live transmission of JPEG images and the FTP periodic image transmission simultaneously.
- When “Bandwidth control(bit rate)” is set low, taking a picture using the snap shot button may not function depending on the usage environment. In this case, select “JPEG” on the “Live” page and take a picture with the snap shot button using the lowest possible image capture size.

[Easy IP Setup accommodate period]
Select “20min” or “Unlimited” to determine how long the network setting operation using the Panasonic “IP Setting Software” can be allowed.
- 20min: The network setting operation using the Panasonic “IP Setting Software” are allowed for 20 minutes since the camera starts up.
- Unlimited: The network setting operation using the Panasonic “IP Setting Software” are allowed without time limitation.
- Default: 20min

Note
- The camera information display using the Panasonic “IP Setting Software” is allowed without time limitation, and camera images can be opened.
- Refer to the network administrator for the addresses of each server.
- The port forwarding function changes a global IP address to a private IP address, and “Static IP masquerade” and “Network Address Translation (NAT)” have this function. This function is to be set in a router.
To access the camera via the Internet by connecting the camera to a router, it is necessary to assign a respective HTTP port number for each camera and address translation by using the port forwarding function of the router. For further information, refer to the operating instructions of the router in use.

[FTP access to camera]
Select “Allow” or “Forbid” to determine whether to allow or forbid the FTP access to camera.
- Default: Forbid

IMPORTANT
- If you allow FTP access to the camera, there is a possibility that authentication information (user names, passwords, etc.) will be leaked when accessing the camera from a PC.

2.9.2 Configure advanced network settings [Advanced]
Click the [Advanced] tab on the “Network” page. (→page 38, page 39)
The settings related to SMTP (E-mail), FTP, NTP, UPnP, HTTPS, DDNS, SNMP, QoS can be configured in this section.
You can move to the setting page of a setting item by clicking the corresponding link for that setting item.
2.9.2.1 Configure the settings related to sending E-mails

[E-mail notification]
Select “On” or “Off” to determine whether or not to provide notification by E-mail according to the settings for the “Alarm” and “Diag.” checkboxes of “Destination of notification” below.
- When an alarm is detected (“Alarm”)
- When a notification of the remaining capacity of the SD memory card has been provided (“Diag.”)
- When the SD memory card has become full (“Diag.”)
- When the SD memory card cannot be recognized (“Diag.”)

• Default: Off
[Alarm image attachment]
Select “On” or “Off” to determine whether or not to attach an image to the E-mail to be sent when an alarm is detected.
- Default: Off

[Image capture size]
Select the image capture size of images attached to an alarm E-mail from the following.
JPEG(1)/JPEG(2)/JPEG(3)
- Default: JPEG(2)

[SMTP server address]
Enter the IP address or the host name of the SMTP server used to send E-mails.
- Available number of characters: 1 - 128 characters
- Available characters: Alphanumeric characters, the colon (:), the period (.), the underscore (_), and the hyphen (-).

[SMTP port]
Enter the port number to which E-mails are sent.
- Available port number: 1-65535
- Default: 25
The following port numbers are unavailable since they are already in use.
20, 21, 23, 42, 53, 67, 68, 69, 80, 110, 123, 161, 162, 443, 995, 10669, 10670

[POP server address]
When “POP before SMTP” is selected for “Type”, enter the IP address or the host name of the POP server.
- Available number of characters: 1 - 128 characters
- Available characters: Alphanumeric characters, the colon (:), the period (.), the underscore (_), and the hyphen (-).

IMPORTANT
- When entering the host name for “SMTP server address” or “POP server address”, it is necessary to configure the DNS settings on the [Network] tab of the “Network” page. (→page 148)

[Authentication]
- Type
  Select the authentication method to send E-mails from the following.
  - None: It is not necessary to clear any authentication to send E-mails.
  - POP before SMTP: It is necessary to first clear the POP server authentication to use the SMTP server to send E-mails.
  - SMTP: It is necessary to clear the SMTP server authentication to send E-mails.
  - Default: None

Note
- When you don’t know the authentication method to send E-mails, refer to the network administrator.

- User name
  Enter the user name to access the server.
  - Available number of characters: 0 - 32 characters
  - Unavailable characters: " & ; \n
- Password
  Enter the password to access the server.
  - Available number of characters: 0 - 32 characters
  - Unavailable characters: " &
[Sender’s E-mail address]
Enter the E-mail address of a sender.
The entered E-mail address will be displayed in the “From” (sender) line of the sent E-mails.
- **Available number of characters**: 3 - 128 characters
- **Available characters**: Alphanumeric characters, the at sign (@), the period (.), the underscore (_), and the hyphen (-).

[SSL]
Select “On” if you want to use SSL encryption when sending E-mail notifications for alarm occurrences or the “Diag.” function. When you select “On”, the authentication method will be set to “SMTP”. Set the user name and the password used for authentication.
- **Default**: Off

**Note**
- Some SMTP servers may not support SSL.
- SSL supports SMTP over SSL, but STARTTLS is not supported.
- When “On” is selected, the SMTP port number may need to be set to 465. Ask your Internet service provider for the appropriate settings.

[Address 1] - [Address 4]
Enter the destination E-mail address. Up to 4 destination E-mail addresses can be registered.
- **Available number of characters**: 3 - 128 characters
- **Available characters**: Alphanumeric characters, the at sign (@), the period (.), the underscore (_), and the hyphen (-).
  
  To delete the registered address, click the [Delete] button respective to the desired address.
- **VMD**: Notify by e-mail when motion is detected.
- **Audio detection**: Notify by e-mail when audio is detected.
- **Command alarm**: Notify by e-mail when a command alarm is entered.
- **Diag.**:
  - When a notification of the remaining capacity of SD memory card has been provided
  - When the SD memory card has become full
  - When the SD memory card cannot be recognized

**Note**
- In the diagnostic e-mail notification sent when you have checked the destination of notification [Diag.] field, the contents of the [E-mail subject] and [E-mail body] which are set later are not changed.

[E-mail subject]
Enter the E-mail subject.
- **Available number of characters**: 0 - 50 characters
- **Use the camera title**: The camera title will be displayed in the e-mail subject.
- **Cause of alarm**: Adds the cause of alarm to the E-mail subject.

[E-mail body]
Enter the E-mail body.
- **Available number of characters**: 0 - 200 characters
- **Cause of alarm**: The cause of alarm %p% is added in the e-mail body. %p% is replaced by the cause of alarm and sent.
  - For VMD alarm: “VMD”
  - For Audio detection alarm: “Audio detection”
  - For command alarm: “CMD”
**Occurrence time:** The time of occurrence %t% will be added to the e-mail body. %t% will be replaced by the time of occurrence of the alarm (HH:MM:SS) and sent.

**Default:**
- Cause of alarm: Checked
- Occurrence time: Checked
- E-mail body: The %p% alarm was occurred at %t%.

**Note**
- Notification E-mail will be sent with the message “The capacity of the SD memory card is full.” when the SD memory card has become full, or “The SD memory card cannot be detected.” when mounting of the SD memory card failed.
- Entering alternative text into the E-mail body automatically adds the event or time when an alarm occurs.
  Alternative text cause of alarm: %p%, occurrence time: %t%
  (Examples of use)
  After setting the following characters in the E-mail body, there is a VMD alarm occurrence at the time 19:13:24.
  E-mail body settings: %p% alarm occurred at %t%.
  Sent E-mail body: “A “VMD” alarm occurred at 19:13:24.”
  When the body of the email is empty, the language that the email is sent in is determined by “Menu language” of “Basic”. If “Japanese” is specified, email is sent in Japanese. If another language is specified, email is sent in English.

**Example of e-mail notification**
An e-mail format in which the camera title check box is specified in the e-mail subject and the cause of alarm/occurrence time are specified in the e-mail body

Example e-mail:

1. Subject: XXXXX
2. E-mail body:
   A “VMD” alarm occurred at 19:13:24

- The alarm occurrence time is assigned.
- The camera title is used as the e-mail subject.
- The alarm cause is assigned.
2.9.2.2 Configure the settings related to FTP transmission

FTP

[Alarm image FTP transmission]
Select “On” or “Off” to determine whether or not to transmit the alarm image to the FTP server.
- Default: Off

[Directory name]
Enter the directory name where the alarm images are to be saved.
For example, enter “/ALARM” to designate the directory “ALARM” under the root directory of the FTP server.
- Available number of characters: 1 - 256 characters
- Unavailable characters: " & ;
[File name]
Enter the file name used for the alarm image to be transmitted to an FTP server. The file name will be as follows.
File name: [“Entered file name” + “Time and date (year/month/day/hour/minute/second)”] + “Serial number”
- Available number of characters: 1 - 32 characters
- Unavailable characters: " & * / : ; < > ? \ |
- VMD: Transmit the image to the FTP server when motion is detected.
- Audio detection: Transmit the image to the FTP server when audio is detected.
- Command alarm: Transmit the image to the FTP server when a command alarm is entered.

[FTP transmission retry]
Select “On” or “Off” to determine whether or not to resend failed FTP transmissions.
- On: If transmission fails, transmissions are resent until they are successfully sent.
- Off: If transmission fails, the image that failed to be sent is discarded and the next image is sent.
- Default: Off

[Pre alarm]
- Transmission interval
  Select the update interval of images before an alarm occurs from the following.
  0.1fps/ 0.2fps/ 0.33fps/ 0.5fps/ 1fps
  - Default: 1fps
- Maximum number of images
  Select the number of images to be transmitted from the following.
  0 pic/ 1pic/ 2pics/ 3pics/ 4pics/ 5pics/ 6pics*/ 7pics*/ 8pics*/ 9pics*/ 10pics*/ 20pics*/ 30pics*/ 40pics*/ 50pics*
  - Default: 0 pic
- Recording duration
  The recording duration, which changes according to the configured “Transmission interval” and “Maximum number of images”, of images recorded before an alarm occurs is displayed.

Note
- When “JPEG(1)” is selected for the capture size of the image to be transmitted, pre alarm is unavailable if the image capture size of “JPEG(1)” is either “2048x1536” or “1920x1080”.
- When “On” is selected for “Image compression rate upon alarm detection”, only post alarm recorded images are compressed. Compression is not applied to pre alarm recorded images.
- When a selection with an asterisk (*) on the right of it is selected for “Maximum number of images” of “Pre alarm”, the specified number of images may not be able to be sent depending on the image capture size and image quality. The following table shows the maximum number of images that can be sent for pre alarm.

<table>
<thead>
<tr>
<th>Image quality (0-9)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 1 2 3 4 5 6 7 8 9</td>
</tr>
</tbody>
</table>
[Post alarm]
- **Transmission interval**
  Select the transmission interval for the alarm image transmission to the FTP server from the following.
  0.1fps/ 0.2fps/ 0.33fps/ 0.5fps/ 1fps
  - **Default:** 1fps
- **Number of images**
  Select the number of images to be transmitted from the following.
  1pic/ 2pics/ 3pics/ 4pics/ 5pics/ 6pics/ 7pics/ 8pics/ 9pics/ 10pics/ 20pics/ 30pics/ 50pics/ 100pics/ 200pics/ 300pics/ 500pics/ 1000pics/ 1500pics/ 2000pics/ 3000pics
  - **Default:** 100pics
- **Recording duration**
  Approximate time to be taken to save the set “Number of images” with the set “Transmission interval” will be displayed.

[Image capture size]
Select the image capture size of images transmitted when an alarm occurs from the following.
JPEG(1)/JPEG(2)/JPEG(3)
- **Default:** JPEG(2)

**FTP periodic image transmission**

**[FTP periodic image transmission]**
Select “On” or “Off” to determine whether or not to transmit images using the FTP periodic image transmission function.
When “On” is selected, it is necessary to configure the settings of the FTP server.
- **Default:** Off

**IMPORTANT**
- When using FTP periodic image transmission, it is necessary to configure the schedule settings of FTP periodic image transmission on the [Schedule] tab of the “Schedule” page. (→page 193)

**[Directory name]**
Enter the directory name where the images are to be saved.
For example, enter “/img” to designate the directory “img” under the root directory of the FTP server.
- **Available number of characters:** 1 - 256 characters
- **Unavailable characters:** " &
- **Default:** None (blank)
[File name]
Enter the file name (name of the image file to be transmitted) and select the naming option from the following.

- **Name w/time&date**: File name will be [“Entered file name” + “Time and date (year/ month/ day/ hour/ minute/ second)” + “Serial number (starting from 00)”].
- **Name w/o time&date**: File name will be the characters entered for “File name” only. When “Name w/o time&date” is selected, the file will be overwritten each time a file is newly transmitted.

- **Available number of characters**: 1 - 32 characters
- **Unavailable characters**: " & ; : / * < > ? \\ | 
- **Default**: None (blank)

**Note**
- When “Name w/time&date” is selected, the file name will be [“Entered file name” + “Time and date (year/ month/ day/ hour/ minute/ second)” + “Serial number (starting from 00)”] + “s” during summer time.

[Transmission interval]
Select the interval for the FTP periodic image transmission from the following.

1s/ 2s/ 3s/ 4s/ 5s/ 6s/ 10s/ 15s/ 20s/ 30s/ 1min/ 2min/ 3min/ 4min/ 5min/ 6min/ 10min/ 15min/ 20min/ 30min/ 1h/ 1.5h/ 2h/ 3h/ 4h/ 6h/ 12h/ 24h

- **Default**: 1s

[Image capture size]
Select the image capture size of images to be transmitted from the following.

JPEG(1)/JPEG(2)/JPEG(3)

- **Default**: JPEG(2)

[FTP server address]
Enter the IP address or the host name of the FTP server.

- **Available number of characters**: 1 - 128 characters
- **Available characters**: Alphanumeric characters, the colon (:), the period (.), the underscore (_), and the hyphen (-).

**IMPORTANT**
- When entering the host name for “FTP server address”, it is necessary to configure the DNS settings on the [Network] tab of the “Network” page. (→page 148)
- When the FTP client function is enabled, there is a possibility that FTP server authentication information (user names, passwords, etc.) will be leaked on the network when sending images to the FTP server.

[User name]
Enter the user name (login name) to access the FTP server.

- **Available number of characters**: 1 - 32 characters
- **Unavailable characters**: " & ; \ 

[Password]
Enter the password to access the FTP server.

- **Available number of characters**: 0 - 32 characters
- **Unavailable characters**: " &

[Control port]
Enter a control port number to be used for the FTP server.

- **Available port number**: 1-65535
- **Default**: 21

The following port numbers are unavailable since they are already in use.
[FTP mode]
Select “Passive” or “Active” for the FTP mode. Normally, select “Passive”. When it is impossible to connect after select “Passive”, try to connect after selecting “Active”.
• Default: Passive

2.9.2.3 Configure the settings relating to the NTP server

The settings relating to the NTP server such as the NTP server address, port number, etc. can be configured on this page.

IMPORTANT
• Use an NTP server when the more accurate time & date setting is required for the system operation.

[Time adjustment]
Select the time adjustment method from the following. Time adjusted by the selected method will be used as the standard time of the camera.
• Manual: Time set on the [Basic] tab on the “Basic” page will be used as the standard time of the camera.
• Synchronization with NTP server: Time automatically adjusted by synchronizing with the NTP server will be used as the standard time of the camera.
• Default: Manual

[NTP server address setting]
When “Synchronization with NTP server” is selected for “Time adjustment”, select the method of how to obtain the NTP server address from the following.
• Auto: Obtains the NTP server address from the DHCP server.
• Manual: The NTP server address will be entered manually on “NTP server address”.
• Default: Manual

IMPORTANT
• When obtaining the NTP server address from the DHCP server, it is necessary to select “DHCP”, “Auto(AutoIP)”, or “Auto(Advanced)” for “Network Settings” on the [Network] tab of the “Network” page. (→page 148)
[NTP server address]
When “Manual” is selected for “NTP server address setting”, enter the IP address or the host name of the NTP server.
- Available number of characters: 1 - 128 characters
- Available characters: Alphanumeric characters, the colon (:), the period (.), the underscore (_), and the hyphen (-).
- Default: None (blank)

IMPORTANT
- When entering the host name for “NTP server address”, it is necessary to configure the DNS settings on the [Network] tab of the “Network” page. (→page 148)

[NTP port]
Enter a port number of the NTP server.
- Available port number: 1 - 65535
- Default: 123

The following port numbers are unavailable since they are already in use.
20, 21, 23, 25, 42, 53, 67, 68, 69, 80, 110, 161, 162, 443, 995, 10669, 10670

[Time adjustment interval]
Select an interval (1 - 24 hours: in 1 hour intervals) of synchronization with the NTP server.
- Default: 1h

2.9.2.4 Configure the UPnP settings
This camera support UPnP (Universal Plug and Play). By using the UPnP function, it becomes possible to configure the following automatically.
- Configuration of the port forwarding function of the router (However, a router supporting UPnP is required.)
  This configuration is useful when accessing the camera via the Internet, or from a cellular phone/mobile terminal.
- Automatic refreshment of the shortcut to the camera that is created on the [Network] folder of the PC even when the IP address of the camera changes.

[Auto port forwarding]
Select “On” or “Off” to determine whether or not to use the port forwarding function of the router.
To use the port forwarding function, the router in use must support UPnP and the UPnP must be enabled.
- Default: Off

Note
- Due to port forwarding, the port number may sometimes be changed. When the number is changed, it is necessary to change the port numbers registered in the PC and recorders, etc.
• The UPnP function is available when the camera is connected to the IPv4 network. IPv6 is not supported.
• To check if auto port forwarding is properly configured, click the [Status] tab on the “Maintenance” page, and check that the “Enable” is displayed for “Status” of “UPnP”. (→ page 202) When “Enable” is not displayed, refer to “Cannot access the camera via the Internet.” in the “3.3 Troubleshooting” section. (→ page 220)

[Camera short cut]
Select whether or not to create the shortcut to the camera on the [Network] folder of the PC. When creating the shortcut, select “On”. To use the shortcut function to the camera, enable the UPnP function on the PC in advance.
• Default: Off

Note
• To display the shortcut to the camera on the [Network] folder of the PC, it is necessary to add the Windows component. Refer to the following to enable the UPnP function.

For Windows 7
[Start] → [Control Panel] → [Network and Internet] → [Network and Sharing Center] → select [Turn on network discovery] of [Network discovery] of [Change advanced sharing settings] → click [Save changes] → Complete

For Windows 8.1
Right-click [Start] → select [Control Panel] → [Network and Internet] → [Network and Sharing Center] → select [Turn on network discovery] of [Network discovery] of [Change advanced sharing settings] → click [Save changes] → Complete

For Windows 10
[Start] → [Settings] → [NETWORK & INTERNET] → [Ethernet] → [Network and Sharing Center] → select [Turn on network discovery] of [Network discovery] of [Change advanced sharing settings] → click [Save changes] → Complete
2.9.2.5 Configure the HTTPS settings

It is possible to enhance the network security by encrypting the access to cameras using the HTTPS function. Refer to page 170 for how to configure the HTTPS settings.

[HTTPS - Connection]
Select the protocol used to connect the camera.
• HTTP: HTTP and HTTPS connections are available.
• HTTPS: Only the HTTPS connection is available.
• Default: HTTP

Note
• To change to an HTTPS connection when HTTP is selected, perform HTTPS connection settings first. The HTTPS connection will be available even if the setting is changed to HTTP afterwards.

[HTTPS - Select certificate]
Select the certificate to be used with HTTPS.
• Pre-installed: Select a pre-installed certificate.
• CA: Select a CA certificate. Only displayed when the CA Certificate is installed.
• Default: Pre-installed

[HTTPS - HTTPS port]
Designate the HTTPS port number to be used.
• Available port number: 1 - 65535
• Default: 443
The following port numbers are unavailable since they are already in use.
20, 21, 23, 25, 42, 53, 67, 68, 69, 80, 110, 123, 161, 162, 554, 995, 10669, 10670, 59000-61000
**[Pre-installed certificate - Download root certificate]**
Click the [Execute] button to download the root certificate for the pre-installed certificate. By installing the root certificate to your PC, you can get signature verification for the pre-installed certificate.

**[CRT key generate]**
CRT key (SSL encryption key) used for the HTTPS protocol is generated. To generate the CRT key, click the [Execute] button to display “CRT key generate” dialog box.

**[CA Certificate - Generate Certificate Signing Request]**
When using the CA certificate issued by CA (Certificate Authority) as the CA certificate used for the HTTPS protocol, the CSR (Certificate Signing Request) will be generated. To generate the CSR, click the [Execute] button to display the “CA Certificate - Generate Certificate Signing Request” dialog window.

**[CA Certificate - CA Certificate install]**
Installs the CA certificate issued by CA (Certificate Authority) and displays the information of the installed CA certificate. To install the CA certificate, click the [Browse...] button to display the [Open] dialog box, and select the file of the CA certificate issued by CA, and click the [Execute] button. If the CA certificate is already installed, the file name of the installed CA certificate will be displayed.

**[CA Certificate - Information]**
Displays the information of the CA certificate. When the [Confirm] button is clicked, the registered information of the installed CA certificate will be displayed in the “CA Certificate - Confirm” dialog box. If the CA certificate is not installed, the content of the generated CSR file will be displayed. When the [Delete] button is clicked, the installed CA certificate will be deleted.

**IMPORTANT**
- Before deleting the valid CA certificate, confirm that there is a backup file of the CA certificate on the PC or another media. The backup file of the CA certificate will be required when installing the CA certificate again.

**Note**
- After changing the connection setting, access the camera again by after waiting a while according to the changed setting (“http://IP address of the camera” or “https://IP address of the camera”).
- When the camera is accessed using the HTTPS protocol, the refresh interval and frame rate of images may be lower.
- When the camera is accessed using the HTTPS protocol, it may take time to display images.
- When the camera is accessed using the HTTPS protocol, the images may be distorted or audio may be interrupted.
- The maximum number of concurrent access user varies depending on the maximum image size and transmission format.

### 2.9.2.6 Configure the settings relating to DDNS
To access this camera via the Internet, it is necessary to configure the settings for the DDNS function.
Refer to page 187 for how to configure the settings relating to DDNS.

[Area]
Select the region where the camera is installed.
Japan/Global

Note
• If the camera is used in Japan, select “Japan”. If the camera is used outside of Japan, select “Global”. The “Viewnetcam.com” service that is displayed when “Global” is selected cannot be used in Japan.

[Service]
Select the DDNS service to determine whether or not to use DDNS.
• Off: Does not use the DDNS function.
• Viewnetcam.com: Uses the “Viewnetcam.com” service.
• Dynamic DNS Update: Uses Dynamic DNS Update (RFC2136 compliant) without the DHCP cooperation.
• Dynamic DNS Update (DHCP): Uses Dynamic DNS Update (RFC2136 compliant) with the DHCP cooperation.
• Default: Off

Note
• When using Dynamic DNS Update (RFC2136 compliant), refer to the network administrator for whether or not to cooperate with the DHCP.
2.9.2.7 Configure the settings relating to SNMP

The settings relating to SNMP can be configured on this page. It is possible to check the status of the camera by connecting to the SNMP manager. When using the SNMP function, contact the network administrator.

![SNMP settings interface](image)

**[SNMP version]**
Select the SNMP version to be used.
- **SNMPv1/v2**: SNMPv1/v2 is activated.
- **SNMPv3**: SNMPv3 is activated.
- **SNMPv1/v2/v3**: SNMPv1/v2/v3 is activated.
- **Default**: SNMPv1/v2

**[SNMPv1/v2] - [Community]**
Enter the community name to be monitored.
- **Available number of characters**: 0 - 32 characters
- **Default**: None (blank)

**IMPORTANT**
- When using the SNMP function, it is necessary to enter the community name. When no community name is entered, the SNMP function will not work.

**[SNMPv3] - [User name]**
Set the SNMPv3 user name.
- **Available number of characters**: Empty field or 1 - 32 characters
- **Unavailable characters**: " ; 

**[SNMPv3] - [Authentication]**
Select the SNMPv3 authentication method from MD5 or SHA1.
- **Default**: MD5

**[SNMPv3] - [Encryption method]**
Select the SNMPv3 encryption method from DES or AES.
- **Default**: DES
[SNMPv3] - [Password]
Set the SNMPv3 password.
• **Available number of characters:**
  • If the authentication method is MD5: Empty field or 8 - 16 characters
  • If the authentication method is SHA1: Empty field or 8 - 20 characters
• **Unavailable characters:** " &

[System name]
Enter a system name to be used to manage the camera with the SNMP function.
• **Available number of characters:** 0 - 32 characters
• **Default:** None (blank)

[Location]
Enter the name of the location where the camera is installed.
• **Available number of characters:** 0 - 32 characters
• **Default:** None (blank)

[Contact]
Enter the E-mail address or the phone number of the SNMP manager.
• **Available number of characters:** 0 - 255 characters
• **Default:** None (blank)

2.9.2.8 Configure the QoS settings
The settings relating to the Diffserv function and shaping of stream are configured in this section.

**Diffserv**
The Diffserv function can be used to set the priority of image/audio data sent from routers. The priority set to this function must match the DSCP value configured to the router. When using the Diffserv function, contact the network administrator.

**[Image DSCP(0-63)]**
Enter the packet priority for video data.
• **Available values:** 0 - 63
• **Default:** 0
[Audio DSCP(0-63)]
Enter the packet priority for audio transmission/reception.
• **Available values:** 0 - 63
• **Default:** 0

[Panasonic alarm protocol notification DSCP(0-63)]
Enter the packet priority for Panasonic alarm protocol notification.
• **Available values:** 0 - 63
• **Default:** 0

**Shaping of stream**

[Shaping of stream]
Select On/Off to determine whether or not to control the H.265 (or H.264) image data so that it does not burst. It is effective in situations such as when a network device loses video data from the camera, but the video display may be delayed.
• **Off:** Disables the shaping of stream function.
• **On:** Enables the shaping of stream function.
• **Default:** Off

**Note**
• If you are concerned about delays of the video display, select Off.
2.9.3 How to configure HTTPS settings

The settings relating to the HTTPS protocol that can enhance the network security by encrypting the access to cameras on this page.

HTTPS settings can be configured by either using the certificate pre-installed to the camera, or using a CA certificate that you obtained by yourself from the CA (CA: Certification Authority). The settings will be configured in the following procedure.

<table>
<thead>
<tr>
<th>When using a pre-installed certificate:</th>
<th>When using a CA certificate:</th>
</tr>
</thead>
<tbody>
<tr>
<td>When a pre-installed certificate is selected</td>
<td>When a CA certificate is selected</td>
</tr>
<tr>
<td>Generate CSR (Certificate Signing Request) (→page 76)</td>
<td>Apply for the approval and the issue of CA certificate by CA (→page 76)</td>
</tr>
<tr>
<td>Obtain the root certificate (→page 171)</td>
<td>Install the CA certificate (→page 180)</td>
</tr>
<tr>
<td>Configure HTTPS connections (→page 177)</td>
<td></td>
</tr>
<tr>
<td>Access a camera using HTTPS</td>
<td>Access a camera using HTTPS</td>
</tr>
<tr>
<td>When a pre-installed certificate is selected (→page 181)</td>
<td>When a CA certificate is selected (→page 186)</td>
</tr>
</tbody>
</table>
### 2.9.3.1 Select the certificate to use when accessing with HTTPS

Select the certificate to be used with HTTPS with [HTTPS – Select certificate].

- **When using a pre-installed certificate**: Select “Pre-installed”.
  - When “Pre-installed” is selected, a root certificate (page 171) must be obtained.
- **When using a CA certificate**: Select “CA”.

**Note**

- “CA” can only be selected when a CA certificate has been added. Refer to page 170 for information on how to add a CA certificate.

### 2.9.3.2 Obtaining the root certificate

This procedure only needs to be done once for each PC that accesses the camera.
1. Access the camera, and click the [Execute] button for “Pre-installed certificate - Download root certificate” under “HTTPS” in the [Advanced] tab in the settings menu of the “Network” page. Click “Open” displayed on the bottom of the browser.
2. Click “Install Certificate...”.

3. Click “Next” displayed in “Certificate Import Wizard”.
4. Select “Place all certificates in the following store”, and click “Browse...”.

5. Select “Trusted Root Certificate Authorities”, and click “OK”.

![Certificate Import Wizard](image1.png)

![Select Certificate Store](image2.png)
6. Click “Next”.

7. Click “Finish”.

8. Confirm that the content shown next to “Thumbprint” in the “Security warning” window is as follows and then click “Yes”.
   - Thumbprint (sha1): 0B886A3C E7F2DBA8 1035DDFA 2B21F80B 06778932
Note

- Other parties cannot create another thumbprint with the same values. You can confirm that you have retrieved the correct root certificate from the specified camera by confirming the values of the thumbprint.

When the import is successfully completed, the screen “The import was successful.” will be displayed.

9. Click the [OK] button.
10. Click the [OK] button in the “Certificate” window to close the window.

2.9.3.3 Configuration of HTTPS connections

1. Select “HTTPS” to access the camera in [HTTPS – Connection].
2. Designate the HTTPS port number to be used for [HTTPS – HTTPS port].
   • **Available port number**: 1 - 65535
   • **Default**: 443
   The following port numbers are unavailable since they are already in use.
   20, 21, 23, 25, 42, 53, 67, 68, 69, 80, 110, 123, 161, 162, 554, 995, 10669, 10670, 59000 - 61000
3. Click the [Set] button.
   → It will become possible to access to the cameras using the HTTPS protocol.
   Restart the browser and access again.
   Refer to the following for information on methods to access cameras using HTTPS.
   • **Monitor images on a PC**: page 9
   • **Monitor images on a cellular phone**: page 18
   • **Monitor images on a mobile terminal**: page 19
4. If “Certificate error” is displayed, refer to the following.
   • **When using a pre-installed certificate**: page 171
   • **When using a CA certificate**: page 186

**Note**
• When the connection setting is changed, after waiting for a while, access the camera again with either “http://IP address of the camera” or “https://IP address of the camera” depending on the changed setting.
- **When using the pre-installed certificate:**
  In advance, install the root certificate of the Pre-installed certificate on the PC in use. Refer to page 171 for information on the setting procedure.
- When the camera is accessed using the HTTPS protocol, the refresh interval and frame rate of images may be lower.
- When the camera is accessed using the HTTPS protocol, it may take time to display images.
- When the camera is accessed using the HTTPS protocol, the images may be distorted or audio may be interrupted.
- The maximum number of concurrent access user varies depending on the maximum image size and transmission format.

### 2.9.3.4 Generation of the CRT key (SSL encryption key)

**IMPORTANT**

- When the CA certificate is valid, it is impossible to generate the CRT key.
- When the CA certificate is used, the available key size varies depending on the CA. Confirm the available key size in advance.
- To generate the CRT key, it may take about 2 minutes. Do not operate the web browser until the generation of CRT key is complete. While the CRT key is being generated, the refresh interval and line speed may be lower.

1. Click the [Execute] button of “CRT key generate”.
   → The “CRT key generate” dialog box will be displayed.

![CRT key generate dialog box](image)

2. Click the [Execute] button.
   → The generation of CRT key will be started. When the generation is finished, the key size and generation time & date of the generated key will be displayed on “Current CRT key”.

**Note**

- To change (or update) the generated CRT key, perform step 1 to 2. The CRT key and CA certificate are valid in a set. When the CRT key is changed, it is necessary to re-apply for the CA certificate.
- When the CRT key is updated, the log of the previous CRT key is saved. When the [History] button of “Current CRT key” on the “CRT key generate” dialog box is clicked, the “Previous CRT key” dialog box will be displayed, and it is possible to check the key size and generation time & date of the previous
key. When the [Apply] button is clicked on the “Previous CRT key” dialog box, it is possible to replace the current CRT key with the previous one.

2.9.3.5 Generation of CSR (Certificate Signing Request)

**IMPORTANT**
- If the CRT key is not generated, it is impossible to generate the CSR.
- Before generating the CSR file, configure the following settings on [Internet Options] of the web browser in advance. Click [Internet Options...] under [Tools] of the menu bar of Internet Explorer, and then click the [Security] tab.
  - Register the camera for [Trusted Sites].
  - Click the [Custom level...] button to open the [Security Settings] window, and check the [Enable] radio button of [File Download] under [Downloads].
  - Click the [Custom level...] button to open the [Security Settings] window, and check the [Enable] radio button of [Automatic prompting for file downloads] under [Downloads].

1. Click the [Execute] button of “CA Certificate - Generate Certificate Signing Request”.
   → The “CA Certificate - Generate Certificate Signing Request” dialog box will be displayed.

2. Enter the information of the certificate to be generated.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Available number of characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Common Name]</td>
<td>Enter the camera address or host name.</td>
<td>64 characters</td>
</tr>
<tr>
<td>[Country]</td>
<td>Enter the country name.</td>
<td>2 characters (Country code)</td>
</tr>
</tbody>
</table>
### Item Description Available number of characters

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Available number of characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>[State]</td>
<td>Enter the state name.</td>
<td>128 characters</td>
</tr>
<tr>
<td>[Locality]</td>
<td>Enter the locality name.</td>
<td>128 characters</td>
</tr>
<tr>
<td>[Organization]</td>
<td>Enter the organization name.</td>
<td>64 characters</td>
</tr>
<tr>
<td>[Organizational Unit]</td>
<td>Enter the unit name of the organization.</td>
<td>64 characters</td>
</tr>
<tr>
<td>[CRT key]</td>
<td>Displays the key size and generation time &amp; date of the current key.</td>
<td>—</td>
</tr>
</tbody>
</table>

**Note**
- To use the CA certificate, follow the requests from the CA about the information to be entered.
- The available characters for [Common Name], [State], [Locality], [Organization], [Organizational Unit] are 0-9, A-Z, a-z and the following marks.
  - , . _ , + / ( )

3. Click the [OK] button after entering the items.
   → The [Save As] dialog box will be displayed.
4. Enter a file name for the CSR in the [Save As] dialog box to save on the PC.
   → The saved CSR file will be applied to the CA.

**IMPORTANT**
- The CA certificate will be issued for the set of the generated CSR and CRT key. If the CRT key is re-generated or updated after applying to the CA, the issued CA certificate will be invalidated.

**Note**
- This camera generates the CSR file in the PEM format.

### 2.9.3.6 Installation of the CA certificate**

**IMPORTANT**
- If the CSR file is not generated, it is impossible to install the CA certificate.
- For the installation of the CA certificate, the CA certificate issued by CA is required.

1. Click the [Browse...] button of “CA Certificate - CA Certificate install”.
   → The [Open] dialog box will be displayed.
2. Select the CA certificate file and click the [Open] button. Then, click the [Execute] button.
   → The CA certificate will be installed.

**Note**
- The host name registered in the installed CA certificate will be displayed on “CA Certificate - Information”. Depending on the status of the CA certificate, the following are displayed.

<table>
<thead>
<tr>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid</td>
<td>The CA certificate is not installed.</td>
</tr>
<tr>
<td>[CA certificate Host name]</td>
<td>The CA certificate has already been installed and validated.</td>
</tr>
</tbody>
</table>
### Indication | Description
---|---
Expired | The CA certificate has already expired.

- When the [Confirm] button is clicked, the registered information of the CA certificate will be displayed in the “CA Certificate - Confirm” dialog box. (Only “Organizational Unit” will be displayed with an asterisk (*).)

- When the [Delete] button is clicked, the installed CA certificate will be deleted.
- When “HTTPS” is selected for “Connection”, it is impossible to delete the CA certificate.
- To update the CA certificate, perform step 1 and 2.

**IMPORTANT**
- Before deleting the valid CA certificate, confirm that there is a backup file of the CA certificate on the PC or another media. The backup file of the CA certificate will be required when installing the CA certificate again.
- When the CA certificate has expired, the HTTPS function will become unavailable. When the camera is restarted, the connection protocol will be changed to HTTP. Update the CA certificate before it expires.
- The expiration date of the CA certificate can be checked by double-clicking the CA certificate file issued by CA.

### 2.9.4 Access the camera using the HTTPS protocol (for pre-installed certificate)

When accessing the camera with HTTPS from a browser using the pre-installed certificate, in order to stop a warning message from being played, you must configure your PC by following the steps below. Explanations are based on procedures for Windows 7 using Internet Explorer 11. Procedures for other operating systems or browsers may differ.

#### 2.9.4.1 Configuration of the host file

This procedure must be done on each PC for all the camera that are accessed.

**Note**
- The following procedure cannot be used if you are using DDNS.

1. Start the browser and then access the camera using the HTTPS protocol.
2. When the security alert window is displayed, click “Continue to this website (not recommended).”

The “Live” page will be displayed. If an authentication window is displayed, enter the user name and password.

**Note**
- This warning is displayed because the text entered in the address box does not match the text displayed in the subject of the certificate. This type of warning is displayed because when the certificate for the pre-installed certificate is created, the IP address or domain name assigned to the camera has not been determined yet. However, because the certificate configured in “2.9.3.2 Obtaining the root certificate” (→ page 171) is only issued for Panasonic products, this is not a problem.

3. Click “Certificate error” over the URL, and click “View certificates” on the bottom of the “Mismatched Address” window.
**Note**
- If “Certificate Invalid” is displayed as shown below even though you have installed the root certificate (→page 171), end the connection, and check that no suspicious devices are connected.

![Certificate Invalid](image)

4. The “Certificate” window is displayed. Select the “Details” tab.
5. Confirm <All> that is displayed for “Show” and then click “Subject” in the field. Copy the text shown after “CN=” in the lower box.
6. From the Start menu enter the following text in the “Search programs and files” text box and then press [Ctrl], [Shift], and [Enter] at the same time.
notepad C:\Windows\System32\drivers\etc\hosts

7. If the “User Account Control” window is displayed, select “Yes”.

8. The “hosts - Notepad” window is opened. Add the following text to the end of the file.
(camera IP address) (copied text from step 5)
The example is when the IP address is “192.168.0.10” and the CN of the camera is “WV–xxxxxx.0000-0100-450D-0022.panasonic-security-system.net”.

9. Select “File” → “Save” to save the file and then close the file.
2 Settings

10. When accessing with a browser, add the following text for the CN after entering “https://” in the “address” box.

![Image of browser address bar]

**IMPORTANT**

- When the HTTPS port number is changed from “443”, enter “the following text for CN + : (colon) + port number” in the address box of the browser.
  Example of when the port number is “61443”:
  https://WV-xxxxxx.0000-0100-450D-0022.panasonic-security-system.net:61443
- We recommend adding the camera's URL to your browser's bookmark. If you forget the camera's URL, refer to the hosts file.

11. When the settings are completed, the color of the background of the address box changes to white. Confirm that “Website Identification” is displayed after clicking the key mark on the right side of the address bar.

![Image of browser address bar]

**Note**

- If you cannot access with this method it may be because of proxy server settings. Ask the network administrator.

**IMPORTANT**

- When the camera is accessed using the HTTPS protocol, the refresh interval and frame rate of images may be lower.

2.9.5 Access the camera using the HTTPS protocol (for CA Certification)

1. Start up the web browser.
2. Enter the IP address of the camera in the address box of the browser.
   - **Example of entry**: https://192.168.0.10/
2.9.6 How to configure the settings relating to DDNS

When activating the DDNS function using the camera, either of the following DDNS services is available.

- "Viewnetcam.com" service
- Dynamic DNS Update (RFC2136 compliant)

IMPORTANT

- Before using the DDNS service, it is necessary to perform the port forwarding setting for the router.
- About Dynamic DNS Update (RFC2136 compliant)
  Operation using DDNS services other than the "Viewnetcam.com" service is not guaranteed. We are not responsible for any troubles or accidents on the circumstances where the camera is used arising out of such services.
  Refer to the DDNS service providers for the selection and configuration of the DDNS services other than the "Viewnetcam.com" service.

Note

- "Viewnetcam.com" is a Dynamic DNS service designed for use with Panasonic Network Cameras. Refer to the “Viewnetcam.com” website (http://www.viewnetcam.com/) for further information about the service.

About DDNS services (IPv4/IPv6)

By using a DDNS service, it becomes possible to view camera images via the Internet. The DDNS service associates dynamic global addresses and domain names.

It is possible to configure the settings for the “Viewnetcam.com” or Dynamic DNS Update (RFC2136 compliant). In most of the DNS services offered by providers, global addresses are not static but dynamic. Therefore, access to the camera via an old global address may be invalidated after a certain period of time. Either of the following services is required when accessing a camera whose global address is not static via the Internet.

- **DDNS service (such as “Viewnetcam.com”)**
  It is possible to access via a registered and static domain name (example: *****.viewnetcam.com) even after the global address is changed. Enrollment in a domain name service is required even when using the IPv6 connection.
  Refer to the “Viewnetcam.com” website (http://www.viewnetcam.com/) for further information about the service.

- **Static IP address service (such as a service offered by a contracted provider)**
  In this service, global addresses are static (not changed).
Configuration of the DDNS service (Example of the “Viewnetcam.com” service)

A. DNS server
B. Internet
C. Provider
D. “Viewnetcam.com” service server
E. Remote site

1. **Global address is changed.**
   The contracted provider allocates a global address to the router (or the camera). The global address is not static but dynamic.

2. **“*****.viewnetcam.com” and the current global address is automatically registered.**
   If you are enrolled in “Viewnetcam.com”, the unique “domain name” (example: *****.viewnetcam.com) will be allocated. The “Viewnetcam.com” service server automatically manages the domain name of camera and the global address of router (or camera) when a camera automatically notifies the service server of the global address.

3. **Current global address is automatically registered via “*****.viewnetcam.com”**.
   The “Viewnetcam.com” service server registers the global address and the domain name of router (or camera) in the DNS server.

4. **Global address is obtained via the URL (domain name).**
   By entering the URL (including the domain name) on the web browser when accessing the camera via the Internet, the DNS server identifies the registered global address of router (or camera).

5. **Access using the current global address**
   The identified global address is used for accessing the router (or camera) to monitor images.

**Note**
- Refer to the contracted provider whether the current IP address is static or not.
- Depending on the provider, local addresses may be allocated. In this case, the DDNS service is unavailable. Refer to the contract provider for further information.
2.9.6.1 When using the “Viewnetcam.com” service

[Personal(Camera) URL]
The URL of the camera registered for “Viewnetcam.com”.

[Your Account Link]
When the displayed URL is clicked, the registration window for the “Viewnetcam.com” service will be displayed in a newly opened window.
Register the information in the registration window to enroll in the “Viewnetcam.com” service.

[Access interval]
Select the interval to access the “Viewnetcam.com” service server to check the IP address and the host name from the following.
10min/ 20min/ 30min/ 40min/ 50min/ 1h
• Default: 1h

[Global IP Address Notification Method]
Typically [Global IP Address Notification Method] should be set to “Normal”.
If you cannot access the camera using the registered URL 30 minutes after registering with “Viewnetcam.com”, select “Advanced”.
In this case, UPnP (→page 162) must be enabled for the camera and for the router.
• Default: Normal

Procedure to register information for the “Viewnetcam.com” service

1. Select [Viewnetcam.com] for [Service] and click the [Set] button.
   → A URL is displayed in [Your Account Link].
   If a URL is not displayed in [Your Account Link], confirm the camera's network settings and Internet connection, then click [Set] again.
2. Register the information for “Viewnetcam.com” by following the instructions of the wizard.
   → The registration window for “Viewnetcam.com” will be displayed in a newly opened window.
When the registration window is not displayed, check that the PC is being connected to the Internet, and click the reload button of the browser.

3. Register the information for “Viewnetcam.com” by following the instructions of the wizard.
   → When the message “The new camera is successfully registered to Viewnetcam.com” is displayed, close the registration window.
   The URL set at the time of registration can be used for camera access. However, this URL is unavailable when accessing the camera from the PC connected to the same network (LAN).

Note
- When the registration for the “Viewnetcam.com” service is completed, the URL registered for “Personal(Camera) URL” is displayed. It may take up to about 30 minutes until the URL of the registered camera is validated.
- To cancel the enrollment in the “Viewnetcam.com” service, access the “Viewnetcam.com” website (http://www.viewnetcam.com/) later.
- When “Expired” is displayed in the URL of “Viewnetcam.com” in the viewnetcam settings page or the status page, restart the camera after registering the “Viewnetcam.com” service. After restarting the camera, check that the registered URL is displayed in the URL of “Viewnetcam.com” of [Status] - [Viewnetcam.com] on the “Maintenance” page.
- It is possible to check the information registered for the “Viewnetcam.com” service by accessing the URL displayed beside “Your Account Link”. When the URL is not displayed, check that the PC is being connected to the Internet, and click the [Set] button.
• If access often fails due to the change in the global address of router, set a smaller value for “Access interval”.

Checking the information registered for the “Viewnetcam.com” service

It is possible to check if the camera has been registered for the “Viewnetcam.com” service. (→ page 202)

2.9.6.2 When using “Dynamic DNS Update”

![Dynamic DNS Update Settings](image)

[Host name]
Enter the host name to be used for the Dynamic DNS Update service.

- **Available number of characters**: 3 - 250 characters
  Enter in the form of “(host name). (domain name)”.
- **Available characters**: Alphanumeric characters, the colon (:), the period (.), the underscore (_), and the hyphen (-).
- **Default**: None (blank)

**Note**
- Refer to the network administrator for further information about the available host names.

[Access interval]
Select the interval to access the Dynamic DNS Update service server to check the IP address and the host name from the following.
10min/ 20min/ 30min/ 40min/ 50min/ 1h/ 6h/ 24h
- **Default**: 24h
2.9.6.3 When using “Dynamic DNS Update(DHCP)”

[Host name]
Enter the host name to be used for the Dynamic DNS Update service.
- **Available number of characters**: 3 - 250 characters
  Enter in the form of “(host name). (domain name)”.
- **Available characters**: Alphanumeric characters, the colon (:), the period (.), the underscore (_), and the hyphen (-).
- **Default**: None (blank)

**Note**
- Refer to the network administrator for further information about the available host names.
2.10 Configure the settings relating to the schedules

On the “Schedule” page, it is possible to configure the settings relating to schedules as follows.

- VMD permission
- Audio detection permission
- Access permission
- SD memory recording
- Scene file
- FTP periodic image transmission
- Allow e-mail transmission
- Reboot (Schedule 5 only)

The “Schedule” page has only the [Schedule] tab.
Up to 5 schedules can be set.

1. Select an action to be assigned to the schedule from “Schedule mode”. “Off” is selected at the default.
   - **Off**: No action will be taken for the respective schedule.
   - **VMD permission**: The video motion detection (VMD) function will be active during the period of the schedule. Schedule settings are not required when continuously using VMD.
   - **Audio detection permission**: The audio detection function will be active during the period of the schedule. Schedule settings are not required when continuously using audio detection.
   - **Access permission**: Users whose access level is set to “2. Camera control” and “3. Live only” on the [User auth.] tab (→page 137) can access the camera only in the period of schedule.
• **SD memory card 1:** The SD recording configured in “Recording stream 1” will be performed at the designated time in the schedule. Only available when a stream is selected in “Recording format”.

• **SD memory card 2:** The SD recording configured in “Recording stream 2” will be performed at the designated time in the schedule. Only available when a stream is selected in “Recording format”.

• **Image adjust 1: Scene 1:** Images are set to the image settings of “Scene file 1” at the designated time in the schedule. When the designated time for the schedule finishes, images are set to the image settings of “Scene file is not applied”.

• **Image adjust 1: Scene 2:** Images are set to the image settings of “Scene file 2” at the designated time in the schedule. When the designated time for the schedule finishes, images are set to the image settings of “Scene file is not applied”.

• **Image adjust 1: Scene 3:** Images are set to the image quality settings of “Scene file 3” at the designated time in the schedule. Once designated time in the schedule is over, the image quality setting is set to “Scene file is not applied”.

• **Image adjust 1: Scene 4:** Images are set to the image quality settings of “Scene file 4” at the designated time in the schedule. Once designated time in the schedule is over, the image quality setting is set to “Scene file is not applied”.

• **FTP periodic image transmission:** FTP periodic image transmission will be performed at the designated time in the schedule.

• **E-mail permission:** While the schedule is set, e-mail notification is sent when alarm is input.

• **Reboot:** The camera reboots at the scheduled time. Can only be selected with Schedule 5.

**Note**

• Select “On” for “User auth.” on the [User auth.] tab of “User mng.” page (→page 137) and “Off” for “Host auth.” on the “Host auth.” page (→page 140) to validate “Access permission”.

• When selecting “Recording to SD(Recording stream1)” or “Recording to SD(Recording stream2)”, select “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” for “Recording format” on the [SD memory card] tab and select “Schedule” for “Save trigger”. (→page 70)

2. Select days of a week by checking the respective checkboxes.
3. From the pull-down menu, select the start time and the end time of the schedule. When not designating time, check the checkbox of “24h”.
4. Click the [Set] button after completing the settings.

→ The result will be displayed at the bottom of the window.

**Note**

• The schedules displayed at the bottom of the window can be identified by colors assigned to each schedule.
2.10.1 How to set the schedules

1. Check the check box of the desired day of the week of “FTP image transmission schedule”. → The selected day of the week will be validated for the schedule.
2. To designate time, select the desired “hour” and “minute” from the pull-down menu. When not designating time, check the checkbox of “24h”.
3. Click the [Set] button after completing the settings. → The result will be displayed at the bottom of the window.
2.10.2 How to delete the set schedule

1. Uncheck the check box of the set day of the week.
2. Click the [Set] button after completing the settings. → The schedule of the selected day of the week is deleted.
2.11 Maintenance of the camera [Maintenance]

System log check, firmware upgrade, status check and initialization of the setup menu can be performed on this page.

The “Maintenance” page has the [System log] tab, the [Upgrade] tab, [Status] tab, the [Default reset] tab, and the [Data] tab.

### 2.11.1 Check the system log [System log]

Click the [System log] tab of the “Maintenance” page. (→page 38, page 39)

Up to 4,000 system logs can be saved on the SD memory card when the SD memory card is inserted after selecting “Use” for “SD memory card” on the [SD memory card] tab (→page 65).

When “Not use” is selected for “SD memory card”, up to 100 system logs can be saved on the built-in memory of the camera.

When the saved system logs have reached the maximum number, the newer logs will overwrite the older system logs. In this case, the oldest log is the first to be overwritten.

The system logs will be displayed in group of 100 logs each, and the logs will be saved even when the power of the camera is turned off.

![System log interface](image)

[<< Latest 100]
When clicking “<< Latest 100”, the latest 100 system logs will be displayed.

[Next 100 >>]
When clicking “Next 100 >>”, the next 100 system logs will be displayed.

[Number of pages display]
The currently opened page will be displayed in the “page/total page” format.

[<< Previous 100]
When clicking “<< Previous 100”, the previous 100 system logs will be displayed.

[No.]
The serial number of the system log will be displayed.

[Time & date]
Time and date at the error occurrence will be displayed.

**Note**
- When “Off” is selected for “Time display format” on the [Basic] tab (→page 58), time & date of logs will be displayed in 24-hour format.

[Description]
The descriptions about the system log will be displayed. Refer to page 215 for further information about the system logs.
2.11.2 Upgrade the firmware [Upgrade]

Click the [Upgrade] tab of the “Maintenance” page. (→page 38, page 39)
The current firmware can be checked and upgraded to the latest version on this page. Contact the dealer for further information about the firmware upgrade.

[Model no.], [MAC address], [Serial no.], [Firmware version], [IP address(IPv6)], [Viewer software installation counter], [Time past from the date of manufacture]

Information of each item will be displayed.

[Ext. software >>]
A link for the extension software screen is displayed.
Refer to our website (https://security.panasonic.com/support/info/ <Control No.:C0103>) for further information about extension software.

1. Contact the dealer and download the latest firmware onto a PC.

**IMPORTANT**
- A blank (space) cannot be used for the name of the directory where the downloaded firmware to be saved.
2 Settings

2. Click the [Browse...] button and designate the downloaded firmware.

   **Note**
   - The latest firmware upgrade is posted on our website.
     - When using the camera in Japan
       https://sol.panasonic.biz/security/support/index.html
     - When using the camera outside of Japan
       https://security.panasonic.com/support/
   - To view the website, it is necessary to be connected to the internet.

3. Click the radio button respective to the desired option to determine whether or not to initialize the settings after completing the firmware upgrade.
   **Default:** Do not reset the settings to the default after the upgrade.

   **Note**
   - Note that the settings cannot be restored after an initialization is operated.

4. Click the [Execute] button.
   → The confirmation window will be displayed.

**IMPORTANT**
- After upgrading, make sure to check the version on this page.
- After completing the upgrade, delete temporary internet files. (→page 220)
- Upgrade the firmware using a PC in the same subnet as the unit.
- Follow the instructions from the dealer when upgrading the firmware.
- When upgrading the application software, use the designated file (extension: img) for the firmware upgrade.
  The name of the firmware to be used for the upgrade should be “model name (Use small letters. “WV-” is not required._xxxxx.img”.
  * (“xxxxx” indicates the version of the firmware.)
- Do not turn off the power of the camera during the upgrade process.
- Do not perform any operation during upgrading and wait until it completes.
- The following network settings will not be reset when upgrading the firmware after selecting “Reset the settings to the default after completing the upgrade. (Except the network settings)”.
  Primary server address and secondary server address DNS settings for IPv4, primary DNS server address and secondary DNS server address settings for IPv6, On/Off for DHCP, IP address, subnet mask, default gateway, HTTP port, HTTPS port, connection protocol (HTTP/HTTPS), CRT key, CA certificate, UPnP setting, line speed, bandwidth control (bit rate), time & date, IEEE 802.1X setting.
- The viewer software used on each PC should be licensed individually. Refer to your dealer for the software licensing.

2.11.3 Check the status [Status]

   Click the [Status] tab of the “Maintenance” page. (→page 38, page 39)
The status of this camera can be checked on this page.

**Viewnetcam.com**

**[Server]**
The URL of the “Viewnetcam.com” service server will be displayed.

**[Status]**
The registration status for the “Viewnetcam.com” will be displayed.

**[Personal(Camera) URL]**
The URL of the camera registered for “Viewnetcam.com” will be displayed.

**UPnP**

**[Port number(HTTP), Port number(HTTPS)]**
The port number that is set for UPnP port forwarding will be displayed.

**[Status]**
The port forwarding status will be displayed.
2 Settings

[Router global address]
The global address of router will be displayed.

Self check
The self check result of the hardware will be displayed.

Note
• Refer to our website (https://security.panasonic.com/support/info/ <Control No.:C0111>) for further information about the contents of the displayed statuses (relating to the “Viewnetcam.com” service, the UPnP function, or the self check).

SD memory card

[Model no.]
Displays the model number of the SD memory card.
If model number information could not be obtained, “Read error” is displayed. If the SD memory card is not used, “Not use” is displayed. In other cases “Unknown” is displayed.

[Serial no.]
Displays the serial number of the SD memory card.
If the serial number information could not be obtained, “Unknown” is displayed.

[Remaining capacity]
Displays the remaining capacity and total capacity of the SD memory card.
This is the same information that is displayed in [Remaining capacity] of the SD memory card information on the [SD memory card] tab of the “Basic” page.

[Total use time]
Displays the length of time that SD memory card has been inserted into and used with the camera.
If the length of time that the SD memory card has been used for cannot be obtained, “Unknown” is displayed.
“Total use time” is updated once per hour.

[Number of overwrite times]
Displays the number of overwrite times as calculated from the total capacity of the SD memory card, the number of times the camera has written files to the SD memory card, and the file sizes.
If the number of overwrite times cannot be calculated, “Unknown” is displayed.

Note
• Because the overwrite time values are just estimates calculated by the camera, they may differ to the actual number of overwrite times.

[No.] / [Time & date] / [Description] of the log
Displays the log related to the SD memory card.
### Category | Indication | Description
--- | --- | ---
SD memory card | <SD> Format | Successfully formatted the SD memory card.
 | <SD> Format error | Error occurred when formatting the SD memory card.
 | <SD> Detection error | The SD memory card could not be correctly recognized.
 | <SD> Write error | An error occurred when writing to the SD memory card.
 | <SD> Read error | An error occurred when reading from the SD memory card.
 | <SD> Delete error | An error occurred when deleting data from the SD memory card.
 | <SD> File system error | An error occurred in File system of the SD memory card.
 | <SD> Undefined error | An error other that the ones above has occurred for the SD memory card.

**IMPORTANT**
- In order to be able to correctly use this function, format the SD memory card with the camera before using it.
- When using SD memory cards that have been used on other devices such as PCs, the correct information may not be able to be displayed.
- Up to 30 SD memory card logs can be saved to the built-in memory of the camera. When the saved system logs have reached the maximum number, the newer logs will overwrite the older system logs.

**Note**
- Refer to our website (https://security.panasonic.com/support/info/) for further information about the contents of the displayed statuses (relating to the “Viewnetcam.com” service, the UPnP function, or the self check).

### 2.11.4 Reset the settings/Reboot the camera [Default reset]

Click the [Default reset] tab of the “Maintenance” page. (→page 38, page 39)
The settings and the HTML data of the camera can be initialized and reboot of the camera can be performed on this page.

**[Reset to the default (Except the network settings)]**
Click the [Execute] button to reset the settings to the default. Note that the network settings will not be reset.
It is impossible to operate the camera for about 3 minutes after the initialization.
[Load the default HTML files (setup menu).]
Click the [Execute] button to reset the HTML files to the default.
It is impossible to operate the camera for about 3 minutes after the initialization.

[Reset to the default and load the default HTML files.]
Click the [Execute] button to reset the settings of the camera and the HTML files to the default. Note that the network settings will not be reset.
It is impossible to operate the camera for about 3 minutes after the initialization.

[Reboot]
Click the [Execute] button to reboot the camera. It is impossible to operate the camera for about 2 minutes after rebooting the camera.

Note
- Refer to the Important Information in the supplied CD-ROM for more information about initializing the network settings (page 148).
- If “Diag.” of the alarm or e-mail notification function is selected, a notification of error will be sent to “Destination E-mail address” or to “Destination of notification” when an error such as no SD memory card insertion after the reboot occurs. (→page 153, page 132)

2.11.5 Settings data/backing up or restoring logs [Data]
Click the [Data] tab of the “Maintenance” page. (→page 38, page 39)
The settings related to backing up or restoring settings data, and saving logs can be configured in this section.

Backup
[Setup data]
Click the [Execute] button to backup the setup data of the camera to a PC.
[Scene file]
Click the [Execute] button to backup the scene files of the camera to a PC.

[Logs]
Click the [Execute] button to backup the log data of the camera to a PC.

**IMPORTANT**
- When backing up settings or logs, creating the backup files takes time.
- When the backup operation takes 10 minutes or more, a communication timeout may occur. In this case all of the backup data may not be obtained. Therefore, we recommend completing backup operations within 10 minutes. It is also possible to check whether or not the correct data was obtained by restoring the obtained data (excluding log data).

**Restore**

[Setup data]
Press the [Browse...] button and select the setup data files to restore.
Click the radio button respective to the desired option to determine whether or not to also restore network related setting contents.
Click the [Execute] button to start restoring. Do not perform operations until the restoration is complete. (The camera will be rebooted when the restoration is complete.)
Make sure to set the file name of setup data files used when restoring to “model name.dat”. (The model name must be written in lower case letters and “WV-” is not needed.)

**IMPORTANT**
- When 5 minutes or more is required to restore setup data files, there is a possibility that the restore will fail because or reasons such as transmission disconnections. In this case, restore setup data files again.

**Note**
- Restore operations for setup data are not applied to HTTPS related settings.

[Scene file]
Press the [Browse...] button and select the scene files to restore.
Click the [Execute] button to start restoring. Do not perform operations until the restoration is complete.
Make sure to set the file name of scene file data used when restoring to “model name.txt”. (The model name must be written in lower case letters and “WV-” is not needed.)
2.12 Display the Panasonic support website

Methods for accessing the Panasonic support website are explained on the “Support” page.

To access the Panasonic support website from a web browser, click the link for the support page.
To access from a cellular phone/mobile terminal, scan the “Data Matrix” or “QR Code” with your cellular phone/mobile terminal to display the Panasonic support website.
If you cannot display the website, access the Panasonic website (https://security.panasonic.com/support/qr_sp_select/).
3 Others

3.1 Using the CD-ROM

3.1.1 About the CD launcher

By inserting the provided CD-ROM into the CD-ROM drive of your PC, the CD launcher is automatically started and the license agreement is displayed. Read the agreement and select "I accept the terms in the license agreement", and then click "OK". The CD launcher window is displayed.

• If the launcher window is not displayed, double click the “CDLauncher.exe” file on the CD-ROM.

Using the supplied CD-ROM, the following actions can be performed.

1. The Panasonic “IP Setting Software” can be installed on the PC. (→page 210)
2. Settings related to the camera’s network can be set from the Panasonic “IP Setting Software”. (→page 212)
3. The manuals can be installed on the PC. (→page 211)
4. You can also view the manuals without installing them to the PC by clicking the [Open] button.
5. The Viewer software can be installed on the PC. (→page 211)
3.1.2 Installing Panasonic “IP Setting Software”

On the CD launcher window, click the [Install] button next to [IP Setting Software] to display the Panasonic “IP Setting Software” installation window. Confirm the following settings before starting the installation.

![IP Setting Software installation window]

- Select the Panasonic “IP Setting Software” to install.
- Select where to create the Panasonic IP setting shortcut icon when the Panasonic “IP Setting Software” is installed.
- Specify which folder on the PC to install the Panasonic “IP Setting Software” to.
- Click the [Install] button to start the installation.

**Note**
- To uninstall the Panasonic “IP Setting Software” delete the shortcut icon from where you specified it to be installed (the default is on the desktop) during installation and the [EasyIPConfig] folder from the folder (the default is C:\Panasonic) you specified during installation.
3.1.3 Installing the manuals

On the CD launcher window, click the [Install] button next to [Manual] to display the Manual installation window. Confirm the following settings before starting the installation.

1. Select which manuals to install. The camera models that the manuals support are displayed in 2 “Model List”.
2. The camera models that are supported by the manuals selected in 1 are displayed here.
3. Select where to create the manuals shortcut icon when the manuals are installed.
4. Specify which folder on the PC to install the manuals to.
5. Click the [Install] button to start the installation.

Note
• To uninstall the manuals delete the shortcut icon from where you specified it to be installed (the default is on the desktop) during installation and the [Manual] folder from the folder (the default is C: \Panasonic) you specified during installation.

3.1.4 Installing the Viewer software

In order to display H.265 (or H.264) images, receive audio from the camera, and display logs or play images saved on the SD memory card, the “Network Camera View 4S” (ActiveX®) viewer software must be installed. On the CD launcher window, click the [Install] button next to [Viewer Software], and follow the instructions displayed on the window to install the software. A message is displayed if a PC that does not have the Viewer software installed tries to access the camera. Install the software by following the instructions displayed on the window. Refer to page 4 for further information.

Note
• To uninstall the Viewer software, follow the steps below depending on the OS used on your PC. Delete [Network Camera View 4S] from [Control Panel] - [Programs] - [Uninstall a program].
3.1.5 Configure the network settings of the camera using the Panasonic “IP Setting Software”

It is possible to perform the network settings of the camera using the “IP Setting Software” on the provided CD-ROM. When using multiple cameras, it is necessary to configure the network settings of each camera independently. If the Panasonic “IP Setting Software” does not work, access the “Network” page from the setup menu of the camera in the browser and perform settings separately. (→page 148)

**IMPORTANT**
- The “Windows Security Alert” window may be displayed when starting the “IP Setting Software”. In this case, disable “User Account Control” from the control panel.
- Panasonic “IP Setting Software” is inoperable in other subnets via the same router.
- This camera cannot be displayed or set with an older version of the “IP Setting Software” (version 2.xx).
- Due to security enhancements in “IP Setting Software”, “Network Settings” of the camera to be configured cannot be changed when around 20 minutes have passed after turning on the power of the camera. (When the effective period is set to “20min” in the “Easy IP Setup accommodate period”.) However, settings can be changed after 20 minutes for cameras in the initial set mode.

1. To start the Panasonic “IP Setting Software”, click the [Run] button next to [IP Setting Software] from the CD launcher menu window, or double-click on the shortcut icon created after installing the software on the PC.
   - The License Agreement will be displayed. Read the Agreement and choose “I accept the terms in the license agreement”, and click [OK].
   - The “IP Setting Software” screen is displayed. If a camera is found, information about it, such as the MAC address and IP address, is displayed.

2. Click the [Access Camera] button after selecting the MAC address/IP address of the camera to be configured.

![Panasonic: IP Setting Software](image)

**Note**
- When using a DHCP server, the IP address assigned to the camera can be displayed by clicking the [Search] button of the “IP Setting Software”.
- When duplicate IP addresses are used, the number of the camera with the duplicate address is displayed in overlap.
- The displayed camera information is not automatically updated. Click the [Search] button to update the information.
- It is possible to change the “Camera list” display between IPv4 addresses and IPv6 addresses in accordance with the protocol in use.
3. When the viewer software “Network Camera View 4S” installation screen is displayed, follow the on-screen instructions to install the software. (The viewer software “Network Camera View 4S” is installed from the camera.)
   - The “Live” page of the camera is displayed.
   - If the viewer software “Network Camera View 4S” cannot be installed or images are not displayed, click the [Install] button next to [Viewer Software] from the CD launcher window to install the software.

### Changing Network Settings

When changing settings related to the network settings, such as connection mode, IP address, and subnet mask, click the [Network Settings] button in the [IP Setting Software] screen. The “Network Settings” screen is displayed. Enter each item and then click the [Save] button.

![Network Settings](image)

**Network Settings**

- **Network Settings**
  - Static IP
  - DHCP

- **Port No.**
  - 60

- **IPv4 Address**
  - 192.168.0.10

- **Subnet Mask**
  - 255.255.255.0

- **Default Gateway**
  - 192.168.0.1

- **DNS**
  - Auto

- **Primary DNS**
  - 0.0.0.0

- **Secondary DNS**
  - 0.0.0.0

- **Wait for camera restarting.**

**Note**

- By unchecking the “Wait for camera restarting.” checkbox, multiple cameras can be continuously configured.
- For further information about each setting of the “Network Settings” page, refer to page 148.

**IMPORTANT**

- It may take for around 2 minutes to complete to upload the settings to the camera after clicking the [Save] button. The settings may be invalidated when the LAN cable is disconnected before completing the upload. In this case, perform the settings again.
• When using a firewall (including software), allow access to all UDP ports.
### 3.2 About the displayed system log

#### Error indications relating to SMTP

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>POP3 server error</td>
<td>Authentication error.</td>
<td>• Entered user name or password may be incorrect. Check if the E-mail settings are configured correctly.</td>
</tr>
<tr>
<td></td>
<td>Failed to find the POP3 server.</td>
<td>• The IP address of the server may be incorrect. Check if the IP address of the server is configured correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The POP3 server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td>SMTP server error</td>
<td>Authentication error.</td>
<td>• Entered user name or password may be incorrect. Check if the E-mail settings are configured correctly.</td>
</tr>
<tr>
<td></td>
<td>Failed to resolve the E-mail server address from DNS.</td>
<td>• The designated IP address of the DNS may be incorrect. Check if the DNS settings are configured correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The DNS server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td></td>
<td>Failed to find the SMTP server.</td>
<td>• The IP address of the server may be incorrect. Check if the IP address of the server is configured correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The SMTP server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td>Internal error</td>
<td>Undefined error.</td>
<td>• An error occurred in the E-mail function. Check if the E-mail settings are configured correctly.</td>
</tr>
</tbody>
</table>

#### Error indications relating to FTP

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP server error</td>
<td>Failed to resolve the FTP server address from DNS.</td>
<td>• The FTP server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td></td>
<td>Failed to find the FTP server.</td>
<td>• The IP address of the server may be incorrect. Check if the IP address of the server is configured correctly.</td>
</tr>
<tr>
<td>Connection error</td>
<td>File transfer error.</td>
<td>• The FTP server settings may be incorrect. Check if the FTP settings are configured correctly.</td>
</tr>
<tr>
<td></td>
<td>Passive mode error.</td>
<td>• The settings relating to the indicated item may be incorrect. Check if the FTP settings are configured correctly.</td>
</tr>
<tr>
<td></td>
<td>Log out failed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Failed to change the directory.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User name or password isn’t correct.</td>
<td></td>
</tr>
</tbody>
</table>
### Error indications relating to “Viewnetcam.com”

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal error</td>
<td>Undefined error.</td>
<td>• An error occurred in the FTP function. Check if the FTP settings are configured correctly.</td>
</tr>
<tr>
<td>Access test error</td>
<td>Access test failed</td>
<td>• Port forwarding may not be configured for the router. Refer to the manuals provided with the router in use to enable the UPnP setting.</td>
</tr>
<tr>
<td>Viewnetcam.com server error</td>
<td>Failed to resolve the Viewnetcam.com server address from DNS.</td>
<td>• The designated IP address of the DNS may be incorrect. Check if the DNS settings are configured correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The DNS server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td>Connection error</td>
<td>No response from the Viewnetcam.com server.</td>
<td>• The “Viewnetcam.com” server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td></td>
<td>File transfer error.</td>
<td></td>
</tr>
<tr>
<td>Internal error</td>
<td>Undefined error.</td>
<td>• An error relating to the “Viewnetcam.com” function occurred. Check if the “Viewnetcam.com” settings are configured correctly.</td>
</tr>
</tbody>
</table>

### Error indications relating to Dynamic DNS Update

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDNS server error</td>
<td>Failed to resolve the DDNS server address from DNS.</td>
<td>• The designated IP address of the DNS may be incorrect. Check if the DNS settings are configured correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The DNS server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td>Connection error</td>
<td>No response from the DDNS server.</td>
<td>• The DDNS server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td></td>
<td>Same host name has registered.</td>
<td>• The same host name has already been registered in the DDNS server. Check if the DDNS Update settings are configured correctly.</td>
</tr>
<tr>
<td>Internal error</td>
<td>Undefined error.</td>
<td>• An error occurred in the DDNS function. Check if the DDNS Update settings are configured correctly.</td>
</tr>
</tbody>
</table>
## Error indications relating to NTP

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection error</td>
<td>No response from the NTP server.</td>
<td>• The IP address of the server may be incorrect. Check if the IP address of the server is configured correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The NTP server may be down. Ask the network administrator.</td>
</tr>
<tr>
<td>Internal error</td>
<td>Undefined error.</td>
<td>• An error occurred in the NTP function. Check if the NTP settings are configured correctly.</td>
</tr>
<tr>
<td>Synchronizing with NTP</td>
<td>NTP update succeeded.</td>
<td>• Time correction succeeded.</td>
</tr>
<tr>
<td>Succeeded.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Log indications relating to HTTPS

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTPS</td>
<td>Certificate Signing Request -</td>
<td>• Generation of the CSR (Certificate Signing Request) is complete.</td>
</tr>
<tr>
<td></td>
<td>Generated</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CA Certificate - Installed</td>
<td>• Installation of the CA certificate is complete.</td>
</tr>
<tr>
<td></td>
<td>CA Certificate - Deleted</td>
<td>• Deletion of the CA certificate is complete.</td>
</tr>
<tr>
<td></td>
<td>Previous CRT key - Applied</td>
<td>• Previous CRT key is applied.</td>
</tr>
<tr>
<td></td>
<td>CRT key - Generated</td>
<td>• Generation of the CRT key is complete.</td>
</tr>
</tbody>
</table>

## Log indications relating to login

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>User name or IP address</td>
<td>• The login user name will be displayed when “On” is selected for “User auth.”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The IP address of the PC currently accessing to the camera will be displayed when “On” is selected for “Host auth.”.</td>
</tr>
</tbody>
</table>
### Error indications relating to login errors

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
</table>
| Login failure                     | User name             | • The user name of the user who failed to log in will be displayed when “On” is selected for “User auth.”.  \  
                                         • If the user is not registered, (Guest User) is displayed.  \  
                                         • Under normal operations, the “Login failure” log may be kept. This is not a problem with the camera.  \  
                                         • If there are many logs in succession, it may indicate that someone is trying to illegally access the camera. Consult with your network administrator. |

### Error indications relating to Panasonic alarm protocol notification

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
</table>
| Panasonic alarm protocol error  | Failed to find destination of notification. | • The IP address of the destination of notification may be incorrect. Check if the IP address of the destination of notification is configured correctly.  \  
                                         • The destination of notification may be down. Ask the network administrator.                                      |
|                                 | Failed to resolve destination addr. from DNS. | • The DNS server settings may be incorrect. Check if the DNS settings are configured correctly.  \  
                                         • The DNS server may be down. Ask the network administrator.                                    |

### Error indications relating to HTTP alarm notification

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
</table>
| HTTP alarm notification error   | Failed to find destination of notification. | • The IP address of the destination of notification may be incorrect. Check if the IP address of the destination of notification is configured correctly.  \  
                                         • The destination of notification may be down. Ask the network administrator.                                      |
|                                 | Failed to resolve destination addr. from DNS. | • The DNS server settings may be incorrect. Check if the DNS settings are configured correctly.  \  
                                         • The DNS server may be down. Ask the network administrator.                                    |
## Error indications relating to SD memory card security settings

<table>
<thead>
<tr>
<th>Category</th>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD memory card</td>
<td>Certificate Signing Request -</td>
<td>• Generation of the CSR (Certificate Signing Request) is complete.</td>
</tr>
<tr>
<td></td>
<td>Generated</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CA Certificate - Installed</td>
<td>• Installation of the CA certificate is complete.</td>
</tr>
<tr>
<td></td>
<td>CA Certificate - Deleted</td>
<td>• Deletion of the CA certificate is complete.</td>
</tr>
<tr>
<td></td>
<td>Previous CRT key - Applied</td>
<td>• Previous CRT key is applied.</td>
</tr>
<tr>
<td></td>
<td>CRT key - Generated</td>
<td>• Generation of the CRT key is complete.</td>
</tr>
</tbody>
</table>
### 3.3 Troubleshooting

**Before asking for repairs, check the symptoms with the following table.**

Contact your dealer if a problem cannot be solved even after checking and trying the solution in the table or a problem is not described below.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/solution</th>
<th>Reference pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot access from the web browser.</td>
<td>• Is the LAN cable (category 5e or better) firmly connected to the network connector of the camera?</td>
<td>Important Information</td>
</tr>
</tbody>
</table>
|                                                                       | • Is the link indicator (LINK) lit?  
  When it is not lit, connection to a LAN may not be established or a network may be not working correctly. Check if the cables have any contact failure or if the wiring is correct or not. | Important Information |
|                                                                       | • Is the power of the camera on?  
  Check if the power of the camera is turned on.                                                        | Important Information |
|                                                                       | • Are the set IP addresses valid?                                                                       | 148             |
|                                                                       | • Are you accessing the wrong IP address?  
  Check the connection as follows.  
  With the Windows command prompt, > ping “IP address of the camera”.  
  If there is reply from the camera, the connection is normal.  
  If there is no reply, check the connection with the following methods using a computer connected to the same network as the camera. If the firewall settings on the PC are enabled, temporarily disable them before performing settings on the camera.  
  – Start the Panasonic “IP Setting Software”, confirm the camera’s IP address, and then access that IP address.  
  – If the network settings (IP address, subnet mask, and default gateway) are incorrect, reboot the camera and change the network settings by using the Panasonic “IP Setting Software” within 20 minutes after the restart.  
  – In networks that do not have a DHCP server, the IP address of the camera will be configured to “192.168.0.10” when the camera is rebooted by holding the INITIAL SET button on the camera. After the camera is initialized, access the camera and set the IP address again. (When the camera is initialized, all the settings of the camera previously configured on the setup menus will be initialized.) | 212             |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/solution</th>
<th>Reference pages</th>
</tr>
</thead>
</table>
| • Is “554” selected for the HTTP port number?  
For the HTTP port number, select a port number other than the following port numbers used by the camera. The number used by the camera: 20, 21, 23, 25, 42, 53, 67, 68, 69, 110, 123, 161, 162, 443, 554, 995, 10669, 10670, 59000 - 61000 | 150 |
| • Is the same IP address provided to other devices?  
Are there contradictions between the address and the network subnet to be accessed?  
**When the camera and the PC are connected in the same subnet:**  
Are the IP addresses of the camera and the PC set in a common subnet? Or is “Use Proxy Server” for the settings of the web browser checked?  
When accessing the camera in the same subnet, it is recommended to enter the address of the camera in the “Don’t Use Proxy For These Addresses” box.  
**When the camera and the PC are connected in the different subnet:**  
Is the IP address of the default gateway set for the camera correct? | - |
| • Is the name currently used to access the camera different from the name registered for the “Viewnetcam.com” service?  
Access the camera again with the registered name. | 189 |
| • Did you access “http://” while using the HTTPS function?  
To use the HTTPS function, access “https://”. It is also necessary to enter the port number. | 181  
186 |
| Cannot access the camera via the Internet. | • Are the network settings of the camera correct?  
Set the default gateway or DNS server address correctly. To use the DDNS service, check that the settings are correct.  
• Is the setting for “Default gateway” on the “Network” page configured? Or is the setting correct?  
**When communicating using IPv4:**  
Configure the setting for “Default gateway” of “IPv4 network” on the [Network] tab of the setup menu. | 148 |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/solution</th>
<th>Reference pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Is the setting of port forwarding configured for the router? To enable the access to the camera via the Internet, it is necessary to perform the port forwarding setting when the router in use does not support the UPnP function. Refer to the manuals provided with the router for further information. • Is UPnP function of the router disabled? Refer to the manuals provided with the router in use to enable the UPnP function. • Is packet filtering set for the router to forbid the access via the Internet? Configure the settings of the router in use to enable the access via the Internet. Refer to the manuals provided with the router for further information about the settings.</td>
<td>162</td>
<td></td>
</tr>
<tr>
<td>• Are you accessing the camera using the local address (the IP address used in a local network)? When accessing the camera, use the global address (or the URL registered in the DDNS service) and the port number of the camera as the IP address to be used in the Internet.</td>
<td>149 150 187</td>
<td></td>
</tr>
<tr>
<td>Cannot access the camera via the URL of the “Viewnetcam.com” service. • Is the global address of camera (or router) notified to the “Viewnetcam.com” service server? Log into the “My Account” page of “Viewnetcam.com” website (<a href="http://www.viewnetcam.com/">http://www.viewnetcam.com/</a>) to check the information of the registered camera. If the global address is not displayed for the IP address, access the camera, and register the user information for the “Viewnetcam.com” service on the [Advanced] tab on the “Network” page of the setup menu. In addition, check the “Status” of “Viewnetcam.com” (on the [Status] tab) and the system log (on the [System log] tab) of the “Maintenance” page of the setup menu.</td>
<td>189 202</td>
<td></td>
</tr>
<tr>
<td>Authentication window is displayed repeatedly. • Is the user name and password changed? While accessing the camera, when changing the user name and password of another user logging into the camera on another web browser, the authentication window will be displayed each time the screen is changed or refreshed. Close the browser and access the camera again. • Have you changed the [Authentication] setting? When the [Authentication] setting has been changed, close the web browser, and then access the camera again.</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause/solution</td>
<td>Reference pages</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>It takes time to display the screen.</td>
<td>• Are you accessing the camera in the HTTPS mode? In this mode, the refresh interval becomes slower due to decode procession.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>• Are you accessing another camera in the same local network via a proxy server? Configure the web browser to not use the proxy server.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>• Are two or more users browsing the camera images simultaneously? It may take time to display the screen or refresh interval may become slower when two or more users browse the camera images simultaneously.</td>
<td>-</td>
</tr>
<tr>
<td>Cannot access the camera from a cellular phone.</td>
<td>• Is the URL correct? Or is “/mobile” missing at the end of the URL? Check if the URL is entered correctly. When accessing the camera from a cellular phone, it is necessary to enter “/mobile” at the end of the URL that is used for the camera access from a PC.</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>• Is the SSL encryption method different from that of the camera? Select “HTTP” (Do not select “HTTPS”) for “HTTPS” - “Connection” on the “Network” page - the [Advanced] tab, and access the camera again.</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>• Did you access “http://” while using the HTTPS function? To use the HTTPS function, access “https://”. It is also necessary to enter the port number.</td>
<td>181</td>
</tr>
<tr>
<td>Cannot access the camera from a mobile terminal.</td>
<td>• Is the URL correct? Or is “/cam” missing at the end of the URL? Check if the URL is entered correctly. When accessing the camera from a mobile terminal, it is necessary to enter “/cam” at the end of the URL that is used for the camera access from a PC.</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>• Is the SSL encryption method different from that of the camera? Select “HTTP” (Do not select “HTTPS”) for “HTTPS” - “Connection” on the “Network” page - the [Advanced] tab, and access the camera again.</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>• Did you access “http://” while using the HTTPS function? To use the HTTPS function, access “https://”. It is also necessary to enter the port number.</td>
<td>181</td>
</tr>
<tr>
<td>A cookie error was displayed when performing user registration for “Viewnetcam.com”.</td>
<td>• Is the web browser configured to allow cookies? Configure the web browser to allow cookies. In Internet Explorer, from [Tools] select [Internet Options] and configure the cookies setting in the [Privacy] tab.</td>
<td>-</td>
</tr>
</tbody>
</table>
### Symptom | Cause/solution | Reference pages
--- | --- | ---
User registration for the "Viewnetcam.com" service fails. | • Is the registered E-mail address correct? When an E-mail with the "Viewnetcam.com" website link is not received, the registered E-mail address may be incorrect. Visit the "Viewnetcam.com" website (http://www.viewnetcam.com/) to register the correct E-mail address. | -

Cannot obtain images on the SD memory card. | • Is “Allow” selected for “FTP access to camera” on the [Network] tab of “Network” page? It is necessary in advance to select “Allow” for “FTP access to camera” on the [Network] tab of the “Network” page. | 152
• Is the entered password correct? Restart the web browser and enter the password again. | 80
• Access to the SD memory card may be failed. Restart the web browser and retry to obtain images. | -

No image is displayed. | • Is the viewer software installed on the PC? Install the viewer software on a PC. | 4
• Is the cellular phone in use support the 320×240 or 640×480 resolution? Or is the image data size too big to display images on the cellular phone? Refer to the manuals provided with the cellular phone in use for the restrictions of image data sizes. | -

No image is displayed. / Older images or logs are displayed. | • When [Every time I visit the webpage] is not selected for [Check for newer versions of stored pages:] in the [Temporary Internet Files] section, images sometimes may not be displayed on the “Live” page. In this case, do the following.
1. Select [Internet Options...] from [Tools] on the menu bar of Internet Explorer. The [Internet Options] window will be displayed.
2. Click the [Settings] button in the [Browsing history] section on the [General] tab, and then select [Every time I visit the webpage] for [Check for newer versions of stored pages:] in the [Temporary Internet Files] tab on the [Website Data Settings] window. | -

The image is not being refreshed. | • Depending on the version of your browser, there might be difficulties refreshing the picture, etc. | Important Information
• Depending on the traffic of the network or the concentration of access to the camera, there might be difficulties displaying the camera picture. Request the camera picture using the web browser such as by pressing the [F5] key, etc. | -

No image is displayed (or too dark). | • Is the brightness setting set at an appropriate level? Click the [Normal] button of [Brightness]. | 11
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/solution</th>
<th>Reference pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Images are displayed washed out.</td>
<td>• Is the brightness setting set at an appropriate level? Click the [Normal] button of [Brightness].</td>
<td>11</td>
</tr>
<tr>
<td>Flicker appears on the screen.</td>
<td>• When flicker occurs frequently, select &quot;Indoor scene&quot; for &quot;Light control mode&quot;.</td>
<td>95</td>
</tr>
<tr>
<td>Images cannot be saved on the SD memory card.</td>
<td>• Is the SD memory card inserted correctly? Check if the SD memory card is inserted correctly.</td>
<td>Important Information</td>
</tr>
<tr>
<td>Failed to write/read data on the SD memory card.</td>
<td>• Is the SD memory card formatted? Format the SD memory card.</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>• Is &quot;--------MB/--------MB&quot; displayed on “Remaining capacity” of the [SD memory card] tab? Format the SD memory card.</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>• Is any recognition error received when the “Diag.” of “E-mail notification” or “Panasonic alarm protocol” is used? Format the SD memory card.</td>
<td>72 153 132</td>
</tr>
<tr>
<td></td>
<td>• Isn’t the SD memory card out of order? There are limited times to overwrite on an SD memory card. When frequently overwritten, it may be at the end of product life. It is recommended to replace the SD memory card.</td>
<td>-</td>
</tr>
<tr>
<td>Audio is not output from other products such as a network disk recorder or PC software package.</td>
<td>• Some of the products such as a network disk recorder or PC software package may not support “G.711” or “AAC-LC”. Set “Audio input encoding format” of the products to “G.726 (32 kbps).”</td>
<td>115</td>
</tr>
<tr>
<td>The alarm occurrence indication button and the SD recording status indicator on the “Live” page do not display the current status in real time.</td>
<td>• Is the viewer software installed on the PC? Confirm that the viewer software “Network Camera View 4S” is installed.</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>• Is “Real time” selected for “Alarm status update mode”?</td>
<td>58</td>
</tr>
<tr>
<td>No image is displayed on the “Live” page.</td>
<td>• Press the [F5] key on the keyboard of the PC or click the [Live] button.</td>
<td>11</td>
</tr>
<tr>
<td>Shortcut icon of the camera is not displayed on “Network” of the PC.</td>
<td>• Is the Windows component of UPnP added? Add the component to the PC in use.</td>
<td>162</td>
</tr>
<tr>
<td>Cannot download the log list.</td>
<td>• Download of files using Internet Explorer may be disabled. Enable “File Download” in the “Security Settings” window ([Internet Options] - [Security]). After changing the settings, close the web browser, and then access the camera again.</td>
<td>-</td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause/solution</td>
<td>Reference pages</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| Images are not displayed or not refreshed smoothly.          | • Delete temporary internet files as follows.  
1. Select “Internet Options...” under “Tools” on the menu bar of Internet Explorer. The “Internet Options” window will be displayed.  
2. Click the [Delete Files...] button in the “Temporary Internet Files” section on the [General] tab.  
• The firewall function of the anti-virus software may be filtering the port of the camera. Exclude the port number of the camera from the list of the port numbers to be filtered by the anti-virus software. | -               |
| No indicator lights.                                        | • Is “Off” selected for “Indicator” on the “Basic” page? Select “On” for “Indicator”.                                                                                                                                 | 58              |
| H.265 (or H.264) images are not displayed.                  | • When “Network Camera View 4S” is deleted from a PC on which the viewer software “Network Camera View 3” is installed, H.265 (and H.264) images will not be displayed. In this case, install “Network Camera View 4S” after deleting “Network Camera View 3”. | 4               |
| When displaying H.265 (or H.264) images on two or more web browser windows, images from two or more cameras are displayed in sequence on a single browser window. | • This may occur due to the display adapter and driver combination. When this has occurred, first update the driver of the display adapter to the latest version. If updating the driver does not solve the problem, adjust the hardware acceleration as follows. The following are descriptions for when Windows 7 is installed on the PC in use. This setting may not be changed depending on the network environment.  
1. Right-click on the desktop and select “Screen resolution” from the displayed pop-up menu.  
2. Click “Advanced settings”.  
3. Select the [Troubleshoot] tab and then click “Change settings”.  
4. If the [User Account Control] dialog box is displayed, click “Yes”. When logged in as a user other than the administrator, enter the password and click “Yes”. Enter a user name as required.  
5. Move the slider for “Hardware acceleration” to the extreme left towards “None”, and then click “OK”. | -               |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/solution</th>
<th>Reference pages</th>
</tr>
</thead>
</table>
| Failed to download recorded data from the image playing screen in the browser. | • You may not be using Internet Explorer with administrator rights. After shutting down all of the open Internet Explorer windows and tabs, restart Internet Explorer by right-clicking the Internet Explorer icon in the Start menu and selecting “Run as Administrator”.  
• In the “Name of the destination directory for downloaded images” settings, specify a directory that general users can write to. | 82              |
| When clicking the back button of the web browser, the screen is not displayed correctly. | • Press the [F5] key on the keyboard to refresh the display. | -               |
**Information Bar**

The “Information Bar” (①) expressed in the following symptom and solutions will be displayed just below the address bar only when there is information to communicate.

Depending on the OS installed on the PC, the following may occur. Follow the instructions below when the following has occurred. By performing the following solutions, other applications may not be affected.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause/solution</th>
<th>Reference pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following message is displayed on the information bar.</td>
<td>• Select “Options for this site” → “Always allow”.</td>
<td>-</td>
</tr>
<tr>
<td>“Internet Explorer blocked a pop-up from <em><strong>.</strong></em>.<em><strong>.</strong></em> (IP address).”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The following message is displayed on the information bar.</td>
<td>• Select [Allow].</td>
<td>-</td>
</tr>
<tr>
<td>“This webpage wants to run the following add-on: ‘WebVideo Module’ from</td>
<td></td>
<td></td>
</tr>
<tr>
<td>‘Panasonic Corporation’.”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The following message is displayed on the information bar.</td>
<td>• Select [Install]. The “Security Warning” window will be displayed. Click the</td>
<td>-</td>
</tr>
<tr>
<td>“This webpage wants to install the following add-on: ‘nwcv4Ssetup.exe’ from</td>
<td>[Install] button on the displayed “Security Warning” window.</td>
<td></td>
</tr>
<tr>
<td>‘Panasonic Corporation’.”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>An unnecessary status bar or scroll bar is displayed on the pop-up window.</td>
<td>• Click “Internet Options...” under “Tools” of the menu bar of Internet Explorer, and then click the [Security] tab. Click “Internet” in the “Select a Web content zone to specify its security settings.” section. Then, click the [Custom level...] button to open the “Security Settings” window. Under “Miscellaneous”, select “Enable” for “Allow script-initiated windows without size or position constraints”. Click the [OK] button. When the warning window is displayed, click the [Yes] button.</td>
<td>-</td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause/solution</td>
<td>Reference pages</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| Images are not fit in the frames.            | • When “120 DPI” or higher is selected for “DPI setting”, they may not be displayed correctly.  
**When using Windows 10:**  
Right-click on the desktop, click “Display settings”, and then move the slider of “Change the size of text, apps, and other items” to “100% (Recommended)”.  
Select “Landscape” of “Orientation”.  
**When using Windows 8.1:**  
Right-click on the desktop, click “Screen resolution” → “Make text and other items larger or smaller”, and then move the slider of “Change the size of all items” to “Smaller” so that the screen becomes the recommended size.  
**When using Windows 7:**  
Right-click on the desktop, click “Screen resolution” → “Make text and other items larger or smaller”, and then select “Smaller - 100% (default)”. | -               |
3.4 Directory structure of drive B

- **Drive B**
  - **FTP**
    - 180101
    - 0123
    - 180102
  - **ALARM**
    - 00001000
    - 18010112.01
    - 18010112.02
    - File name.01
    - Image captured at the alarm occurrence
      (Ex. img_1801011234000001.jpg)
    - 00001001
  - **LOCAL**
    - 00001000
    - 18010112.01
    - 18010112.02
    - File name.01
    - Image saved manually
      (Ex. img_1801011234000001.jpg)
    - 00001001
  - **PULL**
    - ← Destination where images are to be saved by the SD memory recording function of Panasonic network disk recorder
  - **LOG**
    - ← Destination where log files are to be saved (for the system administration)
  - **M_ALARM**
    - 10000001
    - 10000101
    - Video saved at the alarm occurrence (Approx. 20 MB per file)
      (Ex. 10000001_180224193826_A.mp4)
      Video that was started to be recorded on
      February 24, 2018 19:38:26
    - 10000102
    - ...
  - **M_LOCAL**
    - 10000001
    - 10000101
    - Video saved manually or during the period of the schedule
      (Approx. 20 MB per file)
      (Ex. 10000001_180224193826_L.mp4)
      Video that was started to be recorded on
      February 24, 2018 19:38:26
    - 10000102
    - ...
  - **N_NWBKP**
    - ← Destination where video files are to be saved by the SD memory recording function of Panasonic network disk recorder
  - **SETTINGS**
    - ← Destination where setting files are to be saved (for the system administration)
For U.S. and Canada:

Panasonic Corporation of North America
Two Riverfront Plaza, Newark, NJ 07102-5490
http://business.panasonic.com/

Panasonic Canada Inc.
5770 Ambler Drive, Mississauga, Ontario, L4W 2T3 Canada
1-877-495-0580
https://www.panasonic.com/ca/

For Europe and other countries:

Panasonic Corporation
http://www.panasonic.com

Panasonic Corporation
Osaka, Japan

Authorised Representative in EU:

Panasonic Testing Centre
Panasonic Marketing Europe GmbH
Winsbergring 15, 22525 Hamburg, Germany

© Panasonic Corporation 2019